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MBA III SEM 

 

KMBNMK02: MARKETING ANALYTICS                                                      
 

Unit-1: Introduction to Marketing Analytics (4 hrs) 

Meaning, characteristics, advantages and disadvantages of marketing analytics, Market data sources 

(Primary and Secondary). Market Sizing: Stakeholders, Applications & Approaches (Top-down and 

Bottom-up), PESTLE Market Analysis, Porter Five Force Analysis. 

 

Unit-2: Pricing Analytics (8 hrs) 

Pricing Policy and Objectives, Estimating Demand Curve: Price Elasticity, Estimating Linear and Power 

Demand Curves, Optimize Pricing, Incorporating Complementary Products, Pricing using Subjective 

Demand Curve, Pricing Multiple Products. 

Price Bundling & Nonlinear Pricing: Pure Bundling & Mixed Bundling, Determine Optimal Bundling 

Pricing, Profit Maximizing strategies using Nonlinear Pricing Strategies, Price Skimming & Sales, Revenue 

Management: Markdown Pricing and Handling Uncertainty. 

 

Unit-3: Sales Forecasting (8 hrs) 

Introduction, Simple Linear Regression & Multiple Regression model to forecast sales, Forecasting in 

Presence of Special Events, Modeling trend and seasonality; Ratio to moving average forecasting method, 

Using S curves to Forecast Sales of a New Product. 

  

Unit-4: Customer Analytics (8 hrs) 

Customer Lifetime Value: Concept, Basic Customer Value, Measuring Customer Lifetime value, 

Estimating Chance that customer is still active, Using Customer Value to value a business 

Market Segmentation: The segmentation-targeting-positioning (STP) framework, Segmentation, The 

concept of market segmentation, managing the segmentation process, Deriving market segments and 

describing the segments using Cluster analysis. 

 

Unit-5: Retailing & Advertising Analysis (8 hrs) 

Market Basket Analysis: Computing two way and three way lift, RFM Analysis, Allocating Retail Space 

and Sales Resources: Identifying the sales to marketing effort relationship & its modeling, optimizing sales 

effort. 

Advertising Analysis: Measuring the Effectiveness of Advertising, Optimizing advertising, Pay per Click 

(PPC) Online Advertising. 
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1.  Marketing Analytics: Data-Driven Techniques with Microsoft Excel by Wayne L Winston, Wiley India 

Pvt. Ltd. 

2.  Marketing Analytics: Strategic Models and Metrics by Stephan Sorger, Create Space Publishing. 

3.  Marketing Engineering and Analytics by Gary Lilen, Arvind Rangaswamy, and Arnaud De Bruyn 

Decision Pro, Inc. 

4. Marketing Metrics by Dugar Anurag, SAGE Publishing India 
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UNIT-1: INTRODUCTION TO MARKETING ANALYTICS (4 HRS) 

 
Meaning, characteristics, advantages and disadvantages of marketing analytics, Market data sources 

(Primary and Secondary). Market Sizing: Stakeholders, Applications & Approaches (Top-down and 

Bottom-up), PESTLE Market Analysis, Porter Five Force Analysis. 
 

MEANING OF MARKETING ANALYTICS 
The practice of measuring, managing, and analysing the marketing performance of a firm so that the return 

on investment (ROI) can be optimised and increased is called marketing analytics. Marketers can achieve a 

greater level of efficiency and reduce wastage of marketing funds by understanding the concept of 

marketing analytics. 

A lot of vital information related to the preference and requirements of the customer can be obtained with 

the help of marketing analytics apart from the most obvious reason of marketing activities, i.e., increasing 

sales and generating leads. Most of the organisations are still not able to understand the potential of 

marketing analytics, despite having several advantages from it. The following reasons induce the use of 

marketing analytics: 

1) Getting information related with new marketing trends; 

2) Identifying successful programmes and evaluating their reasons of success; 

3) Analysing trends over time; 

4) Completely analysing the ROI of each programme and 

5) Forecasting the outcomes. 
 

CHARACTERISTICS OF MARKETING ANALYTICS 

The characteristics of marketing analytics are as follows: 

1) Ensure High-Quality Data→ The analytics rest on the data. That means marketer need a tool that 

mines both structured and unstructured customer data from all possible sources, including various 

interactions and touch points. 

2) Get Real-Time Insights→ The marketing analytics solution also needs to deliver real-time insights to 

marketer. Marketer can’t be effective if his information is out-of-date; tracking the right metrics at the 

right time is key. 

3) Perfect Dashboard→ While it may be tempting to track as many metrics as possible, the analytics will 

not be as useful if marketer do. Rather, define the goals and measure results for the use cases most 

important to marketer. 

4) Choose Right Analytics Visualization→ Marketing teams and stakeholders must be able to make 

something of the data if marketers are to gain meaningful insights from it. The key is to choose the most 

appropriate data visualizations so he can find patterns and interpret the data. Thus, marketer must choose 

a marketing analytics solution that allows him to choose or customize visualizations instead of using 

default charts for displaying data. 

5) Use a Tool Featuring Machine Learning and AI (artificial intelligence) to Predict and Prescribe→ 

Marketing must be real-time and predictive to be effective today. Marketer must be able to make 

accurate predictions, analyse the data, and make data-driven decisions to enhance each step of the 

customer journey. 
 

COMPONENTS OF MARKETING ANALYTICS 

Following are the components of marketing analytics: 

1) People→ The marketing analytics process is created, executed, and managed by people who own it. In 

most marketing organisations, the process owner is the Chief Marketing Officer (CMO) or the marketing 

director. 

2) Steps→ The marketing analytics process consists of a sequence of steps. 

3) Tools and Technology→ While the marketing analytics process is not necessarily complex, tools and 

technology help marketing organisations deliver greater value faster than they ordinarily might be. 

4) Input and Output→ Data feeds the process, with insights and decisions as the output of the process. 
 

A 3-STEP METHODOLOGY FOR MARKETING ANALYTICS 

At the heart of every data-driven decision lie three essential elements that contextualize data and allow real 

business decisions to surface from the sea of numbers that are produced from marketing activity. These are: 
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1) Understand→ Analysis for the sake of analysis, provides little value and consumes precious time in a 

marketer’s busy day. Develop a basic understanding of what you plan to accomplish with marketing 

analytics, i.e., improved customer knowledge, new segments, channel effectiveness, etc. It might even be 

appropriate to back into data requirements by defining a core business challenge or key question that the 

organisation would like to answer with the analysis. This will help determine exactly what data is 

required and possible, even identify new opportunities for capturing critical data in the future. 

2) Execute→ After developing a core understanding of the data itself and translating that into business 

strategy, it is time to execute and act. Often involving some additional refinement of the information 

produced in the Understand Phase, execution may be done through reporting engines, analytical models, 

testing, and even spreadsheets. 

3) Monitor→ It is critical for marketers to close the loop on analytical exercises through ongoing 

monitoring of a standard set of Knowledge Performance Indicators (KPIs). This might be accomplished 

via a dashboard or periodic report, but the goal should be to standardise metrics over time, so you can 

establish a benchmark for significant changes in the data that may alert you to opportunities to optimise 

marketing results. This information should also be available for marketers to better understand and 

initiate new campaign cycles. 
 

ADVANTAGES OF MARKETING ANALYTICS 

1) Gaining a Full View of Customers across Channels→ With marketing analytics, marketing firms can 

obtain a full view of potential customers across different marketing channels such as bricks-and-mortar 

locations, kiosks, call centres mobile, partners, e-commerce, social media and so on. For this purpose, 

the firm needs to first establish a strategy for gaining access to customer data and then integrating and 

analysing it with different sources. 

2) Becoming More Effective and Proactive→ With marketing analytics, firms can anticipate the 

behaviours of their customers and target markets and can respond accordingly in a more proactive 

manner. Solutions that conduct data mining or statistical methods are included under marketing analytics 

which helps the marketing organisations to establish predictive models based upon the arrangements of 

different variables. 

3) Personalising Customer and Market Engagements→ With marketing analytics, firms can explore and 

assess the behaviour of customers in the targeted regions and predict their likely responses. This enables 

the firms to customise the content, timings and channels of delivery of products/services so as to fulfil 

the customers’ preferences. 

4) Visualising Success across Enterprise→ With the help of data visualisation, analytics become 

accessible for non-technical marketers which further enables collaboration, sharing, and decision-making 

for becoming more effective and efficient. 

5) Treating Data as a Strategic Asset→ There are lot of hackers who try to steal or break into the 

customer data. This reflects the importance of customer information. Locking this data into a vault is not 

the solution of this problem as a balance is needed between privacy, data access and governance for 

protecting the interests of the customer as well as the organisation. Since marketing analytics treat 

customer data as a strategic asset, it helps the firm in maintaining such balance. 
 

DISADVANTAGES OF MARKETING ANALYTICS 

The various disadvantages of marketing analytics are as follows: 

1) Misidentifying Market Needs→ One of the elements of marketing analysis is identifying the needs of 

each market segment. It also identifies other businesses and products that are attempting to satisfy the 

needs of this segment. The disadvantage of doing this is twofold. Marketer may overestimate how well 

his competition is meeting the customers’ needs and quit before he even try to market. Marketer also 

may misidentify the need that is being met. The marketer don’t overlook the uniqueness of own offering. 

Just because competition wants the same customer that marketer do, that doesn’t mean he is satisfying 

the same need. 

2) Evaluating Market Growth without Market Share→ Marketers marketing analysis will include a 

look at how the overall market is growing, which can give him some idea of his range of opportunities. 

If his analysis discourages him, however, it can be a disadvantage. Marketer can successfully compete in 

a limited market if he capture market share. An analysis of the market size alone is not enough to 

indicate the opportunities. Improved market share can compensate for a slow-growth market. 
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3) Market Segmentation versus Target Markets→ Marketer must identify the segments of the market 

that have potential customers for the products or services. This will help him understand the varied 

approaches marketer may need to take to reach different types of customers. The downside is that 

marketer may spread himself too thin. Few businesses can afford to market to every single potential 

customer. Marketer should identify a target market that he choose from among the available segments, 

and go after that target market in a focused manner. 

4) Improper Interpretation of Data→ A marketing analysis is only as good as the analyser. Marketer can 

collect a lot of data in market surveys, but interpreting that data correctly is vital. Marketer will be at an 

extreme disadvantage if he misinterprets facts and makes decisions based on that misinterpretation. 

Marketer should make sure that his analysis is not wishful thinking. 

 

MARKET DATA 
MEANING OF DATA 

The term data has been derived from the Latin plural word “datum”. Any fact or figure that is collected by 

experience, experiment or observation within a computer system is termed as data. 

According to Davis, “Data, raw material for information, is defined as groups of non-random symbols, 

which represent quantities, actions, objects, etc. Data item in information systems are formed from the 

characters. These may be alphabetic, numeric, or special symbols.” 

Meaningful information can be generated after processing the data. 

 

 
 

A research can be carried-out with the help of two types of data, viz., primary data and secondary data. 

The former can be defined as the data which is collected for the first time by the researcher, while the later 

can be defined as the data which are already collected and statistically processed for a particular event or 

problem. Secondary data are indirectly based on primary data or are directly calculated from the primary 

data. 

In other words, secondary data can be called as processed primary data. Based on the purpose of the research 

study, researchers choose the primary or secondary data to find relevant solutions. The methods for 

collecting primary and secondary data are different. 

Marketing data is information that can be used to improve product development, promotion, sales, pricing, 

distribution and related strategies such as branding. 
 

Methods of Data Collection 

Depending upon the sources being utilised, any statistical data can be divided into two categories, which are 

as follows: 

1) Primary Data→ The data which is directly collected by the researcher and was not available before is 

called as “primary data”. The sources of primary data are very useful in finding the real facts about the 

incidents or events. It includes the personal observation of the researcher and respondent. Primary data 

are the freshly collected data that provide information about a particular problem. These data can be 

gathered using techniques like, interview, observation, mailing, counselling, etc. 

2) Secondary Data→ The previously recorded information about an event is very important in finding the 

solution of similar kind of problems. This readily available information is called “secondary data”. It is 

already processed and compiled with an evaluation. These can be gathered from the published reports 

like census reports, annual reports, financial assessment reports, and journals, as well as from 

unpublished sources. Various statements and records about the performance of a particular organisation 

and its departments like accounting records, minutes of meetings, inventory records, etc., fall in the 

category of secondary data sources. 
 

SELECTION OF APPROPRIATE METHOD FOR DATA COLLECTION 

The required data collection methods for research purposes are determined by considering the following 

factors: 

1) Complexity of Topic→ The data collection method is employed by analysing the seriousness and 

complexity of the topic chosen for the research study and the nature and types of questions to be 

involved. The method for data collection is also affected by the possible quality or length of the 

responses. 

 

Processing 
 

Data 
 

Information 
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For example, the responses to complicated questions should not be obtained through telephone survey, 

on the other hand, personal interviews and in-depth explanatory notes will give more positive results. 

Moreover, the electronic version which is capable of performing the complicated sequencing better is 

preferred in place of a paper version. 

2) Types of Data→ Data collection methods cover various types of topics. Self-administered techniques 

are normally preferred over interviews when it comes to sensitive topics, as they are considered to be 

more private. There are cases where, for this reason, a face to face interview is included in a self-

administered technique. Self-administered techniques are also required where the respondents need to 

inquire from other people or inspect the previous records before responding. This can be done through a 

telephone survey in which the respondent is mailed a form to complete with his/her responses, and are 

required to deliver their responses over the phone. 

3) Non-response→ The extent of response to a research study affects the reliability and quality of the data 

surveyed. While achieving a 100% response rate for any survey is very rare, choosing the data collection 

technique can have a significant impact on the obtained response rate. The fact that it is difficult to say 

no to a person’s face, personal interviews are more effectual than mail surveys. However, the results of 

the method of response are also affected by other factors (if the survey is necessary, whether it is fresh or 

repeated, and how these methods are followed up). 

4) Respondent Preference→ The answer to the question whether the chosen data collection method fits in 

with the respondent’s working style and lifestyle influences the selection of the data collection methods. 

For example, much of the business of respondents is done over the phone which makes them 

comfortable in using this method as stated by the retail business survey and CATI survey. The 

preference of the respondents to complete their forms using electronic methods has given rise to the 

Electronic Transaction Act (July 2001) which gives the respondents the right to use it for ABS surveys. 

5) Resources Available→ To obtain numerous and quick responses, the researcher might use a less 

suitable data collection method. This is mainly applied when there is scarcity of resources (time, money 

or manpower) on the part of the researcher. The survey must be conducted with appropriate quality, so 

choosing such data collection method in hurry gives rise to conflicts. 

There are various alternatives available to the researcher such as, compromising a planned reduction in 

quality of data, reducing the coverage, or selecting a less efficient method of choosing data. The 

researcher might also look for other sources for cost savings and for acquiring resources. 

6) Sampling Frame and the Population→ The selection of data collection methods are influenced by the 

quality and type of sampling frame as well. For example, if survey is to be conducted on homeless 

people, a mail survey method is not at all a suitable method. Mail surveys are appropriate when the 

target population includes shift workers or those who are unavailable at their houses when the researcher 

can reach them. 
 

PRECAUTIONS IN COLLECTION OF DATA 

Following guidelines which are based on various data collection sources should be considered while 

collecting data: 

1) Primary Data→ It is a very difficult task to collect the necessary information. Also, it is difficult to 

collect data from the field situation in comparison to the data collected from the organisational situation. 

Various precautions which a researcher must observe to collect definite, unbiased and accurate 

information from field, and to overcome the difficulties like lack of cooperation, inaccurate information 

and stress are as follows: 

a) Friendly Attitude: Interviewer should collect the information in a friendly manner and is presumed 

to be polite and disciplined. He should be focused towards creating and maintaining a good 

relationship with the respondents. The respondents should be acknowledged regarding their 

cooperation in the research work. 

b) Appropriate Use of Words: The words and sentences must be proper and known to the 

respondents. Moreover, it should not hurt the emotions of respondents. Interviewer should replace 

the unfamiliar words with more suitable and familiar words so as to provide convenience to the 

respondents in understanding the questions. 

c) Avoiding Objectionable or Unsuitable Questions: Interviewer must avoid socially objectionable 

questions. But, if it is necessary, then he must use indirect questions for the objective. 
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d) Transparency to the Respondents: The researcher should always maintain the transparency with 

the respondents. He should clearly communicate the objective of research and fieldwork. At times, 

respondents are reluctant to answer the questions if research objectives are not explained clearly. 

e) Confidentiality and Privacy of Respondents’ Identity: The researcher should make sure to the 

respondents that adequate privacy and confidentiality measures have been adopted during the 

collection of data. 
 

2) Secondary Data→ Similar to the primary data collection, there are some precautions that are needed to 

be taken during secondary data collection. Some of those precautions are described below: 

a) Objective of the Study: While collecting the secondary data, whether internal or external, the 

researcher should keep in mind that the data collected should be relevant with the objective of 

research. Also, the researcher should check the authenticity, accuracy and compatibility of the 

secondary data based on the objective of study, as it gives the idea of research procedures, research 

design, types of data used, etc. Hence, the researcher should focus on the objective of study and must 

collect the data accordingly, by using specific techniques. 

b) Reputation of Data Sources: While collecting data from secondary sources, it should always be 

kept in mind that the quality of data differs vastly among the available data sources. Some sources 

contain credible, valid and accurate data as their sole emphasis is on quality work. While, on the 

other hand, other sources may contain inaccurate and false data that may disturb the analytical 

process and thereby provide inaccurate outcomes. The researcher should wisely select the reputed 

sources of data. 

c) Context of the Data: The researcher should filter-out the available secondary data, as only some 

part of the data can be applicable on the research for accuracy and precision. Hence, the secondary 

data should match with the objectives of research. 

For example, if a research problem is associated with niche marketing, then secondary data on the 

core marketing concepts will not be applicable. Therefore, the researcher needs to collect data which 

is specific to the topic. 

d) Time of Information: The time at which the data has been collected, influences the research 

outcome in a significant way. The time factor can also affect the measures and their definitions. 

For example, if the researcher has the research study on weather reports, then the time of the 

readings is vital; also if the research is done on the amount of traffic for a particular city, then 

alongwith the other factors, time of data collection is also significant as the amount of traffic in a 

particular area varies with time. 

e) Methodology Implemented: The researcher should possess the knowledge of research methodology 

implemented during the process of data collection, so as to evaluate the quality of secondary data. He 

should have an in-depth knowledge about research design, sample size, response rates, 

questionnaires, schedules, interview procedures and other analytical techniques involved in the 

research study in order to examine the compatibility of the secondary data as per the research study. 
 

PRIMARY DATA 
The data collected by the researcher himself for finding the solution of a particular problem or situation, is 

known as primary data. This type of data is characterised by its originality as it is freshly collected. Various 

organisations conduct surveys, observations, interviews, etc. and as a result generate primary data. Although 

secondary data provides a basic understanding to the research problems, but sometime, it becomes necessary 

to collect primary data as the previously generated secondary data may not serve the purpose. 

Just like secondary data, researchers should also take additional care while collecting primary data such that 

it is accurate, reliable, and unbiased. For collecting primary data, researchers need to take many decisions 

regarding proper selection of relevant sources, sampling techniques, research tools, etc. To conduct any 

research effectively and produce valid results, researchers should collect primary data as it contains current 

and exact information about the incident or event. One of the major benefits of primary data is that its 

validity and reliability can be verified by other experts. There are many ways to collect primary data such as 

observation, interviews, group discussions, case studies, etc. 
 

CHARACTERISTICS OF PRIMARY DATA 

Following are the characteristics of primary data: 

1) Collected for the First Time→ Since the primary data are collected for the first time with an objective, 

they are natural and available in raw stage. They are required to be analysed in a systematic way to reach 
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the conclusions. However, status of secondary data is just opposite and they are already processed after 

analysis. 

2) Collected from the Source→ These are generated after personal interactions or observations of original 

sources or through deputed personnel for the task. These are obtained after certain experimental results, 

close study of sample cases, first hand encounters of the situations and selection of resources at free will, 

without following any sequence or particular methods. The data thus collected is needed to be analysed 

by a team of experts to arrive at conclusions who may even decide to re-confirm the validity of data by 

re-examining certain observations. 

3) Considered Prospective in Nature→ The data is generated from first adventure and provides some 

links on probable happenings in future. These can be taken as baseline and follow up action can be 

evolved only after the thorough analysis of the data. 

4) Volume of Data→ The primary data is at raw stage and researchers need to do thorough study step-by-

step and summarise it to use it efficiently. Researchers find the values of data statistically in a 

presentable format or in simple statements so that the outcome is easily understood by the general 

public. 

5) Specific Research Objective→ Primary data is collected with specific objective and can be used to 

generate information which is reliable and effective to a large extent after extensive analysis and 

refinements. The primary data can be collected through different modes like close monitoring, in-depth 

study of results of different groups, opinion polling at different locations, recording reaction of general 

public and making tactical operations to unearth the truth hidden behind the screen. 
 

COLLECTION OF PRIMARY DATA 

Major methods for collecting primary data are as follows: 

1) Survey→ This technique is one of the most common and widely used techniques for collecting primary 

data. Survey can be conducted using various methods such as using mails, telephones, internet, face-to-

face, etc. The selection of survey method relies upon various factors such as the nature of population to 

be studied, size of sample, allotted time, allocated budget, etc. 

2) Interview→ Interview is the exchange of ideas which takes place between two or more people with the 

purpose of getting information from the respondent. In this method, the interviewer organises a meeting 

with the respondent regarding an object or issue related to the research objective, and asks some 

questions. The responses of the interviewee are recorded and compiled to get a better insight into the 

research problem. Interview can be conducted through various methods such as personal interview, 

telephonic interview, mail interview, panel interview, etc. 

3) Observation→ Another technique for gathering primary data is observation. When the researcher 

records information about a person, organisation, or situation, without making any personal contact, it is 

known as “observation method”. In this, the researcher or the field executive observes the activity of the 

concerned person or organisation, to draw a pattern of behaviour or response to a particular incident. 

Sometimes, an artificial environment is created to collect the actual responses of the participants. 

4) Experimentation→ An important method to collect primary data is experimentation. In 

experimentation, the causal relationship is determined and analysed between variables. Experimentation 

is carried-out with the objective to study effect on a dependent variable by causing a change in the 

independent variable. For example, a research can be conducted to analyse the influence on learning due 

to guidelines and instructions in schools. 

5) Warranty Cards→ Warranty cards are generally used by the dealers of consumer durables to get the 

feedback of products from their consumers. These are the postal sized cards placed within the package of 

product. These cards contain various questions regarding the performance of product and to know the 

needs of consumers. Customers are requested to fill and mail it back. It helps in new product 

development for the manufacturer. 

6) Auditing→ Auditing is a technique for assessing the performance and current position of any 

department or the organisation. Sometimes, it is also used for understanding the market and buying 

behaviour of customers. Distributors or manufacturers use this tool for gaining the competitive 

advantage and satisfying the need of customers. It is also used by the researchers for inspecting the 

products, services or food purchased by consumers, also known as pantry audit. 

7) Simulation→ Simulation is a quantitative technique for data collection. It is the creation of an artificial 

environment resembling a real life situation. This real life situation is simulated by using various 
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mathematical equations and variables. Researchers can determine the relation between different 

variables by altering one of the variables and finding its effect on the others. 

8) Depth Interview→ When a small group of respondents is intensively interviewed on individual basis so 

as to measure their perception about a particular event, concept, idea or situation, it is called ‘Depth 

Interview’. For example, a depth interview can be conducted to explore the reviews of participants of an 

organisational event about the nature of operations, activities, its usefulness or changes required if any.  

Numerous topics or issues like strategic planning, program improvement, problem identification, need 

analysis, etc., can be facilitated with the help of depth interviews. It is very helpful for getting in-depth 

information from a relatively small number of participants, with the help of asking only open-ended 

questions. As depth interviews allow researchers to intensely recognise the attitudes and perceptions of 

the respondents over a given issue, they are majorly used for designing and evaluating extension 

programs. 

9) Projective Technique→ Projective techniques are used in those areas of qualitative research where the 

researcher aims to achieve a greater understanding of a subject. Under this technique, individuals are 

asked to express their opinions and feelings on a situation or behaviour of another individual. 

Hypothetical situations and/or behavioural patterns of individuals are created, which are ambiguous and 

vague in nature, and respondents are requested to express their beliefs and feelings on the same. 

In doing so, researchers are able to study the motivations and attitudes of the respondents themselves, 

thereby enabling them to dig deeper into the research. The degree of ambiguity of the situation 

determines the depth of motivations and emotions of the respondents that the researcher is able to unveil.  

10) Focus Group→ Focus group is a method in which a group of respondents is selected so as to collect 

desired information through a formal interactive session. It is also called ‘group interviewing method’. In 

this, the respondents response to the questions of a moderator (sometimes researcher himself/herself) to 

discuss about the given topic or research problem. Moderator asks specially designed questions so as to 

explore in-depth information. The information explored here is not possible to collect from other 

techniques like surveys, observations or interviews. 

Focus group method is characterised by the use of significant methods and strategies so as to collect and 

analyse the information generated here. This makes focus group method a reliable source of data 

collection. This type of method is used in areas like new product concept or new product development, 

improvement of production-line in an organisation, motivation program for new employees, etc. 
 

ADVANTAGES OF PRIMARY DATA 

Primary data is advantageous in research due to following reasons: 

1) Reliability→ As the primary data is collected originally by the researcher and it is current and accurate, 

it is more reliable than secondary data. 

2) Variety of Techniques→ Primary data can be collected through various techniques. There are numerous 

tools and techniques available to record and analyse primary data such as interviews, questionnaires, 

observation, audits, etc. It allows the researchers to explore effectively in almost every area where 

research is possible. 

3) Wide Coverage Including Special Cases→ Primary data is applicable in many areas including some 

special cases. Sometimes, researchers want information regarding particular cases for which previous 

literature is not available. Collecting primary data is the only solution for these specific research 

problems or issues. In these cases, primary data is the only source of information which can be trusted 

for effective solution. 

4) Complete Control over Process→ Sometimes, organisations ask the researchers to conduct the 

research in specific area rather than in broader perspective. Collecting the primary data allows the 

researchers to collect the data of their concern and represent it in ways that can benefit the organisations. 

Researchers can also decide the length of study, location in which research is to be carried out, time 

duration, etc., as per their requirement and convenience. 

5) Cost Effective Collection→ The collection of primary data is cost-effective. Many times unnecessary 

time and money is wasted in collecting secondary data, and the information proves to be useless. But in 

primary data collection, the researcher concentrates his efforts on potential sources of data which 

provide reliable information in optimal cost. 

6) Sole Ownership of Information→ As the information processed from the primary data is fresh and 

original, it can be copyrighted. This way, the researcher becomes the owner of that information. He/she 
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can take the benefit of information by sharing it with organisations. This is not so in the case of 

secondary data, as it already belongs to other person or organisation. 
 

DISADVANTAGES OF PRIMARY DATA 

Primary data has following disadvantages: 

1) Costly Affair→ Primary data collection is an expensive task. It involves different activities like 

selecting type of technique, preparing questions, and hiring trained professionals for collecting 

information or observing targets, etc. In this process, a huge amount is spent, which is why it is costly to 

conduct. 

2) Time Consuming→ Collecting primary data effectively takes more time. Developing research plan, 

deciding sources of information, and selecting the methods of data collection are time consuming 

activities. 

3) Infeasible Sometime→ Although, primary data considered to be reliable source of information, but, 

sometimes it is not an easy task to collect the primary data, as the sources of information may not be in 

the reach of researcher or may incur a huge amount of money. 

4) Huge Quantity of Data→ Sometimes data collected through primary sources are in huge quantity. This 

large volume of data leads to confusion about the accuracy of the information. The processing and 

analysis of the data becomes complex and cumbersome due to large size. 

5) Unwillingness to Answer→ Sometimes, participants do not cooperate in data collection by showing 

unwillingness to answer or by giving wrong information. These factors act as hurdles in primary data 

collection and also reflect biasness in responses. 
 

SECONDARY DATA 
When a researcher uses data which are previously collected by some other researchers, institutions, or 

agencies for their own purposes are called secondary data. The researchers collect secondary data either 

from an internal source of an organisation, or from the published sources like reports and journals. The 

purposes of data may vary from that of the current study. Hence, few portions of this data may be used for 

current research problem. It should be kept in mind that, secondary data needs to be processed before 

applying in research; as the contexts of data may have changed and modified as per their own purposes. 

For example, Total contribution of different sectors to the GDP are published by the government or some 

trade association, which may be a secondary data source for analysing the current market position of a 

particular organisation within a particular industry. That published data may provide the required 

information or fraction of it. 

Secondary data helps in various activities in a research study, such as, generating new ideas, analysing the 

needs previously addressed, understanding the tools and techniques used for similar cases, save the time, etc. 

Secondary data is given preference in the situation where a research has to be completed in shorter time 

duration. 
 

CHARACTERISTICS OF SECONDARY DATA 

Different characteristics of secondary data are as follows: 

1) Available and Adequate→ The information available from secondary data is also suitable and 

acceptable to make correct decision in solving the problem. 

2) Cheaper→ Since the information received from secondary data can be received easily, it is 

comparatively cheaper than primary data collection. The analysis of secondary data information may 

also provide equally satisfactory results required for research. The information thus collected has wider 

spectrum compared to data collected through primary collection. 

3) Less Time Consuming→ The search time involved in data collection is very much reduced in 

secondary data collection exercise compared to primary data collection. 

4) More Accurate Data→ The secondary data is based upon official count or survey conducted by 

government departments or some organisations involved in research and is bound to be more accurate 

due to vast area coverage and extensive research work undertaken which is generally not done in 

primary data collection which is based on limited survey. 

5) Helps Defining Research Problem and Generating Hypothesis→ The data obtained through 

secondary data can also significantly contribute to research work under initial stage where area is 

unfamiliar and some theory is evolved based upon limited inputs. The secondary data certainly helps 
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researchers to understand the ground realities, exposes too many options that can be followed and 

suitable alternatives may be adopted. 

6) Helps Defining the Population→ Secondary data helps to define the general status of population of an 

area. For example, the statically per capita income of people in an area can reveal the financial 

categories of the people such as affluent, rich, average middle class or below poverty line. This is also 

applicable in various other fields like agriculture, weather, etc. 
 

COLLECTION OF SECONDARY DATA 

The secondary data can be collected from following sources: 

1) Internal Secondary Data→ Secondary data generated within the research conducting organisation is 

known as internal secondary data. Data generated within the organisation can be either formal or 

informal. Formal data are generated periodically in a structured layout such as reports of various 

departments, half yearly reports, etc. On the other hand, informal data are not periodically generated 

such as conceptual booklets, new policy frameworks, etc. 

Formal internal data can be collected from following major sources: 

a) Sales Analysis: Sales analysis reports generated within the organisation are important internal source 

of secondary data. These reports contain the information about the sales pattern and fluctuations in 

market position. These can be very useful in drawing the solution of related problems. 

b) Invoice Analysis: The invoices of an organisation also act as a secondary data source. These 

invoices help in understanding the sale and purchase pattern of the organisation in different situations 

or scenarios. The information collected through the invoices may be summarised carefully to reach a 

particular solution. Various data related to customer can be obtained with the help of invoices, such 

as name of customer, type of product, location of product delivered, etc. 

c) Financial Data: Researchers can get a lot of financial data recorded within the organisation. These 

records may contain the information regarding production cost, storage cost, transportation cost, 

sales cost, etc. these data are very useful data for marketing research. These financial data are- 

periodically generated from time to time, and hence are updated. 

d) Transportation Data: The transportation data regarding the routes, vehicles, loads, etc., provide a 

lot of information regarding the transportation activities. These data allow the researchers to analyse 

the trade-offs between various costs and determine the ways to get maximum financial benefits. 

e) Storage Data: Various costs associated with storage, such as, handling cost, maintenance cost, etc., 

are the important data that are generated within the organisation. These data help the researchers in 

analysing various pros and cons related to the storage of materials and therefore suggesting suitable 

methods to be adopted. 
 

2) External Secondary Data→ Sometimes, important secondary data is not found within the organisation. 

The secondary data derived from different sources outside the organisation is known as “external 

secondary data”. Some important sources of secondary data are as follows: 

a) Libraries: Library is one of the external secondary data sources, which the researcher may use to 

collect the necessary information for the research. Different kinds of libraries provide a range of data 

for the research. Books related to research topics, journals, magazines, research papers, etc., are 

available in various libraries, maintained by different organisations and institutions. 

b) Literature: A variety of literature is available on different subjects and issues. These literatures are 

the result of extensive research practices. There is plenty of valuable information in such kind of 

sources, which can be utilised for the resolution of current research problems. 

c) Periodicals: Business periodicals are published at regular time intervals, viz., yearly, half yearly, bi- 

monthly, fortnightly, quarterly, etc. The secondary data are published by various government and 

non-government agencies regarding finance, trade, transport, industry, labour, etc. These periodical 

contain various trends, future prospects, opportunities in market, etc., which can be used by 

researchers in their current research problem. 

d) References and Bibliography: The references and bibliography of a particular research or journal 

can be a useful resource for deriving secondary data related to specific issue. Researchers can take a 

huge amount of data which can then be analysed to get deeper insight. 

e) Census and Registration Data: Data collected through census and different registration programs 

may become very useful in deriving secondary data. As this data is collected through extensive effort 
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and field work, it contains the appropriate information about various issues like, agriculture, trade, 

transport, banking, etc. 

f) Trade Associations: Large amount of useful data may be derived from trade associations as these 

contain the relevant information about the changes and happenings in the industry. The information 

from one trade association is exchanged with other trade association for updating the information 

content. Research firms gain the access to different information from these associations. 

g) Government Departments: The information available from government departments may be 

utilized as secondary data in research process. Government departments can provide various 

information regarding position and growth of different sectors of an economy like finance, banking, 

trade and transport, agriculture, etc. 

h) Private Sources: There are many organisations which publish the statistically processed data for 

further use. These are the private institutions which perform primary research about particular events 

or situations and compile the final facts and figures. Some of the examples of such sources are 

Economic Times, Financial Express, Indian Marketing Association, etc. The researchers engaged in 

current marketing research can utilise the information available from these institutions by purchasing 

journals, magazines, newspapers, etc., which are publicly available. 

i) Commercial Research Institutions: Some institutions in the market deal in purchasing and selling 

of different kind of data or information, which are collected through research. Many market research 

institutions are in the business of providing statistically processed data or information, by taking help 

of secondary data or by conducting fresh surveys. 

j) International Organisations: Several international organisations like World Health Organisation, 

World Bank, International Monetary Fund, International Labour Organisation. Asian Development 

Bank etc. are helpful in deriving required information or data about a particular research. These 

organisations have plenty of information or resources to provide data about issues like population, 

inflation, agriculture, education, labour problems, child problems, women development, trade and 

transport, etc. 
 

ISSUES TO BE CONSIDERED FOR COLLECTING SECONDARY DATA 

Secondary data are those data which already exist and are generated for some other purposes by different 

agency. These may be in published or unpublished form. However, before using the secondary data, 

following characteristic may be verified: 

1) Reliability of Data→ For ascertaining the reliability of data, following points should be verified: 

a) Name of source of data collection, 

b) Name of respondent’s source of data, 

c) Methods used for data collection, 

d) Time of data collection, 

e) Verification of bias angle of compiler and 

f) Level of accuracy needed and what is being delivered. 

In case, data is collected by government institution, recognised institution or international agency, it is 

likely to be more reliable than collected by any private institution or individual. Secondary sources of 

data, such as government institutions, institutions coming under parliamentary act and international 

organisations are considered to be reliable and dependable. 

It is important to check the reliability of data prior to using it for research studies. In the first place, it is 

important to check the experience, truthfulness, skills and capability on part of the researcher. Secondly, 

it is important to examine the methods of data collection. The method of data collection should be as 

objective and as scientific as possible. 
 

2) Suitability of Data→ The data is collected based upon purpose, extent of area coverage and type of 

inquiry. These aspects are to be looked into before acceptance of the data. If these aspects are different, 

the secondary data remains useless. There is also a need to carefully analyse the various terms and units 

of data collection from the original primary sources. 

The suitability of data solely depends upon the level of inquiry. The data may be suitable for one level of 

inquiry which may not be suitable for other level of inquiry. Hence, suitability is required to be 

ascertained before acceptance of data. 
 

3) Adequacy/Sufficiency of Data→ There are cases like dying statement of a person, eye witness of an 

accident or a murder, version of a squad deputed on secret mission, etc., which cannot be generated from 
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the primary source and thus, secondary data has to be considered. In such cases, it is simply not possible 

to access the original source. However, in cases of availability of no data, fresh efforts are to be made to 

generate primary data from original sources. 

Sometimes the level of inquiry rises and data collected from the secondary sources is not sufficient to 

satisfy the requirements. In such cases no final decision can be made and it remains useful for research 

work only. Sometimes limited area is selected for data collection and the information is required for 

much bigger area or information collected from much bigger area and information needed for a very 

limited area, in either case the secondary data may not be useful and cannot be relied upon. The data has 

to be reliable, suitable and adequate for the researchers. 

For ascertaining if the data collected is sufficient or not, it is important to view it in relationship with the 

needs of the survey and the geographical area taken into consideration while collecting the secondary 

data. For example, in case the research aims at collecting the data pertaining to salary of the employees 

in the cotton industry and the literature provides insight about all the workers in the industry, then such a 

data might prove to be futile for this study at hand. Data adequacy is also questionable in terms of the 

time frame of its availability. 
 

4) Consistency of Data→ Consistency of data means the absence of contradictory reports and this can be 

achieved by collecting the data from various sources without any bias and from different locations. For 

example, for the ground level evaluation of flood relief supplied from the government agencies, the data 

has to be collected from different sources other than the government agencies to arrive at the correct 

conclusions. 

The tools used for collecting the information may be suitable questionnaire format, interviews, 

observation of official procedures and other different types of tools used for data collection. This ensures 

the data collected is accurate and consistent. 
 

ADVANTAGES OF SECONDARY DATA 

1) Economic→ The secondary data is easier and cheaper to access. It is more economically collected 

compared to the primary data. Some of the secondary data can be obtained with absolutely no cost. 

2) Less Time Taking→ As secondary data is already processed and compiled by other researchers, it takes 

very less time to collect this data. There is variety of secondary data available from various sources. 

Hence, researchers just need to search the data from the sources. 

3) Quality→ The quality of the secondary data is unique and rare as these are originally collected by 

trained professionals who have expertise in data collection. Hence, for a researcher it is very difficult to 

match that level of quality single-handedly. 

4) Measuring Instruments are not Required→ In collecting secondary data, there is no need to decide 

the tools and techniques for gathering required information, as this data is already recorded and 

processed by other researchers. The researchers only need to identify the relevant section of this data 

which is of their concern. 

5) Availability→ Secondary data is widely available and hence easily accessible. Secondary data are 

helpful especially when it is quite difficult to collect primary data. Majority of secondary data is 

available which can be utilised for a particular research. 

6) Bases for Comparison→ Secondary data can also be used for comparative analysis with primary data. 

This way, researchers can make many interpretations regarding the data. 

7) Useful in Exploratory Research→ As exploratory research is conducted with the purpose of getting 

better insight about an issue or phenomena, secondary data is very useful in serving its purpose by 

providing extensive available information from various sources. This helps the researchers to carry out 

the research accordingly. 

8) Generates Feasible Alternatives→ Secondary data is a source which provides a variety of alternatives 

to researchers related to various problems in research. Researchers are required to analyse and study the 

solutions provided by these data through various approaches, sources, and methods, etc. 
 

DISADVANTAGES OF SECONDARY DATA 

1) Relevance→ As secondary data is collected by other researchers for other purposes, therefore, these data 

may not be relevant for the current research work. The secondary data may vary because of many 

reasons, such as, measurement and scaling, sampling technique, data analysis technique, purpose of 

research, time duration, etc. 
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2) Accuracy→ The accuracy of secondary data is questionable due to many reasons such as using 

inappropriate data collection method, researcher biasness, inappropriate sampling technique, etc., due to 

which Secondary data may not be accurate every time. 

3) Obsolete Data→ There can be a significant time gap between the secondary data and present 

requirement, and it is obvious that many times secondary data may contain obsolete information which is 

not applicable for present scenario. Therefore, including such data can be a risk to the effectiveness of 

research work. 

4) Non-Disclosure of Research Findings→ It is not always easy to have access to all the findings of a 

particular research. Some organisations or research institutions may not allow its disclosure. 

5) Difficulty in Tracing-Out Sources→ Sometimes researchers or individuals are not able to identify the 

appropriate sources of secondary data. Due to this limitation, the validity of secondary data remains 

doubtful. 
 

PRIMARY DATA VERSUS SECONDARY DATA 
 

Basis of 

Difference 
Primary Data Secondary Data 

1) Meaning 

The data is collected by the researcher 

himself for finding the solution of a 

particular problem or situation, is known as 

primary data. 

When a data, which was earlier created by 

some researchers or organisations for their 

own purposes, is used in current research for 

a similar purpose, it is known as secondary 

data. 

2) Cost 
The collection of primary data is costly as it 

includes several tools and techniques. 

It is less costly than primary data collection. 

The secondary data can be obtained easily, 

involving zero or very less amount of money. 

3) Sources It is directly collected from respondents. 
It is collected from some already available 

published or unpublished sources. 

4) Methods 

The methods used for primary data 

collection include interviews, 

questionnaires, observations, and surveys. 

The methods used for secondary data 

collection include studying and analysing 

reports, journals, census, and different 

databases. 

5) Reliability 
Primary data is more reliable as it is original 

and new. 

The reliability of secondary data is 

comparatively less reliable, as this data 

belongs to different problem or situation. 

6) Scientific 

Method 

The selection of primary data is scientific in 

nature. It includes forming hypothesis about 

the problem or situation, collecting data, and 

analysing data to prove the hypothesis right 

or wrong. 

The selection of secondary data is manual. It 

is selected according to the content of the 

source and the current research topic. 

7) Precaution 
Precautions are relatively nominal in 

collecting primary data than secondary data. 

A lot of precaution is taken in the selection 

of secondary data. 

8) Form of 

Data 

Form of primary data is like raw which 

needs to be processed to get meaningful 

information. 

Secondary data are already processed data 

that needs to be analysed and studied to use 

in research study. 

9) Accuracy 
Primary data is original and accurate, as it is 

developed according to the need. 

The secondary data is not completely 

accurate as it was developed for some other 

purpose. 

 

MARKET SIZING 
Market sizing is the process of estimating the potential of a market. Understanding the potential of a market 

is important for companies looking to launch a new product or service. 

Market size is a key component of strategic marketing planning. Knowledge of the size of target market 

allows fully assessing opportunities and accurately planning the firm’s approach and investments - wisely. 

Market size is a measurement of the total volume of a given market. Calculating market size accurately, can 

be challenge, so it is important to be clear on what one is measuring. Variables are often dynamic, so they 
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must be clearly defined. Size can also be based on consumption or production figures, so it is important to 

know what approach marketers will take. 

Marketers must take the time to assess market size and they may find answers that reveal how to achieve the 

level of growth they need. When they know their market size, they can more easily determine how to invest 

R&D budget for the year. It can also help to determine a wise level of sales and marketing investments - in 

the right areas. Marketing strategies become clear. Marketers do not want to spend too much in a market 

when return will be low, but they also do not want to under invest in a high growth, fast moving market. But 

be careful not to base investment decisions on rumour or expert opinions.  
 

CATEGORIES OF MARKET SIZING 

Categories of market sizing are given below: 

 
 

1) Market Potential→ Assuming 100% market Share, the total potential value of product/service sold over 

a specified timeframe. 

2) TAM (Total Addressable Market)→ The potential value of Product/Service sold to a particular 

customer segment. 

3) SAM (Serviceable Available Market)→ The total value of Product/Service that can fulfill the demand 

of a segment using a one revenue stream/channel. 

4) SOM (Serviceable Obtainable Market)→ The total value of SAM divided by the expected percentage 

market share that the company can capture. 
 

EVALUATING MARKET SIZING 

There are several kinds of market sizing techniques that businesses should consider and use in their market 

size analysis. The most important step, before considering anything that will help marketer estimate to 

market, is having good data that accurately paints the picture of the marketplace or industry. Having good 

data and research is necessary to understanding how to estimate the market size. Before working with any 

market size estimation techniques, marketer must make sure that he has solid information to draw from and 

analyse. 

With good data, marketer can: 

1) Look at the Competition→ The marketer must identify his number of competitors in the market. This 

will tell the marketer a lot about the potential size of the market. If the marketer has a lot of competition, 

he knows that he is competing with other businesses for customers, effectively reducing or limiting the 

potential market. 

2) Understand the Product→ The marketer must be realistic about things that will affect who will buy the 

product. Things like cost, usefulness, reliability, or availability will influence how many people are truly 

in the market. 

3) Understand Customer→ Similar to understanding the product, marketer must know something about 

his customer when doing market size calculation. Are customers likely to be male? That tells marketer 

something about the market. Are they likely to be college-educated? Found in cities? Make a certain 

salary a year? Knowing the target customer always leads to helping marketer to estimate the market size. 
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MARKET SIZING APPLICATIONS 

1) Market Trends: Take advantage of trends 

2) Sales Forecasts: Forecast as % of total market . 

3) Sales force Sizing: Number of salespersons to hire 

4) Distribution Channels: Type of channel(s) to employ 

5) Market Segments: Number and size of segments 

6) Market Share: Need total size to calculate share 

7) Adoption Rate: Keeping up with industry average? 

8) Life Cycle: Growth or decline? 

9) Market Investment: Continue investing in market? Explore new niche? 
 

APPROACHES TO MARKETING SIZING 

There are fundamentally two different approaches to sizing a market: top-down analysis or bottom-up 

analysis. Ideally, in any market sizing exercise, both of these methodologies should be used to ensure the 

appropriate reliability of the data and to point out any areas requiring further research for reconciliation. 

1) Top-down Approach→ In a top-down approach, the starting point is an existing (or easily developed) 

estimate of total demand for a given product that needs to be further segmented or refined based on the 

outlined scope of the exercise. 

2) Bottom-up Approach→ In a bottom-up approach, demand is calculated by applying usage assumptions 

to an indicator or statistic that directly relates to the product being consumed (i.e., a direct indicator). 
 

With both approaches, the estimate becomes more refined as more factors are taken into consideration, for 

example, accounting for differences in purchasing parity, oil component of GDP, local competition and 

selling prices, market maturity, brand awareness and value etc. 
 

TOP-DOWN APPROACH 

When deciding whether to use this form of market sizing analysis, it needs to be determined if a reliable top-

line demand estimate is available. There are numerous sources that one can turn to in search of a top-line 

demand estimate, each of which have advantages and disadvantages that need to be balanced in the 

performance of this analysis. Often times, more than one of these techniques can, and should, be used in 

conjunction with one another. 
 

This is where a ‘big picture’ view of a market is used as a starting point and a series of filters are applied to 

give an estimate for the specific market. A simple example of this is taking a global market estimate and 

splitting it to a country estimate based on GDP. 
 

The Top-Down Approach estimates the addressable market from above, by starting with a broad market size 

figure (e.g. an existing market research report for a bigger segment) and narrows it down to the target market 

segments by using assumptions and statistics. Some assumptions can be verified via existing data or 

statistics; others cannot and have to rely on the best guess or judgement of the market modeller. The top-

down approach is usually considered as a less robust methodology. It is the “fast and cheap” of market 

sizing and tends to give market estimates that are too high. 

 
Top-Down Market Size Analysis 
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In comparison, a top-down analysis is a procedure in which a larger reference market is used and the 

percentage of that market that a company expects to capture is estimated. There are two different techniques 

for top-down analysis, as described below. 

1) Using a Known Reference Market→ In this method, the size of a known reference market is required 

and then the amount of that market that is contributed by a specific segment of interest is estimated. 
 

2) Market Sizing Using Population Metrics→ This can almost always result in misleading information. 

In this method, the size of a specific population is used and then a company estimates the percentage of 

that population that it can capture with its services. 
 

BOTTOM-UP APPROACH 

The bottom-up approach is typically taken when no reliable sources of top-line demand exist or when a 

more reliable estimate can be developed by analysing product consumption as it relates to a direct indicator. 

This approach can be more time consuming than a top-down methodology and is sensitive to seemingly 

small assumptions that can cascade through the analysis. 

This uses the reverse approach, building up the estimate from the lowest point where the product can be 

used. For example, if a product is sold into hospitals, we could start with the number of hospital beds.  

Assuming we see a £5 average sales data, we can multiply £5 by the total number of hospital beds. As with 

the top down approach, further refinement is often needed, for example, to account for different sizes and 

types of hospital as well as differences in bed use etc. 

 
Bottom-up Market Sizing 

Step 1: Identify Relevant Market Segments: The very first step in bottom-up market sizing approach is to 

identify the relevant and potential market segment. For example if marketers are selling an educational 

product, two relevant criteria for that might be “user sophistication” and “resources.” Plotting all the 

different groups of customers might yield something like the below plot. 

One can even go a step further with segmentation. For example, Universities come in all shapes and sizes. 

Universities may include: Research Universities, Liberal Arts Colleges, and Community Colleges. Likewise 

Government funded groups vary in size, from 100K students (small) to urban school programs (large) which 

may support up to 500K students. 
 

Step 2: Find the Market Contribution of Each Segment: Use resources such as Census data, Bureau of 

Labour Statistics, or other public databases. For example if marketer is looking at Community Colleges, 

The National Centre for Education Studies reports that there are 1,669 Community Colleges in the India 

total. These schools spend 465 million dollars annually. Of this total, 15 million is allocated to IT services. If 

one can realistically capture 1% of this segment, then the Community Colleges segment can contribute 

$150,000 to his total annual market potential. Repeat the process for the Research University segment, 

Liberal Arts College segment etc. 
 

Step 3: Iterative Market Analysis: These projections are not set in stone and they will change as one can 

understand his market better. Refine this model as one learn more about competitors and customers. Maybe 

the market is much smaller than anticipated and you need to reposition the offering. Maybe it is much larger 

than expected, and one needs to rise funding, to achieve the necessary scale to become profitable. 
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STAKEHOLDERS FOR MARKET SIZING 

A stakeholder is a party that has an interest in a company and can either affect or be affected by the business. 

The primary stakeholders in a typical corporation are its investors, employees, customers and suppliers. 

However, the modern theory of the idea goes beyond this original notion to include additional stakeholders 

such as a community, government or trade association. 

Stakeholders can be internal or external. Internal stakeholders are people whose interest in a company comes 

through a direct relationship, such as employment, ownership or investment. External stakeholders are those 

people who do not directly work with a company but are affected in some way by the actions and outcomes 

of said business. Suppliers, creditors and public groups are all considered external stakeholders. 

1) Internal Stakeholder→ Investors are a common type of internal stakeholder and are greatly impacted 

by the outcome of a business. If, for example, a venture capital firm decides to invest $5 million into a 

technology start-up in return for 10% equity and significant influence, the firm becomes an internal 

stakeholder of the start-up. The return of the company’s investment hinges on the success, or failure, of 

the start-up, meaning it has a vested interest. 

2) External Stakeholder→ External stakeholders are a little harder to identify, seeing as they do not have 

a direct relationship with the company. Instead, an external stakeholder is normally a person or 

organization affected by the operations of the business. When a company goes over the allowable limit 

of carbon emissions, for example, the town in which the company is located is considered an external 

stakeholder because it is affected by the increased pollution. 

Conversely, external stakeholders may also sometimes have a direct effect on a company but are not 

directly tied to it. The government, for example, is an external stakeholder. When it makes policy 

changes on carbon emissions, continuing from above, the decision affects the operations of any business 

with increased levels of carbon. 
 

STAKEHOLDERS WITH RESPECT TO MARKET SIZING 

The stakeholders involved in the market sizing are: 

1) Marketing Departments→ The role of marketing department in estimating the market size is to 

investigate new markets and to calculate market share. 

2) Operations Departments→ The operations department is responsible for the products manufacturing 

like how many units to make and in the service delivery such as how many people to hire. 

3) Channel Partners→ In market sizing, channel partners refer to the number of units to move in channel. 

4) Financial Services→ Financial services includes VC: Large and growing market, $500M - $1B 
 

PROBLEMS WITH STAKEHOLDERS 

A common problem that arises with having numerous stakeholders in an enterprise is their various self-

interests may not all be aligned. In fact, they may be in direct conflict. The primary goal of a corporation, 

for example, from the viewpoint of its shareholders, is to maximize profits and enhance shareholder value. 

Since labour costs are a critical input cost for most companies, a company may seek to keep these costs 

under tight control. This might have the effect of making another important group of stakeholders, its 

employees, unhappy. The most efficient companies successfully manage the self-interests and expectations 

of their stakeholders. 
 

IMPORTANCE OF MARKET SIZING 

Importance of market sizing is given below: 

1) Quantify the sales or profit potential of new product markets or customer segments. 

2) Identify product lines and customer segments with lucrative growth opportunities. 

3) Helps validate Business Model hypothesis. 

4) Specify competitive threats and develop strategic responses to those threats. 

5) Develop exit strategies or pivot points for the future. 

6) Important to Investors. They want a scalable product addressing a large enough market to get the most 

bang for their bucks. Listen to them. 
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PESTLE ANALYSIS 

PESTLE stands for political, economic, socio-cultural, technological, legal, and environmental. It is an 

analytical tool available to companies to determine how external factors influence their operations and make 

them more competitive in the market. 

This method looks at the factors in a nation or marketplace, and examines how those factors affect the 

consumer: 

1) Political factors→ Includes government policy and legislative changes that affect the economy, such as 

tax and employment laws. 

2) Economic factors→ These are inflation, exchange rates, recessions, and supply and demand. 

3) Socio-cultural factors→ Includes consumer demographics, culture, and lifestyle. 

4) Technology→ These are factors like changes in technology, how technology is used in different sectors 

and industries, and research. 

5) Legal factors→ These are legal aspects that affect businesses such as consumer law, copyright law, and 

health and safety law. 

6) Environmental factors→ These have little to do with the actual business, including climate, pollution, 

weather, and environment-related laws. 

PESTLE analysis allows managers, marketing, and financial experts to examine specific factors (outside of 

money) when making decisions about the company's services or products. 

Results from PESTLE analysis allow the company to make specific choices when planning the company's 

future, from how the brand should be presented, to any changes within the structure of the company's 

organization, to the development of new products. 

 

PORTER FIVE FORCE ANALYSIS 

Porter’s 5 Forces is an analytical model used to help identify the structure of an industry and to help 

companies determine their competitive strategies. The model was developed by Harvard Business School 

professor Michael E. Porter as part of his book “Competitive Strategy: Techniques for Analyzing Industries 

and Competitors,” published in 1980. 

The model can be applied to any segment of the economy. It helps explain why various industries maintain 

different degrees of profitability. 

The model is widely used to analyze the industry structure of a company as well as its corporate strategy. 

Porter identified five undeniable forces that play a part in shaping every market and industry in the world. 

The forces are frequently used to measure competition intensity, attractiveness and profitability of an 

industry or market. 

These forces are: 
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1) Threat of new entrants→ This force determines how easy (or not) it is to enter a particular industry. If 

an industry is profitable and there are few barriers to enter, rivalry soon intensifies. When more 

organizations compete for the same market share, profits start to fall. It is essential for existing 

organizations to create high barriers to enter to prevent new entrants. Threat of new entrants is high 

when: 

 Low amount of capital is required to enter a market; 

 Existing companies can do little to retaliate; 

 Existing firms do not possess patents, trademarks or do not have established brand reputation; 

 There is no government regulation; 

 Customer switching costs are low (it doesn’t cost a lot of money for a firm to switch to other 

industries); 

 There is low customer loyalty; 

 Products are nearly identical; 

 Economies of scale can be easily achieved. 
 

2) Bargaining power of suppliers→ Strong bargaining power allows suppliers to sell higher priced or low 

quality raw materials to their buyers. This directly affects the buying firms’ profits because it has to pay 

more for materials. Suppliers have strong bargaining power when: 

 There are few suppliers but many buyers; 

 Suppliers are large and threaten to forward integrate; 

 Few substitute raw materials exist; 

 Suppliers hold scarce resources; 

 Cost of switching raw materials is especially high. 
 

3) Bargaining power of buyers→ Buyers have the power to demand lower price or higher product quality 

from industry producers when their bargaining power is strong. Lower price means lower revenues for 

the producer, while higher quality products usually raise production costs. Both scenarios result in lower 

profits for producers. Buyers exert strong bargaining power when: 

 Buying in large quantities or control many access points to the final customer; 

 Only few buyers exist; 

 Switching costs to other supplier are low; 

 They threaten to backward integrate; 

 There are many substitutes; 
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 Buyers are price sensitive. 
 

4) Threat of substitutes→ This force is especially threatening when buyers can easily find substitute 

products with attractive prices or better quality and when buyers can switch from one product or service 

to another with little cost. For example, to switch from coffee to tea doesn’t cost anything, unlike 

switching from car to bicycle. 

 

5) Rivalry among existing competitors→ This force is the major determinant on how competitive and 

profitable an industry is. In competitive industry, firms have to compete aggressively for a market share, 

which results in low profits. Rivalry among competitors is intense when: 

 There are many competitors; 

 Exit barriers are high; 

 Industry of growth is slow or negative; 

 Products are not differentiated and can be easily substituted; 

 Competitors are of equal size; 

 Low customer loyalty. 
 

When a company’s management uses the five forces, it can create ways to take better advantage of a 

situation of strength, overcome a situation of weakness, and avoid making mistakes that would provide 

someone else a competitive edge.  
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UNIT-2: PRICING ANALYTICS (8 HRS) 

 
Pricing Policy and Objectives, Estimating Demand Curve: Price Elasticity, Estimating Linear and Power 

Demand Curves, Optimize Pricing, Incorporating Complementary Products, Pricing using Subjective 

Demand Curve, Pricing Multiple Products. 

Price Bundling & Nonlinear Pricing: Pure Bundling & Mixed Bundling, Determine Optimal Bundling 

Pricing, Profit Maximizing strategies using Nonlinear Pricing Strategies, Price Skimming & Sales, Revenue 

Management: Markdown Pricing and Handling Uncertainty. 
 

MEANING OF PRICING ANALYTICS 
Pricing analytics are the metrics and associated tools used to understand how pricing activities affect the 

overall business, analyse the profitability of specific price points, and optimize a business’s pricing strategy 

for maximum revenue. 

Pricing analytics is a way of analysing the effects of pricing, such as who is purchasing a product (e.g. age, 

class, income, etc.), best-selling locations (e.g. store, region, etc.), and also the effectiveness of deals or 

discounts. By understanding these types of data, salespeople can better determine how to adjust the price 

value of their items accordingly, thereby overriding competition other businesses pose and increasing 

profitability. 

Pricing Analytics enables companies, across all industries, to dramatically improve profitability and market 

share by defining optimal prices and pricing strategy. 

Deciding the price value of a product can be very challenging, even amongst the most experienced in 

marketing and business management. Despite the challenge, it is a skill that is extremely essential to learn 

and perform well, especially in today’s economy. 

Pricing analytics software can analyse previous pricing data and accurately predict the outcome of price 

inflation or deflation, sales and their effect on company profit, and much more. Pricing analytics software, 

models and analytics are such valuable assets to an organization, as they help businesses understand how 

much of an impact pricing has on sales and profit. 
 

NEEDS FOR PRICING ANALYTICS 

1) Learning about Customers→ In spite of the increased availability of information, many companies are 

still blind (and deaf), when it comes to knowing their customers. For those companies, simple 

descriptive and diagnostic tools, including customer segmentation, can help dramatically improve 

performance. Many manufacturing firms observe its margins improving by 4% by simply aligning its 

pricing (and especially its discounting) along the customer segments. 

2) Identifying Pricing Opportunities→ The implementation of pricing analytics tools often leads to 

uncover “quick wins”, or extra revenue and/or margin that can be generated over a short period of time 

by fixing the most obvious cases of price misalignment or leakages. The quick wins are very often the 

first building block of a longer term effort to realign prices and increase margins. 

3) Planning Pricing Changes and Promotions→ Companies with a pricing strategy already in place have 

different needs, typically revolving around the necessity to closely monitor the market and to 

anticipate the impact of a price change or a promotional campaign. Those companies usually require 

predictive models, capable of reproducing what actually happened in the past, and hence to predict what 

will happen in the future with great accuracy. 

For instance, one consumer packaged goods industry uses a predictive model to plan its price changes 

and promotions. Using the model over time, they have learned a lot about what to do and even more 

about what NOT to do. Ultimately, this saved the company millions of dollars by putting an end to 

inefficient promotions. 

4) Optimizing Pricing→ Building upon the predictive pricing models they use to manage their prices and 

promotions, some companies take it to the next level and implement full-fledged profit optimization 

tools. Companies that successfully manage the shift typically have had a sound pricing strategy in place 

for several years and at the same time excel at execution. 

5) Getting Stakeholders to buy into the Pricing Strategy→ Generally speaking, this need applies to all 

companies, regardless of their industry, size or the degree of sophistication of their pricing strategy. As 

every pricing manager knows too well, getting all the internal stakeholders (whether from sales, 

marketing, finance or even production) to agree upon the pricing strategy and execute it accordingly, can 
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prove to be a major challenge. The very fact of backing the strategy itself with “cold hard facts” and a 

scientifically robust analysis of the data can help facilitate this process and get approval from the various 

stakeholders more easily. 
 

BENEFITS OF PRICING ANALYTICS 

1) Helps in Identifying Competitor Price Tracking→ Businesses can track and monitor competitor 

pricing in real-time by leveraging pricing analytics solutions. Additionally, it helps businesses to 

formulate pricing strategy by comparing it with that of the competitor’s strategy. Furthermore, this can 

improve customer responsiveness and market standing. Price tracking of competitors can also help 

businesses in customer retention. 

2) Improves Price Triggers Tracking→ For businesses, tracking the price triggering points has become 

very important with the frustrating competition. This is where pricing analytics helps. It helps companies 

in improving their capabilities to analyse the factors triggering the price of a product or service and then 

change their pricing strategies accordingly. 

3) Aids in Price Elasticity Analysis→ Price elasticity is one of the foundation of pricing strategy and 

pricing analytics helps in analysing price elasticity efficiently by leveraging customer’s buying 

behaviour and purchasing data. Furthermore, these solutions can help companies in measuring the 

quantity demanded of a good or service by the customers. 

4) Helps in Decision Making→ Effective business decisions based on tightly defined issues including the 

customers who need to be focused on and the products to rationalize. These decisions are based purely 

on clear-cut data rather than intuition 

5) Quick Response towards Marketing Changes→ Improved agility (quickness) in responding to 

changing market conditions or shifting competitive environment. 

6) Helps in Getting Feedback→ Provides clear feedback loops so that pricing teams can assess the 

effectiveness and adjust as needed. 

7) Reduce Costs→ Pricing analytics provides the ability to avoid costly mistakes or missed opportunities 

by running advanced scenario modelling—for instance; it helps identify the potential impact of a pricing 

change on the overall demand and profitability. 

 

PRICING OBJECTIVES 

1) Profits-related Objectives→ Profit has remained a dominant objective of business activities. 

Company’s pricing policies and strategies are aimed at following profits-related objectives: 

a) Maximum Current Profit→ One of the objectives of pricing is to maximize current profits. This 

objective is aimed at making as much money as possible. Company tries to set its price in a way that 

more current profits can be earned. However, company cannot set its price beyond the limit. But, it 

concentrates on maximum profits. 

b) Target Return on Investment→ Most companies want to earn reasonable rate of return on 

investment. Target return may be: 

 Fixed Percentage of Sales; 

 Return on Investment; or 

 A Fixed Rupee Amount. 

Company sets its pricing policies and strategies in a way that sales revenue ultimately yields average 

return on total investment. For example, company decides to earn 20% return on total investment of 

3 crore rupees. It must set price of product in a way that it can earn 60 lakh rupees 
 

2) Sales-related Objectives→ The main sales-related objectives of pricing may include: 

a) Sales Growth→ Company’s objective is to increase sales volume. It sets its price in such a way that 

more and more sales can be achieved. It is assumed that sales growth has direct positive impact on 

the profits. So, pricing decisions are taken in way that sales volume can be raised. 

b) Target Market Share→ A company aims its pricing policies at achieving or maintaining the target 

market share. Pricing decisions are taken in such a manner that enables the company to achieve 

targeted market share. Market share is a specific volume of sales determined in light of total sales in 

an industry. For example, company may try to achieve 25% market shares in the relevant industry. 

c) Increase in Market Share→ Sometimes, price and pricing are taken as the tool to increase its 

market share. When company assumes that its market share is below than expected, it can raise it by 

appropriate pricing; pricing is aimed at improving market share. 
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3) Competition-related Objectives→ Competition is a powerful factor affecting marketing performance. 

Every company tries to react to the competitors by appropriate business strategies. With reference to 

price, following competition-related objectives may be priorized: 

a) To Face Competition→ Pricing is primarily concerns with facing competition. Today’s market is 

characterized by the severe competition. Company sets and modifies its pricing policies so as to 

respond the competitors strongly. Many companies use price as a powerful means to react to level 

and intensity of competition. 

b) To Keep Competitors Away→ To prevent the entry of competitors can be one of the main 

objectives of pricing. To achieve the objective, a company keeps its price as low as possible to 

minimize profit attractiveness of products. In some cases, a company reacts offensively to prevent 

entry of competitors by selling product even at a loss. 

c) To Achieve Quality Leadership by Pricing→ Pricing is also aimed at achieving the quality 

leadership. The quality leadership is the image in mind of buyers that high price is related to high 

quality product. In order to create a positive image that company’s product is standard or superior 

than offered by the close competitors; the company designs its pricing policies accordingly. 

d) To Remove Competitors from the Market→ The pricing policies and practices are directed to 

remove the competitors away from the market. This can be done by forgoing the current profits – by 

keeping price as low as possible – in order to maximize the future profits by charging a high price 

after removing competitors from the market. Price competition can remove weak competitors. 
 

4) Customer-related Objectives→ Customers are in center of every marketing decision. Company wants 

to achieve following objectives by the suitable pricing policies and practices: 

a) To Win Confidence of Customers→ Customers are the target to serve. Company sets and practices 

its pricing policies to win the confidence of the target market. Company, by appropriate pricing 

policies, can establish, maintain or even strengthen the confidence of customers that price charged 

for the product is reasonable one. Customers are made feel that they are not being cheated. 

b) To Satisfy Customers→ To satisfy customers is the prime objective of the entire range of marketing 

efforts. And, pricing is no exception. Company sets, adjusts, and readjusts its pricing to satisfy its 

target customers. In short, a company should design pricing in such a way that result into maximum 

consumer satisfaction. 
 

5) Other Objectives→ Over and above the objectives discussed so far, there are certain objectives that 

company wants to achieve by pricing. They are as under: 

a) Market Penetration→ This objective concerns with entering the deep into the market to attract 

maximum number of customers. This objective calls for charging the lowest possible price to win 

price-sensitive buyers. 

b) Promoting a New Product→ To promote a new product successfully, the company sets low price 

for its products in the initial stage to encourage for trial and repeat buying. The sound pricing can 

help the company introduce a new product successfully. 

c) Maintaining Image and Reputation in the Market→ Company’s effective pricing policies have 

positive impact on its image and reputation in the market. Company, by charging reasonable price, 

stabilizing price, or keeping fixed price can create a good image and reputation in the mind of the 

target customers. 

d) To Skim the Cream from the Market→ This objective concerns with skimming maximum profit 

in initial stage of product life cycle. Because a product is new, offering new and superior advantages, 

the company can charge relatively high price. Some segments will buy product even at a premium 

price. 

e) Price Stability→ Company with stable price is ranked high in the market. Company formulates 

pricing policies and strategies to eliminate seasonal and cyclical fluctuations. Stability in price has a 

good impression on the buyers. Frequent changes in pricing affect adversely the prestige of 

company. 

f) Survival and Growth→ Finally, pricing is aimed at survival and growth of company’s business 

activities and operations. It is a fundamental pricing objective. Pricing policies are set in a way that 

company’s existence is not threatened. 
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PRICE ELASTICITY 

The price elasticity for demand is the percentage of decrease in demand resulting from a 1 percent increase 

in price. When elasticity is larger than 1, demand is price elastic. When demand is price elastic, a price cut 

will increase revenue. When elasticity is less than 1, demand is price inelastic. When demand is price 

inelastic, a price cut will decrease revenue. Studies by economists have obtained the following estimates of 

elasticity: 

 Salt  : 0.1 (very inelastic) 

 Coffee  : 0.25 (inelastic) 

 Legal fees  : 0.4 (inelastic) 

 TV sets  : 1.2 (slightly elastic) 

 Restaurant meals : 2.3 (elastic) 

 Foreign travel : 4.0 (very elastic) 

A 1 percent decrease in the cost of foreign travel, for example, can result in a 4 percent increase in demand 

for foreign travel. Managers need to understand the price elasticity at each price point to make optimal 

pricing decisions. 

 

DEMAND CURVE 
The demand curve is a graphical representation of the relationship between the price of a good or service 

and the quantity demanded for a given period of time. In a typical representation, the price will appear on 

the left vertical axis, the quantity demanded on the horizontal axis. The demand curve will move downward 

from the left to the right, which expresses the law of demand — as the price of a given commodity increases, 

the quantity demanded decreases, all else being equal. 

Demand schedules can be drawn up to show how a single individual reacts to price changes, or to show how 

a whole market will react to price changes. A market demand curve will be derived by adding up the sum of 

all individual consumers in a market. 

 

ESTIMATING DEMAND CURVE 

Demand curve estimation refers to the exercise of estimating the demand curve, typically the market demand 

curve (as opposed to the individual demand curve) for a good. Demand curve estimation is typically done 

for the following purposes: 

1) It may be done by sellers (and in some cases buyers) with significant market power, so that they can 

decide the appropriate price to set. Note that buyers or sellers who do not have market power simply set 

the price as the market price and know that whatever quantity they produce will get sold. In contrast, in 

the extreme case of a monopoly, the seller chooses both the price and quantity but is not guaranteed to 

sell everything. In order to be so guaranteed, the seller needs to have a plot of the market demand curve 

so that the (price, quantity) pair can be chosen as a point on the demand curve. 

2) It may be done by buyers or sellers in order to better estimate prices and quantities to buy or sell for the 

future. Note that this is advantageous even in a perfectly competitive market: with knowledge of the 

future demand and supply curves, sellers can estimate future prices, and therefore optimize their long-

run choices (i.e., make appropriate fixed cost investments). 
 

The two most common forms for estimating demand curve is as follows: 

1) Linear demand curve 

2) Power demand curve 
 

ESTIMATING LINEAR DEMAND CURVE 

A linear demand curve is the graphical representation of the relationship between the price of a good and 

the quantity of those good consumers are willing to pay at a certain price at a point in time. The slope, or 

rate that the line rises or falls, is equal to the difference between two quantities of a product, usually 

represented on the horizontal axis on the graph, divided by the difference price of two points of the graph, 

usually on the vertical axis. 

Linear curves rarely exist in the real world because demand depends in large part on elasticity of demand, or 

how consumers react to a change in price. Also, the relationship between demand and price is not always 

constant. Some products are in demand regardless of price. 
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For example, customers probably use about the same amount of electricity regardless of price because it is 

essential to living. On the other hand, televisions are a luxury, so consumers usually become exponentially 

more willing to buy a unit as the price drops. 

In linear demand curve, there is a straight-line relationship between price and demand. Symbolically, it can 

be represented as: 

D = a – bp 

Where, 

D: units of product demanded by customers 

p: per-unit price 

a and b: adjust curve to fit product’s price elasticity 
 

Suppose that a product’s demand curve follows a linear demand curve. Given the current price and demand 

for a product and the product’s price elasticity of demand, determining the product’s demand curve is a 

simple matter. The following example illustrates how to fit a linear demand curve. 

Suppose a product is currently selling for Rs.100 and demand equals 500 units. The product’s price elasticity 

for demand is 2. Assuming the demand curve is linear; one can determine the equation of the demand curve. 

 
Given two points, one should know that there is a unique straight line that passes through those two points. 

You actually know two points on your demand curve. One point is p=100 and q=500. Because elasticity of 

demand equals 2, a 1 percent increase in price results in a 2 percent decrease in demand. Thus, if p=101 (a 1 

percent increase), demand drops by 2 percent of 500 (10 units) to 490. Thus p=101 and q=490 is a second 

point on the demand curve. You can now use the Excel Trend line to find the straight line that passes 

through the points (100,500) and (101,490). 
 

ESTIMATING POWER DEMAND CURVE 

Arc that shows relationship between price and demand, when product’s price elasticity is not affected by 

product’s price is referred to as power demand curve. Symbolically, it can be represented as 

D = apb 

Where, 

D: units of product demanded by customers 

p: per-unit price 

a and b: adjust curve to fit product’s price elasticity 

b is additive inverse of price elasticity (ex: b = -2 if elasticity = 2) 
 

In this situation, the demand curve is described by a power curve of the form q = apb. If demand follows a 

power curve, for any price, the elasticity equals –b. Thus, for the demand curve q = 100p–2 the price 

elasticity of demand always equals 2. 

Recall that for a linear demand curve the price elasticity is different for each price point. If the marketing 

analyst believes that elasticity remains relatively constant as price changes, then one can use a power 

demand curve (which has constant price elasticity) to model demand for a product. Again assume that a 

product is currently selling for Rs. 100 and demand equals 500 units. Assume also that the product’s price 

elasticity for demand is known to equal 2. You can fit a power demand curve to this information by 

performing the following steps in the Powerfit.xls file, as shown in figure below. 
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1) After naming cell E3 as a, enter a trial value for a. 

2) In cell D5, enter the current price of $100. Because elasticity of demand equals 2, you know that the 

demand curve has the form q = ap–2 where a is unknown. 

3) In cell E5, enter a formula that computes the demand when the unit price equals $100. The demand is 

linked to your choice of the value of a in cell E3 with the formula a×D5^-2. 

4) Now use the Global Seek command to determine the value of a. This formula makes the demand for 

price $100 equal to 500 units. Goal Seek enables you to find a value of a cell in a spreadsheet (called the 

By Changing Cell) that makes a formula (called the Set Cell) hit a wanted Value. In the example you 

want to change cell E3 ^o that the formula in cell E5 equals 500. Set cell E5 to the value of 500 by 

changing cell E3. 

5) To invoke Goal Seek, switch to the Data tab and select What-If analysis from the Data Tools Group, 

then choose Goal Seek from the drop down arrow. With these settings, Excel changes the changing cell 

(E3) until the value of the set cell (E5) matches your desired value of 500. 
 

A value for a = 5 million yields a demand of 500 at a price of $100. Thus, the demand curve is given by q = 

5,000,000p–2. For any price, the price elasticity of demand on this demand curve equals 2. 

 

OPTIMISE PRICING 
Pricing optimisation is using data from customers and the market to understand how one should most 

effectively be pricing the product. The optimal price point is the price where companies can best meet their 

objectives, whether that means increased profit margins, customer growth, or a blend. 

Price optimisation is the use of mathematical analysis by a company to determine how customers will 

respond to different prices for its products and services. It is also used to determine the prices that the 

company determines will best meet its objectives such as maximizing operating profit. The data used in 

price optimisation can include survey data, operating costs, inventories, and historic prices & sales. Price 

optimization practice has been implemented in industries including retail, banking, airlines, casinos, hotels, 

car rental, cruise lines and insurance industries. 
 

Information used in price optimization includes things like: 

1) Customer survey data 

2) Demographic and psychographic data 

3) Historic sales data 

4) Operating costs 

5) Inventories 

6) Machine learning outputs 

7) Subscription lifetime value and churn data (for subscription business models) 
 

Pricing optimisation is a similar process to dynamic pricing strategies used in hospitality, travel, ecommerce, 

and other industries, although dynamic pricing tends to change much more rapidly as companies tweak 

pricing to match real-time demand. 
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NEED OF PRICE OPTIMISATION 

The goal of pricing optimisation is to find that perfect balance of profit, value, and desire. Since one cannot 

control which products and features customers want, and adding valuable product features takes time and 

effort, most companies start finding that balance by setting two things: the starting price of their product or 

services, and any discounts or promotions they might offer. 

1) Starting Prices→ Marketer’s starting price, or base price, is important since it lets customers know 

whether the product or service is worth their time and investment. Starting prices should be optimised to 

match the baseline demand for the product before any discounts or promotions are applied. Optimising 

the starting price works well for companies with products and services that remain fairly stable over 

time, like groceries, office supplies, or even SaaS products. 

2) Discounted Prices→ If one is in sales, he/she needs to know what works best to pull in new customers. 

Offering the product at a discount—or, in some cases, even offering a freemium version—is a great way 

to bring in new customers (customers acquired through freemium offerings cost nearly half as much to 

acquire as those who sign up for paid offerings directly). 

3) Promotional Prices→ What promotional offers would serve the marketer and his/her customer’s best? 

Will markdowns create any additional profit, or are the marketer better off charging the starting price? 

How big of a discount should one can offer below the starting prices? How long will something take to 

sell at a specific price point? Optimising the promotional prices can help boost sales for newly 

introduced products and promotional bundles—for example, a SaaS company launching a new product, 

or bundling multiple products. 
 

HOW TO OPTIMISE PRICING 

Finding the right price for the product—a price that maximises value for customers and profit for 

marketer— starts with gaining a deep understanding of the customers. Marketers need to understand who the 

best customers are, what features they like, and what features they need. Once marketers understand that, 

he/she can align the pricing with what they value, tracking the results of the price changes he/she make and 

improving over time. 

1) Get to Know Your Customers→ Optimising the pricing is all about the data—both qualitative and 

quantitative. Hard data is the only way to find out how much customers are willing to pay for the 

product, and it is the key to breaking free from the guessing cycle. Quantitative data, like transactional 

data, customer reviews, supply and demand data, churn rate, MRR, and more show marketers how 

he/she is doing and what needs to be changed. Software like Price Intelligently can help marketer make 

sense of those metrics and turn them into pricing insights by slicing and dicing the data based on 

demographic, psychographic, and customer preferences. Just as helpful, qualitative data comes from 

talking to customers. Surveys are great, but they’re no match for picking up the phone and actually 

talking to customers, asking them about topics such as their price sensitivity and what features or 

benefits they value most in the product. 

2) Quantify Value→ Once marketers have collected all the customer data, it is time to work out what 

“value” actually means to the customers. That means working out the value metric. Marketer’s value 

metric is essentially what and how he/she is charging for the product—identifying and pricing along the 

proper value metric is the difference between surviving and thriving. 

3) Analyse the Data→ Marketer’s have collected some customer data and worked out what the customers 

value—now it is time to look for patterns in the features, benefits, price points, and value metrics that 

drive or detract from value. One can also find out how willing different segments and personas are to 

pay different prices for the products. One can use findings to create tiers and proper packages for the 

product or services. Each tier should be priced along the value metric, and should align with the different 

buyer personas so that marketer’s offering the right amount of product or service to each customer 

segment. 

4) Adjust Pricing and Monitor→ Even once marketers set the prices, they are still not done—the value 

one can provide versus the competitor’s is constantly changing, so one needs to be constantly monitoring 

and adjusting the pricing. Pricing is an ongoing process. One need to continually collect data and analyse 

the value customers are getting from the product to make sure that what one is offering still meets the 

customer’s needs and pricing desires. One can make sure to keep a very close eye on the pricing, and see 

how customers respond. If need be, re-evaluate and change things up—but don’t be too quick to switch, 

since one might alienate potential or existing customers. 
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REASONS FOR FAILURE OF COMPANIES TO OPTIMISE PRICING 

To make a long story short, most companies are not willing to put in the effort to optimise their pricing 

decisions. All the customer research needed to figure out the right valuations takes time and effort. 

Surprisingly, the average company only spends less than ten hours per year on their pricing strategy, which 

is not enough. Instead, companies turn to strategies like guessing, relying on discounts, and not pricing 

based on value. 

1) Guessing→ Many companies simply guess what an optimal price point would be instead of using 

analytics and metrics that their customers have given them. With the right positioning and promotion, 

even guessing at the prices will work to some extent—it is easy to take that as a sign that the pricing is 

“good enough.” 

2) Misunderstanding Tiers→ Many companies don’t know how many different pricing tiers or levels they 

should incorporate into their pricing structure. It’s a common misconception that more tiers equals more 

conversions. Data shows that too many or too few options push away potential customers, with a clear 

decrease in conversion rates as the number of tiers gets higher. 

3) Relying Heavily on Discounts→ The problem with discounting is that many companies wield 

discounting like a sledgehammer instead of a scalpel. Yes, it juices the acquisition metrics in the short 

term, but over time discounting can reduce the SaaS lifetime value by over 30%. Discounted customers 

have just over doubled the churn rate of those who pay full price—they’ve either been trained to devalue 

the product, or they just were not the right customers in the first place. 

4) Not Pricing for Value→ Value-based pricing is the best price optimization model since it includes both 

marketer and the customer’s optimal prices. The goal with value-based pricing is to figure out how much 

each customer is willing to pay for the product, so one can maximize revenue by charging each customer 

exactly what they are willing to pay. Figuring out what that price should be, though, is not easy. 

5) Target→ That is why so many companies lose out on revenue by setting their prices based on those of 

their competitors or on their costs—they don’t want to put in the effort. 

 

INCORPORATING COMPLEMENTARY PRODUCTS 
A complement refers to a complementary product or service used in conjunction with another product or 

service. Usually, the complementary product has little to no value when consumed alone, but when 

combined with another product or service, it adds to the overall value of the offering. 

A product can be considered a compliment when it shares a beneficial relationship with another product 

offering, for example, bread & butter. 

The joint demand nature of complementary products causes interplay between the consumer need for the 

second product as the price of the first product fluctuates. In economics, this connection is called negative 

cross-elasticity of demand. So, as the cost of a product increase, the user’s demand for the complement 

product decreases. Further, as consumer demand weakens, the market price of the complementary product or 

service may fall. For example, when the price of a product rise, the demand for its complement falls because 

consumers are unlikely to use the complement product alone. 

Additionally, complementary pairs are not two-sided and often have one-sided effects. Using another 

example, if the price of car tires decreases, it will not necessarily increase the demand for cars. However, if 

the price of automobiles decreases, it will increase the demand for car tires as more are sold. 
 

COMPLEMENTS AND ELASTICITY 

There are weak complementary products and strong complementary products. Weak complements have a 

low cross-elasticity of demand. For example, if the price of coffee increases it will only have a marginal 

impact on reducing the consumption of cream. In the case of Apple increasing the price for iPhones, this 

would reduce sales of iPhones and the demand for iOS apps. 

Complementary products differ from substitute products, which are different products or services that satisfy 

the same consumer need. The Apple iPhone is a substitute for Samsung phones. These two products can, 

therefore, replace each. So, rather than complement each other they become substitute products. For this 

reason, if the price of the iPhone increases, the consumer demand for a substitute will also increase.  

 A complementary product is one used in conjunction with another product or service. 

 Such a product may have little value without its complement. 

 When the price of a particular product rises the demand for its complement drops because consumers are 

unlikely to use the complement alone. 
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PRICING USING SUBJECTIVELY TO ESTIMATE DEMAND CURVES 
Sometimes one may not be able to accurately calculate price elasticity of demand for a product. In other 

situations, one may believe the linear or power demand curve is not relevant. In these situations, one way to 

determine a product’s demand curve is to identify the lowest price and the highest price that seem 

reasonable (perhaps using like products). One can then try to estimate the product’s demand with the high 

price, the low price, and a price midway between the high and low prices. 

 

Suppose due to changes in income, population and other factors, the theoretical demand curve shifts from D1 

to D2, D2 to D3 to D4 in above figure. The corresponding supply curve at each of these points occupies 

positions S1 to S4. The price-quantity observation which is recorded in period 1 (say, 1981) is given by the 

intersection of D1 to S1, namely, A. The next one is determined by the intersection of D2 and S2 at B (in 

1982). 

Thus we get a series of observations A to D for four years, viz., 1981, 1982, 1983 and 1984. These together 

trace out a demand curve dd. But this is not the same demand curve discussed in theory. More specifically, it 

is not reversible. It is improbable (unlikely) that we can move back from C to B and B to A. 
 

It is unlikely that the precise combination of conditions which prevailed at these points will be repeated. In 

practice, the demand and supply curves may not move consistently in the same direction, as is assumed in 

this diagram. They may move up or down rather erratically. 
 

In above figure, points A, B and C are not three points on a single demand curve for, say, product X. Each 

point is on a different demand curve — one that is shifting over a period of time. So just by connecting them 

we cannot trace out the product demand curve. 

A firm may interpret the line dd (which is a locus of points A, B, C and D) as the demand curve by mistake. 

Thus it might assume that a reduction in price from P1 to P2 increases sales from Q1 to Q2. An expansion of 

demand may well justify the price reduction. 
 

But, in practice, such a price cut will result in a much smaller increase in demand. The true demand curve 

(D1) is much less elastic than the line dd. Thus, a price cut is much less desirable than it appeared at the first 

sight. 
 

SIMULTANEOUS RELATIONSHIP 

So there is interrelationship between demand and supply curves. Now, data on prices and quantities 

purchased can be used to estimate a demand curve only under two sets of conditions: 

1) The demand curve has not shifted, but the supply curve has shifted; or 

2) We have almost complete information to determine just how each curve has shifted during the 

observation period (which covers four years in this case). 
 

Suppose there is a technological change in the production of X. So costs in the industry will fall sharply 

within a short period but demand conditions are likely to be stable. The situation is illustrated in below 

figure. Here the demand curve, which initially was unknown, in now assumed to be stable. The supply curve 

shifts from S1 to S2, S2 to S3 and S3 to S4. 
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It is clear that each price/quantity point represents the intersection of the supply and demand curves. Since 

all the demand determinants except price are assumed to be stable, points A, B, C and D must be on the 

same demand curve. So the demand curve DD can be estimated by connecting the four points. 
 

PRICING MULTIPLE PRODUCTS 

Generally, organisations produce more than one product in their line of production. Even a single product of 

an organisation can differ in styles and sizes. For example, a refrigerator manufacturing organisation 

produces refrigerators in different colours, sizes, and features. Similarly, an automobile organisation 

manufactures vehicles in different colours, sizes, and mileage. The pricing in case of multiple products is 

called multiple product pricing or Portfolio Pricing or Category Pricing. 

The demand curve for multiple products would be different. However, the MC curve of these products is 

same as these are produced under interchangeable production facilities. Therefore, AR and MR curves are 

different for each product. On the other hand, AC and MC are inseparable. Therefore, the condition of 

MR=MC cannot be applied directly to fix the prices of each product. 

The solution of this problem was provided by E.W. Clemens who stated how the multi-product 

organisations fix prices of their products. Suppose there are four differentiated products. A, B, C, and D 

produced by an organization. The below figure shows the pricing of multiple products: 

 
As shown in above figure, the AR (price) and MR curves for four products are shown as four different 

curves and MC curve is shown as the total of MC of all the products. Suppose the aggregate MR curve, 

which is the total of all individual MR curves, passes through point E on the MC curve. 

From point E, a parallel line, equal marginal revenue (EMR) is drawn towards Y- axis (parallel to X-axis). 

This parallel line passes through the MRs of A, B, C, and D. The output and prices of these four products are 

determined at the points where their respective MC and MR curves intersect each other. 

As shown in above figure, OQa, QaQb, QbQc, QcQd are the output levels of products A, B, C, and D and 

PaQa, PbQb, PcQc, PdQd are the prices of the products respectively. These are the maximum price and 

output levels of an organization. 
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PRICE BUNDLING 
Bundling is when companies package several of their products or services together as a single combined 

unit, often for a lower price than they would charge customers to buy each item separately. This marketing 

strategy facilitates the convenient purchase of several products and/or services from one company. The 

products and services are usually related, but they can also consist of dissimilar items which appeal to one 

group of customers. 

According to Guiltinan, price bundling can be defined as “the practice of marketing two or more products 

and/or services in a single ‘package’ for a single price”. 

The overall aim of a bundling strategy is to promote multi-item purchase in consumer groups that would 

normally purchase one good or the other but not both. 
 

For example, mobile phone retailers frequently bundle the prices of several products and services together 

for their new customers. They offer the phone itself with a package that also includes the 2-year phone plan, 

internet access, and phone charger. This bundle benefits the customer because it provides them with all the 

tools they need for their phone all at once and it benefits the mobile phone retailer because they are selling 

the customer supplementary products and services other than just a phone. 

The main appeal to sell things in a bundle is that you can introduce new or complementary products 

packaged with a consistent high seller. Many businesses do this to try to promote new products and get 

customers intesrested enough to buy more. 

Bundle pricing is built on the idea of consumer surplus. Every customer has a price that he is willing to pay 

for a particular good or service. If the price set by the marketer is equal to or lower than what the customer is 

willing to pay, the customer will buy, as he considers the price a bargain. The difference between what the 

customer pays and what the customer was willing to pay is known in economics as the consumer surplus. 

Bundle pricing is an attempt to capture more of the customers’ consumer surplus. 
 

FORMS OF PRICE BUNDLING 

There are two forms of price bundling — pure bundling, where the seller does not offer buyers the option of 

buying the items separately, and mixed bundling, where the seller offers the items separately at higher 

individual prices. Mixed bundling is usually preferable to pure bundling, because there are fewer legal 

regulations forbidding it, and because the reference price effect makes it appear even more attractive to 

buyers. 
 

PURE BUNDLING 

Pure Bundling is the practice of offering two or more goods in bundled form only. This type of bundling 

occurs when the products in the package can only be sold together. If they’re sold separately then they cease 

to function or the usefulness is greatly reduced. 

Pure bundling is when products are only sold together. In some cases, products do not exist outside the 

bundle. In other words, pure price bundling is a pricing strategy in which a firm bundles two or more 

products/services for one fixed price, without integrating the products or offering them separately. For 

example, restaurants that offers a fixed price menu (thali). 
 

Sub-Categories of Pure Bundling 

Pure bundling has three subcategories: joint bundling, leader bundling, and mixed-leader bundling. 

1) Joint Bundling→ Joint bundling is when the two products are offered together for one bundled price. 

2) Leader Bundling→ Leader bundling is when a leader product is offered for a discount if purchased with 

a non-leader product, accessory, etc. 

3) Mixed-Leader Bundling→ Mixed-leader bundling is a type of leader bundling with the added 

possibility of buying the leader product on its own. 
 

Advantages of Price Bundling 

Bundle pricing has many advantages. 

1) Helps in Selling of Less Popular Products→ The most important one is it that it allows companies to 

sell their lesser known or unpopular products with the popular ones. 

2) Attracting Different Kinds of Buyers→ It will also help attract different kinds of buyers like, buyers 

looking for deals, buyers looking for convenience or buyers looking for advice on items that complement 

each other. 
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3) Attract Customers by Offers→ Some consumers will be spending more than they initially wanted 

when they see an offer they like (if marketer offer the product that they already wanted to buy with 

something they wanted to try but never got to it). 

4) Promoting Two or More Products at a Time→ Product bundles have lower marketing cost because 

marketers are promoting two or more products with an effort and resources for one. 
 

Disadvantages of Price Bundling 

No matter how great a strategy is there is always a downside to it. The various disadvantages of price 

bundling are as follows: 

1) Cannibalisation of Product→ The biggest disadvantage for this one is that it can lead to 

cannibalisation of products that can be bought outside of the bundle. For example, one is selling a laptop 

and a printer together, but also separately. Because of this more printers could be sold through the 

bundle than on its own. This does cause lower profit for that particular product. 

2) Customers Feel Forced to Buy More→ There is also a chance that some consumers won’t buy 

something if it cannot be bought separately because they feel forced to buy more. 

3) Less Revenue→ Another limitation of price bundling is that company has to give s*ome discounts for 

the bundled product or service leading to loss of revenue for the company. For example, if an electronic 

company can sell DVD and television separately comfortably then price bundling can be revenue losing 

proposition for the company. 
 

MIXED BUNDLING 

Mixed bundling is the most popular type of bundling. Mixed bundling, also called custom bundling, is when 

customers are offered to purchase a bundle or separate products on their own. Mixed bundling allows the 

consumer to either purchase the products separately or in bundled form. 

In this bundle pricing strategy, two products which tend to be sold separately are combined as a package 

with a reduced price. It works best when the product is something people buy more than one of. 

In other words, mixed price bundling is a pricing strategy in which a firm sells the separate products/services 

(unchanged) in a price bundle and also sells them separately at their regular prices. For example, 

Samsonite’s strategy of selling different sizes of suitcases separately as well as in a bundle. 

 

DETERMINE OPTIMAL PRICE BUNDLING 
The optimal bundle price is a single lump sum amount equal to the total area under the demand curve at that 

point. One can understand the optimal price bundling with the help of a given example. 
 

Consumer Surplus under Unbundling, Pure Bundling, and Mixed Bundling 

 Unbundling Pure Bundling Mixed Bundling 

Price ($) 
PF = 800 

PB = 1,000 PF  = 800, PH = 700, PB = 1,200 
PH = 400 

Consumer Surplus From: Flight Hotel Bundle Flight Hotel Bundle 

Consumer 1 200 N/A 250 N/A N/A 50 

Consumer 2 0 0 200 N/A N/A 0 

Consumer 3 N/A 300 0 N/A 0 N/A 

1) Consumer Surplus ($) = Reservation Price – Price 

2) PF, PH, and PB represent the prices of flight, hotel, and the flight + hotel bundle respectively. 

3) N/A represents a consumer does not purchase the product since its price exceeds her reservation price. In 

contrast, 0 (zero) means that a consumer actually purchases the product, but cannot enjoy any positive 

consumer surplus because the price she pays is equal to her reservation price. 
 

This simple example indicates that bundling has an ability to generate greater revenue than unbundling, and 

furthermore, mixed bundling may work better than pure bundling in increasing revenues. 
 

However, it should be noted that this example holds true only under a number of strict assumptions on 

consumer reservation prices, market competition, costs, the number of products, etc., hence it is rather 

difficult to apply this example to more general situations. Indeed, most bundling literature in economics and 

marketing considered a series of attempts to examine the relative optimality of the three bundling strategies 

(i.e., unbundling, pure bundling, and mixed bundling) under various assumptions and create more generally 

applicable principles. 
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We can now understand why online travel agents offer travel “packages” as well as individual travel 

products and under what conditions mixed bundling is more profitable than either pure bundling or 

unbundling. However, there remains a question regarding the pricing of a bundle. That is, what prices should 

be set for a bundle and for its component products under mixed bundling? 
 

Most of the previously reviewed studies explicitly or implicitly assume that mixed bundling accompanies 

discounts. Indeed, as Adams and Yellen acknowledge, the additivity assumption (i.e., independence in 

demand), which is very common in traditional economics bundling literature, makes mixed bundling a 

distinct strategy only if the price for a bundle is lower than the sum of the prices for its component products; 

otherwise, nobody would buy the bundle. In addition, if bundling indeed brings about considerable cost 

savings and the market is competitive rather than monopolistic, firms will probably have strong motivation 

to offer discounts for bundled sales. 
 

Venkatesh and Mahajan develop a probabilistic model for determining optimal prices of a bundle and/or 

its component products under unbundling, pure bundling, and mixed bundling strategies. They apply the 

model to pricing ten single music/dance performance tickets and the season ticket, which is in this case the 

bundle of the ten individual performances over a certain time period. 
 

The results are consistent with the traditional view that mixed bundling yields more profits than the others. 

The results also confirmed that mixed bundling generally occurs with considerable discounts on the bundle: 

the optimal prices were $14 for the single ticket and $55 for the season ticket. However, this model did not 

consider complementary relationships among the products. 
 

Venkatesh and Kamakura develop another pricing model that considers the degree of complementarity or 

substitutability among products. The model suggests that a bundle of complements be priced higher than a 

bundle of individually valued products under mixed bundling. 
 

NONLINEAR PRICING 

Nonlinear pricing is a broad term that covers any kind of price structure in which there is a nonlinear 

relationship between price and the quantity of goods. In other words, nonlinear pricing is the phrase used to 

describe pricing schemes in which the price is not strictly proportional to the amount purchased (hence 

nonlinear). An example is affine pricing. 
 

A nonlinear price schedule is a menu of different-sized bundles at different prices, from which the consumer 

makes his selection. In such schedules, the larger bundle generally sells for a higher total price but a lower 

per-unit price than a smaller bundle. 
 

Nonlinear pricing can be used as a broad term to offer discount schemes where different pricing bundles 

offer higher total revenue for the seller with a lower per unit price for the buyer. In layman terms, the seller 

benefits from customers buying more of his products while the customers benefit from getting the goods at a 

reduced price. 
 

As sellers usually benefit from selling more of a specific product -even at a reduced price, this is pretty 

much a win-win situation where both the seller and the buyer get something they want. 
 

PROFIT MAXIMISING STRATEGIES USING NONLINEAR PRICING STRATEGIES 

Non-linear pricing is prevalent in many markets, from phone and electricity tariffs to supermarkets items. 

There is an extensive literature that studies non-linear pricing as a tool for surplus extraction, often as a 

device for price discrimination in the context of heterogeneous buyers. However, the contrast with linear 

pricing is particularly stark when consumers are homogeneous: in this case, the optimal non-linear pricing 

policy involves a monopolist selling the socially optimal quantity and extracting the entire surplus. 
 

A nonlinear tariff is much like a product line: offered a menu of quantities and corresponding charges, each 

customer chooses a preferred quantity and pays the associated charge. Each customer’s decision is 

essentially to select how many incremental units to buy or, when use is continual, the average rate of usage. 
 

Agricultural, commercial, and industrial customers account for the majority of sales in the main industries 

that use nonlinear pricing. Most of these customers are systematic and careful to obtain the maximum net 

value from service; for example, it is increasingly common to employ specialized managers aided by 

computerized control systems for services such as communications, power, and transportation. 
 

Moreover, these customers usually have stable preferences determined by production technologies, facility 

configurations, and sales and distribution systems. Among residential customers, an important segment is 
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equally careful to obtain maximum advantage from the menu of options offered. Among utilities, the 

primary motive for pricing above marginal cost is to obtain sufficient revenue to cover periodic operating 

costs and to repay the cost of capital used to install capacity such as durable equipment. 
 

In oligopolistic industries where entry is limited by the magnitude of fixed costs in relation to profits, 

nonlinear pricing plays a similar role in maintaining profits sufficient to retain the maximum number of 

viable competing firms: this works to the ultimate advantage of customers even though it represents an 

exercise of monopoly power. 
 

Practical Uses for Nonlinear Pricing 

Nonlinear pricing has several roles in practice. In some cases nonlinear pricing promotes more efficient 

utilization of resources. In others it is used to meet utilities’ revenue requirements. And, it can also be used 

by firms with monopoly power to increase their profits. 
 

Nonlinear pricing is often necessary for efficiency. This is the case when the firm’s cost per unit of filling or 

shipping an order varies with the size of the order. Similarly, if the firm has higher inventory costs than 

customers do then inducing customers to make periodic large purchases promotes efficiency. In the case of 

electric utilities, purchasers of large quantities of power typically have higher load factors, so quantity 

discounts recognize lower costs of idle capacity for these customers. Quantity discounts of this sort are 

motivated by cost considerations. 

1) Nonlinear pricing can be used by a regulated monopoly to recover administrative and capital costs. In 

important contexts, using its monopoly power to obtain operating profits sufficient to meet its revenue 

requirement is the most efficient means available to a utility or other public enterprise. 

Efficiency in these contexts refers to avoiding allocative distortions caused by deviations from prices set 

equal to marginal costs. In particular, if the regulatory objective is to maximize an aggregate of 

customers’ net benefits from the firm’s operations, then a nonlinear tariff minimises allocative 

distortions. 
 

2) Nonlinear pricing is often a useful strategy in competitive markets. For example, newspapers and 

magazines offer quantity discounts to attract large advertisers who have substitutes available in other 

media such as television. 

Telephone companies offer quantity discounts for long-distance calls to retain large customers who 

otherwise might elect to bypass local exchanges. Frequent-flier plans offered by airlines were initially 

competitive tactics designed to appeal to business travellers. Quantity discounts of this sort are 

motivated primarily by competitive pressures in submarkets segmented by customers’ volume of 

purchases. 
 

3) Nonlinear pricing can also be used as a means of price discrimination that enables a firm with monopoly 

power to increase its profits. In this case, it is used mainly as a means of market segmentation in which 

customers are classified into volume bands. The extent to which it increases profits depends on the 

degree to which higher-volume customers have higher demand elasticities for incremental units. 
 

An example is a product line of machines, such as copiers or printers that appeal to different volume 

bands because more expensive machines have higher rates of. output and lower marginal costs. 

Nonlinear pricing of this sort is motivated primarily by market segmentation, but the prices are 

determined less by competitive pressures to survive than by profit opportunities that arise from differing 

elasticities of demand in various submarkets. 
 

ADVANTAGES OF NONLINEAR PRICING 

The advantages of using nonlinear pricing are as follows: 

1) Profit to Heterogeneous Customers→ This role emerges if consumers have heterogeneous tastes for a 

firm’s products. In this case, a nonlinear tariff can be used to sort different types of consumers 

endogenously (so-called second-degree price discrimination). 

If some consumers gain higher utility from the product than others, then if the firm offers a tariff where 

the marginal price declines with volume, it will typically make higher profit than if it offers the same 

marginal price to all consumers. 

2) Efficient Way for Regulated Monopoly to Recover Costs→ It follows an efficient way for regulated 

monopoly to recover costs benefits large customers via quantity discounts. 
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3) Selling More of Products→ As marketers already know, getting more for less is something that people 

can hardly resist. When one uses a nonlinear pricing strategy, people are tempted to buy more of the 

products to make the most out offers. If the business benefits from selling more items, this is an 

advantage that makes this strategy worth considering. 

4) Generate Consumer Surplus with Homogenous Customers→ Nonlinear pricing provide a more 

efficient means by which to generate consumer surplus. With linear pricing, the only way to make profit 

is to set prices above costs, which entails deadweight losses. 

With a two-part tariff, however, a firm can extract profit using the fixed charge, while leaving marginal 

prices close to marginal costs (which then maximizes the size of the “pie” to be shared between 

consumer and firm). This role for nonlinear pricing exists even if all consumers are similar. 
 

DISADVANTAGES OF NONLINEAR PRICING 

The disadvantages of using nonlinear pricing are as follows: 

1) Making Products Look Cheap→ One major downside of using a nonlinear pricing strategy is that it 

makes your products look cheap. Imagine a company like Apple offering two iPhones with a 10% 

discount, or a fancy restaurant offering a discount on target portions. 

2) Uniform/Non-discriminatory→ Fixed charge in nonlinear pricing may discourage some people from 

taking service at all. 

3) Loss of Efficiency→ Some consumers are driven out from the market if the fee exceeds their individual 

consumer surplus at hence efficiency loss, as these customers might have been willing to pay price/unit 

(without the fixed fee). 

 

PRICE SKIMMING 
Price skimming can be defined as a product pricing strategy where a consumer will pay the highest initial 

price demanded by a firm. Once the demand of the initial consumers is fulfilled, it reduces the price of the 

product to interest other customers who have a price sensitive approach while making purchase decisions. 

Thus, ‘skimming’ term is derived from skimming of the creamy layer of customer segments because later 

the prices are lowered for attracting other customers. 
 

Price skimming is one of the methods selected by firms who intend to launch new product in the market. 

Here, the launch price of the product is kept high, which is gradually decreased within a given time period to 

recoup the value of the product in a faster way. For example, mobile phones having new and improved 

attributes are launched at high prices, which are gradually decreased by the company after a certain period. 

One more example can be of newly launched 3D televisions available at high prices. 
 

Price skimming strategy is the method of selling a product or service at relatively high price. It is generally 

implemented during the introduction stage of a new product. During this stage, the demand for the new 

product is comparatively inelastic; hence, it becomes most convenient time to apply this strategy. This 

method is used to earn significant profits during the initial period of product launch, in order to recover the 

investment made in the manufacturing of product. However, by doing so, a company might lose its better 

chances of having high sales volume, by selling its product at comparatively low prices. In due course of 

time, the company exercising price skimming, should relax its product’s price as competitors may take 

advantage of this situation by offering their products at lower prices in market. Hence, price skimming 

strategy is appropriate only for a short term. 
 

The market is comparatively small when a firm gets involved in price skimming because only initial 

adopters are obliging to pay for such an expensive product. Therefore the sales volume at such high prices 

often falls as the rest of the potential customers are not ready to purchase the product at the price demanded 

by the seller. If the company wants to see itself in a stable position in near future then such strategy will 

make the company incompetent in the market. Hence, price skimming technique is best suited for companies 

which develop a constant series of new products and give emphasis on research and development. They do 

not aim to become the low-cost provider in the market. 
 

CONDITIONS OF PRICE SKIMMING 

Skimming policy is desirable in the following cases: 

1) If a limited supply exists, the company may follow a skimming approach to match demand and supply. 

2) Where the exporter wants to skim the cream before competitors enter the market. 

3) Where a company wants to maximize its revenue. 
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4) When initial cost of production is very high which has to be recovered as early as possible. 

5) Where the products are of specialty goods such as fashion-oriented goods. 

6) Where the segment of the market is willing to pay a premium price for the value received. 

7) Where the price and quality relationships are viewed favorably. High prices imply high quality for 

quality conscious customers. 
 

ADVANTAGES OF PRICE SKIMMING 

Following are the advantages of using the price skimming method: 

1) Establish the Brand→ Price skimming is advantageous in creating value for a product by establishing 

its brand image. In order to attract customers towards a new product, a strong brand, which is able to link 

up with the target market, is required to be established. Firms may use price skimming strategy to reach 

target market segment for developing a brand on the basis of status or quality. 

2) Perceived Quality→ The advantage of skimming priced products is that they are perceived as high 

quality products by the customers. Every customer desires to get the best quality of products or services 

when he/she is buying it for his/her business or family members. Price is one of the many criteria 

considered by mostly every customer, while purchasing various items including essentials like food 

grains or high end products like electronics items. 

3) Attract Status Conscious Consumers→ Another advantage associated with this method is that they 

help in attracting status conscious customers. Customers who are conscious of their social ranking or 

class usually go for purchasing highly priced products, since price corresponds to quality. Price 

skimming strategies are used by different firms to sell their products to target segment including luxury 

items, designer labels, etc. These status conscious customers help develop an instinct for recognition of 

the product or brand in the opinion of other consumers who may be inspired to buy such products when 

their prices fall. 

4) Early Adopters Brand Promoters→ In price skimming strategy, the early adopters of the products 

proves advantageous for they serve as brand promoters. They purchase the product when it is launched 

with no competition in the market, thus, help as brand campaigners for the company. Price skimming 

strategy does not deter them from purchasing the product. Early adopters playing the role of brand 

campaigners publicise about the new product through the most common medium of marketing, i.e., word 

of mouth. The stimulation created by these early adopters helps increase sales volume and promotes the 

products or services priced under price skimming. 

5) Recoup Costs of Goods Sold→ Price skimming is also advantageous because it helps in recovery of the 

costs involved in production of the products. Heavy investment is involved to develop new and 

innovative products such as procuring raw materials, supplies, plant and equipment, research expenses, 

salaries of employees, costs incurred for advertising and marketing the product, etc. A price skimming 

strategy is opted by companies who wish to recover the costs incurred by them during manufacturing of 

the product. 

6) Effectiveness Short Lifecycle Products→ Another advantage of price skimming strategy is that it can 

be readily applied to products like electronics and computer equipment which have a short lifecycle. It is 

most suitable for these types of products. For example, a new model of computer generally offers better 

features like enhanced graphics and calculation power than any previous model. Therefore, customers 

are generally ready to pay premium price for a latest and powerful model of computer which has all the 

latest features and applications. 

7) Subsidy→ In price skimming strategy, the early adopters help in providing products to the other 

potential customers segment at subsidised rates. For example, products such as television, stereos, 

computers, play station, etc., which were quite costly at the introduction stage, can be purchased by 

prospective customers at an affordable price later. 

8) Saves Money on Advertising→ Price skimming technique enables a firm to save the expenses related 

to advertising. The buyers who buy the product at a later stage are influenced by pricing factor and have 

different preferences in comparison with those who are the early buyers and who buy the product 

immediately as they can shell out more money for the same. The preferences of early adopters of 

products differ from that of customers who buy the products later. Different ads are developed for 

different target segments. This helps in preventing the unnecessary expenditure on advertising. 

9) Discount→ Slamming price strategy helps the seller to offer their products at discounted price at later 

stage, to attract more customers. Discount offer always prompts a buyer to buy the commodity because it 

seems to be an effective deal. The product is priced at a higher price using price slamming method 
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during the introduction phase. Later if the firm offers a discount of 50 per cent or more on the same 

product, the customers would be allured by the opinion that such an expensive product is being made 

available at a sale price. 
 

DISADVANTAGES OF PRICE SKIMMING 

The following are disadvantages of using the price skimming method: 

1) Competition: The biggest disadvantage of price skimming strategy is that there will be continuous entry 

of one or more competitors in the market offering low priced products, creating a challenge for the 

skimmed priced products. 

2) Sales Volume: Another disadvantage of price skimming strategy is that it lowers down the sales volume. 

The concept of decreasing the price of the product by increasing sales volume is not possible with firms 

adopting price skimming approach. 

3) Consumer Acceptance: High prices of product continued for longer time period is not accepted by the 

prospective customer segments. This is another big disadvantage of price skimming. 

4) Annoyed Customers: Company adopting the price skimming technique can experience bad publicity 

and very low level of brand loyalty from the early adopters of the product. This may happen when the 

firm reduces the price of the product at a later stage which displeases the early adopters, who had 

purchased the product at a very high price. 

5) Cost Inefficiency: The firms using skimming pricing are not able to maintain same profit margin (at the 

time of launch) when lowering their prices in later stages. This is so because they find it difficult to cut 

the cost of production. 

6) Difficult to Maintain Stock: Difficulty in maintaining the highly priced stock is another disadvantage of 

price skimming strategy. The distribution chain of the firm may find this approach difficult, and 

therefore, retailers can demand a higher profit margin to carry on with the distribution of such product. 

The manufacturer’s distribution chain is also affected due to the very low inventory turnover rate of 

these products. In order to maintain the commitment and willingness of the retailers towards the product, 

it becomes necessary for the firm to give high profit margins. 

7) Slow Rate of Stuff Diffusion and Adaptation: Lastly, slow rate of stuff diffusion and adaptation is 

also a disadvantage of price skimming. Hence, a substantial amount of demand remains untapped or 

unexploited. 

The time gap between diffusion and adaptation of product gives competitive edge to the competitors. 

Meanwhile, they either create a replica of the product or modify the existing product and launch it in 

market at comparatively low prices. In the process, the company may lose the opportunity which is now 

in the hands of their competitors. 
 

SALES 
In simple terms, selling is the act of persuading, i.e., convincing the buyers to make a purchase. In other 

words, “selling is a business deal in which goods and services are sold in exchange for money.” This is done 

by explaining the benefits of the products to the buyers. 
 

If a deal is to be made, then a certain sum of money has to be given by the buyer to the seller (this sum is 

already agreed upon by both), and the buyer gets the product is exchange. 
 

Exchange process has two branches, i.e., buying and selling. Selling plays a major role in the concept of 

marketing. It does not matter if the salesperson is able to strike a deal or not. There can be a bad salesperson 

and a good salesperson but the success of the seller does not act as the basis of selling. Selling is the process 

in which goods are sold to buyers for money. 
 

ROLE OF SELLING IN MARKETING 

One of the important components of marketing is selling. Marketing refers to the concept of development of 

products, carrying out promotions to communicate the benefits of those products to the potential customers 

and taking care of the continuous value exchange in the process. The process of selling holds significance 

for organisations which are fully customer-oriented. 

The role of selling in marketing is described below: 

1) Prospect Qualification→ Appropriate market segments are identified with the help of marketing 

research. In the same way, potential customers are identified by the salespersons through the use of 
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questionnaires and more direct methods. The most profitable potential customers can be screened by the 

salespersons by following a certain criteria. 

A criteria for preliminary screening customers can have the following segments: 

a) Requirement of the product by the prospect, 

b) Their ability to pay, 

c) Their authority to buy, and 

d) Willingness to purchase. 
 

2) Art of Persuasion→ Selling is the art of persuading customers. Unlike manipulation, sellers try to 

convince their customers to purchase a particular product, since it can benefit them in some way or 

other. This is possible through following a customer-centric approach whereby the salespersons attempt 

to generate trust with the potential customer, ask relevant questions, handle the buyer related issues and 

give proper suggestions. Persuasive selling mainly focuses on the satisfaction of the needs of the 

customers by highlighting the benefits of the products. 

3) Interactive Communication→ Communication is involved in most of the tools of promotion like, 

selling, advertising and public relations. Communication is a two way process in selling. Before getting 

into the act of convincing, an effective salesperson actively listens to the prospect’s needs and asks 

relevant questions. Unlike PR or advertising, this provides the sellers a greater advantage in dealing with 

the queries of the customers and generating more sales. 

4) Personal Relationships→ An integrated element of the salesperson’s role and the process of selling is 

developing personal relationships with clients. The traditional concept of selling focussed on generating 

immediate sales and high-pressure sales tactics. 

In this modern world of marketing, the main aim of the companies is to attract more potential customers 

so as to get them to make repeat purchase. As a result, it becomes the responsibility of the salespersons 

to understand the changing tastes and preferences of the customers and maintain constant follow-ups. 
 

SELLING AS A PART OF MARKETING 

Selling and marketing are two different concepts. Through marketing, a product is introduced in a market 

whereas, through selling, an attempt is made to convert a potential buyer into a customer and close a deal.  
 

Marketing based firms can be differentiated with the help of seven elements as’ given by Bower and Garda: 

1) For the marketing-based firms, the chief measure of marketing success is the market share and not the 

volume. However, profits will be inadequate if the cost of obtaining the market share is ignored. 

2) The principles of market segmentation are analysed and utilised by them. 

3) The needs of the customers, their usage and trends as well as the activities of the competitors are tracked 

and monitored by the marketing based firms. 

4) All the non-marketing activities are coordinated in a way to attain the goals of marketing. This is done 

with the help of a process or structure. 

5) There are a set of specific marketing objectives and goals of the marketing based firms. 

6) A particular corporate based culture and style is followed by the marketing based firms, where a major 

role is played by marketing, 

7) They attempt to provide unique value to the customers by adopting a market oriented business concept. 
 

Hence, it can be said that selling is an inward looking concept where the seller convinces the customers to 

purchase the product which has been produced by the manufacturer. The process of selling starts only after 

the product is manufactured and ready to use. 
 

On the other hand, marketing is an outward looking concept. Here, the firm identifies and analyses the needs 

of the customers and then introduces a product to meet those needs and requirements. 
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DIFFERENCE BETWEEN SELLING AND MARKETING 

Basis of Difference Selling Marketing 

1)  Emphasis In selling, emphasis is given to the product. 
In case of marketing, consumers’ needs 

and wants are emphasised. 

2)  Approach 

Traditionally, selling approach involves 

manufacturing and then sales of the 

product. 

In marketing approach, first the needs 

and wants of customers are identified 

and then the product is delivered. 

3)  Primary and    

      Secondary  

      Motive 

The primary and secondary motive of 

selling is sales and company’s satisfaction 

respectively. 

In marketing, the primary motive is to 

satisfy the customers and secondary 

motive is to meet the consumers’ 

expectations. 

4)  Orientation It is a sales-volume oriented process. It is a profit-oriented process. 

5)  Planning 
It is a short-term plan based on prevailing 

products and markets. 

It is a long-term plan phased on the 

tastes and preferences of the consumers. 

6)  Need Priority It focuses on the needs of sellers. 
It focuses on the needs and demands of 

consumers. 

7)   Philosophy 
Business is considered as a source of profit 

generation. 

Business is considered as a way to 

satisfy consumer needs. 

8)  Technology 
Selling process is based on existing 

technology with limited costs. 

Marketing process is based on superior 

technology to provide better value and 

innovative products to customers. 

9)  Work 

      Delegation 

Different departments perform individually, 

with distinct objectives. 

There is common goal to all departments 

and they work as a team. 

10) Price 

      Determination 
Price is determined by cost. 

Cost is determined by price and price is 

determined by consumers. 

11) Customers 
In selling, customers are considered as the 

last link. 

In marketing, customers are considered 

to be the prime link. 

 

REVENUE MANAGEMENT 
Revenue management is the application of disciplined analytics that predict consumer behaviour at the 

micro-market levels and optimize product availability, leveraging price elasticity to maximize revenue 

growth and thereby, profit. The primary aim of revenue management is selling the right product to the right 

customer at the right time for the right price and with the right pack. The essence of this discipline is in 

understanding customers’ perception of product value and accurately aligning product prices, placement and 

availability with each customer segment. 

Revenue management to this point had been utilized in the pricing of perishable products. In the 1990s, 

however, the Ford Motor Company began adopting revenue management to maximize profitability of its 
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vehicles by segmenting customers into micro-markets and creating a differentiated and targeted price 

structure. Pricing for vehicles and options packages had been set based upon annual volume estimates and 

profitability projections. The company found that certain products were overpriced and some were 

underpriced. Understanding the range of customer preferences across a product line and geographical 

market, Ford leadership created a Revenue management organization to measure the price-responsiveness of 

different customer segments for each incentive type and to develop an approach that would target the 

optimal incentive by product and region. By the end of the decade, Ford estimated that roughly $3 billion in 

additional profits came from revenue management initiatives. 
 

MARKDOWN PRICING 

A price markdown is a deliberate reduction in the selling price of retail merchandise. It is used to increase 

the velocity (rate of sale) of an article, typically for clearance at the end of a season, or to sell off obsolete 

merchandise at the end of its life. 

The timing and level of markdowns in a selling season is critical to maximising return on sales. This is often 

measured as revenue realization: the proportion of the potential original selling price achieved. For example, 

a revenue realization of 50% means that only half the potential full-price sales value was achieved by the 

end of the season. It is also important in minimizing terminal inventory, i.e. the amount of merchandise left 

when the season is finished. 

 

HANDLING UNCERTAINTY 

Relationships will matter no matter what happens 
Communicate with your customers and make sure you understand how the pandemic is impacting them 

personally, their business and their customers. No one understands all of the implications of the pandemic, 

and the only way to find out is to ask and to listen. 

You’re listening for changes in value drivers, the value that you’re providing your customers and the value 

that your customers are providing to their customers. Emotional, Economic and Community value drivers all 

matter, but for the short term it is emotional and community value drivers that will come to the fore. 

 

Don’t offer discounts 
There’s going to be pressure to offer discounts. Resist this pressure. Instead of offering discounts, look at 

making concessions on terms of trade. Defer payment terms if you can. Allow customers to carry volume 

commitments forward. 

If there’s a serious drop in use due to the pandemic, consider extending the subscription for a period of 

months. If you fail to acknowledge the current economic conditions, as reflected in the use of your service 

and the value it delivers, you may contribute to higher churn. In uncertain times, you want to be doing what 

you can to reduce churn. 

 

You’ve started worrying about money. So have your customers. 

If you define value drivers based on how you impact unit economics (Customer Acquisition Costs, Lifetime 

Value of a Customer and so on), take a close look at everything you can do to help your customers reduce or 

manage their own churn. 
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UNIT-3: SALES FORECASTING (8 HRS) 

 
Introduction, Simple Linear Regression & Multiple Regression model to forecast sales, Forecasting in 

Presence of Special Events, Modeling trend and seasonality; Ratio to moving average forecasting method, 

Using S curves to Forecast Sales of a New Product. 
 

SALES FORECASTING 
In general terms, ‘forecast’ refers to the process of prediction of some future outcome. Such definition may 

be technically appropriate, but in managerial perspective, the definition is very general. 

According to Stults, “A sales forecast is an estimate of the amount or unit sales for a specified future period 

under proposed marketing plan or program”. 

Sales forecasting can be used as a tool for evaluating company’s performance. It allows the business owners 

to gauge how effectively a company is being managed. The sales forecast measures, graphs, and analyses 

the various parameters of the business. Sales forecasting not only ensures the survival of the organisation in 

the competitive environment but also transforms it into a high profit making body. It is also an important 

element of company’s budget. The prospective success and direction of a business is greatly influenced by 

the effectiveness of company’s sales forecasts. 

According to American Marketing Association, “Forecasting is an estimate of sales in dollars or physical 

units for a specified future period under a proposed marketing plan or program and under an assumed set of 

economic and other forces outside the unit for which the forecast is made. The forecast may be for a 

specified item of merchandise or for an entire line”. 
 

OBJECTIVES OF SALES FORECASTING 

Sales forecasting is undertaken with the following objectives: 

1) Short-Term Objectives→ The objectives formulated for a short period of time, generally for more than 

90 days and less than a year are known as short-term objectives. As compared to long-term sales 

forecasting, short-term sales forecasting is more accurate and useful for an organisation: Sales 

forecasting may be undertaken for the daily and routine functioning of the organisation. The various 

short-term objectives for which sales forecasting is done are as follows: 

a) To formulate appropriate production policy for meeting the demand forecasted by the organisation. 

b) To ensure continuous availability of raw materials for supporting the production process as per the 

sales forecast. 

c) To optimise the use of machinery. 

d) To determine appropriate pricing policy for specified time period. 

e) To make a robust estimate of the working capital required by the business and also make provisions 

for the same. 

f) To fix the sales quotas and targets for different segments in which the company operates. 

g) To make an estimate of the inventory requirements for the finished, unfinished, and semi-finished 

products for a given time period. 
 

2) Long-Term Objectives→ Long-term objectives are generally meant for time period extending beyond 

one year. Here, sales forecasting is undertaken with an objective of formulating plans and policies 

regarding production and distribution functions. Prospective growth of the organisation is one of the 

most important considerations in long-term sales forecasting. Long-term forecasting is done with the 

following objectives: 

a) To get an estimate of the cash inflow from the sales operations of the business. 

b) To make provisions for the capital expenditure of the organisation. 

c) To plan and estimate the plant/production capacity of the organisation for meeting the increasing 

future demands. 

d) To plan for adequate manpower required for production and distribution activities. 

e) To make arrangements for procuring the necessary raw materials as per future demand of the 

organisation. 

f) To plan for the dividend policy of the organisation. 

g) To minimise the selling cost so that the total cost of the product can be kept at minimum. 

h) To initiate budgetary and planning activity. 
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i) To forecast the future profits that the organisation is likely to earn. 
 

 

 

CRITERIA FOR EFFECTIVE FORECASTING 

The criteria for effective sales forecasting is as follows: 

1) Accuracy→ Forecasting is effective in use only if it is reasonably accurate. Inaccurate sales forecasting 

may result in higher stocks of inventory, increased customer order lead-times and longer delivery 

periods. This will result in companies losing revenues and customers being dissatisfied. Therefore, it is 

very important for firms to forecast their sales accurately. Accuracy in forecasting can be obtained by 

integrating past sales data through the use of statistical models, coupled with moves to gain extensive 

knowledge about customers and their preferences. 

2) Plausibility→ Forecasting and especially sales forecasting has to be done with determination and 

sincerity, and there should be no manipulation of figures under influence or pressure. First of all, 

forecasting has to be reliable and the people of the organisation should be able to believe it. A forecaster 

may manipulate figures to avoid displeasing his higher-ups. He may suppress negative sales forecasts 

and project acceptable figures to the top management. 

3) Durability→ The durability of the forecasts can be improved by following certain principles, such as 

combining the techniques utilised for forecasting, by simulating a series of inputs and by using 

quantitative forecasting approaches rather than relying largely on intuition. By combining forecasting 

techniques rather than applying a single technique, a company can ensure that the sales forecast is more 

durable. 

4) Flexibility→ The forecasting technique will be more effective if it is flexibly applied by the 

management. In today’s volatile business environment, there are sudden changes in both the micro- and 

macro-level environment of a firm. In such a situation, a rigid sales forecast which cannot be changed 

according to changes in the market, will be of little use to the management. Therefore, flexibility in 

forecasting is essential. 

5) Availability of Statistical Indexes→ Quantitative forecasting methods are more appropriate for the firm 

than qualitative methods that are based on intuition. For sales forecasting to be developed using 

quantitative methods, availability of required statistical indexes and related data is highly essential.  
 

USES OF SALES FORECASTING 

The various uses of sales forecasting are: 

1) Sales Planning→ A sales manager is also planning for the future sales of his territory when he makes 

his sales forecasts. All activities in the territory are based on the level of sales done. Depending on the 

level of sales forecast done, the sales manager has to plan the number of customers that he needs to 

acquire. 

2) Demand Forecasting→ The sales forecast also gives a very good idea of the kind of demand that exists 

for the product. The sales team are best placed to give an estimate of the customer demand as they are 

closest to the customers. 

3) Inventory Control→ The sales forecasting helps in proper controlling of the business inventories, raw 

materials, intermediate goods, semi-finished products, finished products, spare parts, etc., by evaluating 

the future requirements. 

4) Supply Chain Management→ Effective sales forecasting also allows the company to plan and manage 

its supply chain in a better way. There is greater cohesiveness in the supply chain and there are fewer 

shocks to the system. This also allows the company to manage its resources more effectively and there 

are greater instances of just in time management practices. 

5) Financial Planning→ It also improves the financial performance of the organisation through lesser 

costs and greater profit. 

6) Price Stability→ As sales forecasting leads to better inventory management, it also results in lesser 

instances of panic sales to clear excess inventory. 

7) Marketing→ Sales forecasting also facilitates marketing to plan for the future. It helps to plan 

advertising and promotion activity in periods where the sales of the product look weak. Sales forecasting 

may also lead the organisation to identify slow moving products which can be removed from the product 

stable. 
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METHODS OF SALES FORECASTING 

A sales forecasting method basically involves trying to estimate the sales of a product if a particular course 

of marketing is followed. The methods of sales forecasting cannot produce accurate results as each one of 

them are having one or the other type of error. Broadly sales forecasting methods can be quantitative or 

qualitative in nature: 

1) Qualitative Methods of Forecasting→ Qualitative methods of forecasting rely on the judgements of 

experts or the collective opinions of stakeholders or the customer. These methods can be categorised as 

follows: 

a) Executive Opinion→ The experts of various departments of the company form a panel which is 

responsible for doing the sales forecast. The panel uses the data from all the departments for framing 

the plan and also appoints a staff analyst for analysing the data. The forecasts presented by expert do 

not show the extremes which could happen if they had been made by the individuals. Such type of 

forecasting is done in two ways: 

i)  By a single experienced individual (typically done in a small company) 

ii) It can also be done by a group of individuals or jury members who have got expertise in one or 

the other field. 
 

b) Delphi Method→ It comprises of certain rounds of the structural surveys and those who participate 

in the survey are the experts of their own field. This survey is conducted in different rounds and the 

results of the initial rounds are given as feedback in the later round for the purpose of follow-ups. It 

can be observed that the expert’s responses in the second round are influenced by the opinion of the 

others. It is basically a group communication system which is structured for survey so that the 

incomplete information or knowledge is utilised to derive the most appropriate outcomes. This 

process generally stops when adequate answers or consensus is obtained for any significant 

deviations. The co-ordinator then carries on statistical analysis of the responses using various 

parameters like obtaining common answers, analysing variations, etc. 

c) Sales Force Composite Method→ It is also termed as Collective Opinion Method. Under this, 

rather than approaching the consumers for their opinions, the verdicts of those affecting the sales are 

given the priority, i.e., the shopkeepers and the salesmen. The salespersons who are engaged with the 

company are to make spate projections of their sales to the respective regions. These individual 

forecasts are put forth for further study and final data for the organisation as a whole is prepared. 

d) Survey of Buyer’s Expectations→ In this type of forecasting method, the intention and motivations 

of the buyers are estimated to develop a forecast for the product. This requires selecting a small 

sample of the prospective buyers of the product and seeking information regarding their future 

buying intentions. The information hence obtained is further generalised for estimating the overall 

future demand. However, the intention to purchase does not often get translated into a purchase for 

the product. Also, the responses can also get clouded because of the biasedness of the targeted 

buyers. Most of the organisations employ survey methods to gauge the intentions of both actual and 

potential buyers of the product. Such customers may range between individual households to various 

intermediaries. Organisations also constitute panels which provide data on the quality, features, and 

price of the product. In most cases however, buyers have problem in providing a feedback regarding 

their future buying behaviour. 

e) Historical Analogy Method→ The forecast for the sale of new business depends upon the analogy 

of past sales of the existing product. The new product can be a substitute of existing product, 

complementary products or product related to consumer belonging to same income groups as being 

targeted by the existing product. For example, the expensive sunglasses manufacturing company 

should study the customer’s demand pattern of expensive watches for launching a new watch in the 

market. 
 

2) Quantitative Methods of Forecasting→ Quantitative methods have lot of relevance in sales 

forecasting. The main quantitative methods which are employed in sales forecasting are as follows: 

a) Trend Projection Method→ The data from the past can be used as a stepping stone for the future 

demand projections. A trend can be established on the basis of the past figures. Such trend can be 

graphically or equationally established. The equation method is accurate. 

b) Exponential Smoothening→ Exponential smoothing is a very common method and is also useful in 

operation management. The basic reasons for acceptance are as follows: 

i)  They are immediately available in standard computer software packages. 
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ii) They basically need less data storage and calculations. 

Under this method, the past data of demand is used considering the weights. The weights used are 

however exponential in nature. Higher weights are allotted to the most recent period and it goes on 

decreasing exponentially as we go down. It can also be said that the weights used are not linear, 

rather they are exponential and their magnitude decreases for later years. 

c) Naive/Ratio Method→ Naive method is the most economical and effective forecast method. In the 

stable time series data, this method states that the forecast for any period equals the actual figures for 

the preceding period. 

d) Econometric Method→ The econometric model forecasting involves estimating several 

simultaneous equations, which are generally behavioural equations, mathematical identities and 

market-clearing equations. The econometric model technique is also known as simultaneous 

equations method and complete system approach to forecasting. This technique uses sophisticated, 

mathematical, and statistical tools. 

 

REGRESSION MODEL TO FORECAST SALES 
Regression analysis is a statistical tool used to calculate a continuous dependent variable from various 

independent variables and is commonly used for prediction and forecasting. For example, if agriculturist 

knows that the yield of rice and rainfall are closely related then he will want to know the amount of rain 

required to achieve a certain production. In this situation, he will use the regression analysis.  

Like time series analysis, regression analysis requires the use of historical sales data. In regression analysis, 

the forecaster seeks to find a relationship between past sales (the dependent variable) and one or more 

independent variables, such as population, per capita income, or gross domestic product. Simple regression 

analysis uses one independent variable, whereas multiple regression analysis includes two or more 

independent variables. The objective of regression analysis is to develop a mathematical formula that 

accurately describes a relationship between the firm’s sales and one or more variables. However, the 

formula indicates only an association, not a causal relationship. Once an accurate formula is established, the 

analyst plugs the necessary information into the formula to derive the sales forecast. 

Regression analysis is useful when a precise association can be established. However, a forecaster seldom 

finds a perfect correlation. Furthermore, this method can be used only when available historical sales data 

are extensive. Thus, regression analysis is not useful for forecasting sales of new products. 

This technique is used for modelling and analysis of mathematical data using the value of a dependent 

variable and one or more independent variables. Dependent variable, also known as response variable, is 

the single variable predicted by the regression model. Independent variable, also known as predictor 

variable, is used to predict the values of dependent variable. 

Regression analysis is the process to calculate the unknown value of one variable from the known values of 

the other variable. 

According to Blair, “Regression is the measure of the average relationship between two or more variable in 

terms of the original units of the data.” 

According to Taro Yamane, “One of the most frequently used techniques in economics and business 

research, to find a relation between two or more variables that are related causally, is regression analysis.” 

Regression may be classified as follows: 

1) Simple Regression 

2) Multiple Regression 

3) Linear Regression 

4) Non-Linear Regression 
 

APPLICATION OF REGRESSION ANALYSIS 

Following are the basic uses of regression analysis: 

1) Used to know the relationship between different (one or more) variables. 

2) Used to find out the value of dependent variable from the value of independent variables. 

3) Used to find out the coefficients of correlation (r) and coefficients of determination. 

4) In corporate sector it is useful to check the quality. 

5) Also very useful to determine the statistical curve (demand, supply, etc.). 
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REGRESSION LINES 

The lines of the best fit between two variables and stating the common average relationship are known as 

regression lines. There are two regression lines for two variables. 

When we take two variables X as dependent variable and Y as independent variable, then the straight line is 

called as the regression line of X and Y and vice versa is also true. 

The regression line of Y on X gives the finest possible values of Y for the given values of X. So this line is 

the sum of squares of deviations of the ‘calculated values of Y’ and ‘observed values of Y is minimum’; i.e.,  

∑(Yc - Y0)
2 = minimum 

Where, Yc = Calculated value of Y 

Y0 = Observed value of Y 

Now, for the regression line of X on Y: 

∑(Xc – X0)
2 = minimum 

Where, Xc = Calculated value of X 

X0 = Observed value of X 

This is why, to understand the concept of regression line, two regression lines are required. If there is only 

one regression line existing between two variables then it means r = ± 1. 

Now If the value of r is 0, then both the variance are independent and lines will cut each other at a right 

angle (i.e., lines will be parallel (II) to x-axis and y-axis). 
 

REGRESSION EQUATIONS 

Regression equation is used to show the regression line and there are two regression equations because there 

are two regression lines. So if there are two variables, say X and Y, then the two regression equations are 

written as: 

1) Regression Equation of X on Y→ The regression equation of ‘X on Y’ is written as follows: 

X = a + bY 

To calculate the values of a and b, following normal equations are solved simultaneously: 

∑X = Na + b∑Y 

∑XY = a∑Y + b∑Y2 
 

2) Regression Equation of Y on X→ The regression equation of ‘Y on X’ is written as follows: 

Y = a + bX 

To get the value of a and b, following normal equations are to be solved simultaneously: 

∑Y = Na + b∑X 

∑XY = a∑X + b∑X2 

In the normal equation ∑X, ∑XY, ∑X2 and ∑Y2 gives the summations and can be determined from the 

observed pairs of values of two variables ‘X and Y’. N is the number of observed pairs of values. 

 

REGRESSION COEFFICIENT 

If ‘b’ is the slope of regression line of ‘Y on X’, then bYX is known as coefficient of regression of ‘Y on X’.  

              σy
 

So, bYX = Regression Coefficient of Y on X = r ––––– 

              σx 

Similarly, for the regression line of ‘X on Y’, 

              σx
 

So, bXY = Regression Coefficient of X on Y = r ––––– 

              σy 
 

PROPERTIES OF REGRESSION COEFFICIENTS 

1) Coefficient of correlation is calculated by determining the geometric mean of the two regression 

coefficients i.e., 

 
Where r = Coefficient of correlation and its value is positive when both the regression coefficients are 

positive. 

Because r lies between +1 to –1, so the value of regression coefficient is not more than one. 

2) It is independent from origin but not from scale. 
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3) If one regression coefficient is greater than unity, then remaining must be smaller than unity. 

4) Both the regression coefficients have the same sign (i.e., if one is positive then the other is also positive 

and if one is negative then the other is also negative). 

5) The value of coefficient of correlation is less than the mean value of regression coefficients. 
 

 

DETERMINATION OF LINEAR REGRESSION EQUATION 
To determine the parameters of a fitted regression equation following methods are used: 

a) Method of Least Squares 

b) Regression Equations when Deviation taken from Actual Mean 

c) Regression Equations when Deviation taken from the Assumed Mean 
 

METHOD OF LEAST SQUARES METHOD 

1) Let X = a + bY be the line of X on Y. To determine the values of a and b, the following two normal 

equations are to be solved simultaneously: 

∑X = Na + b∑Y 

∑XY = a∑Y + b∑Y2 
 

Example 1: Consider the following data obtain the two regression equations 

X 5 3 10 8 9 

Y 8 12 6 5 14 
 

Solution:   Calculation of Regression Equations 

X Y X2 Y2 XY 

5 8 25 64 40 

3 12 9 144 36 

10 6 100 36 60 

8 5 64 25 40 

9 14 81 196 126 

∑X = 35 ∑Y = 45 ∑X2 = 279 ∑Y2 = 465 ∑XY = 302 

Regression equation of X on Y: X = a + bY and the two normal equations are: 

∑X = Na + b∑Y 

∑XY = a∑Y + b∑Y2 
 

Substituting the values 

35 = 5a + 45b           …… (1) 

302 = 45a + 465b           …… (2) 
 

Multiplying equation (1) by 9: 

315= 45a + 405b           …… (3) 
 

Subtract equation (2) from (3), 

13 = – 60b    or     b = – 0.22 
 

Substituting the value of b in equation (1); 

35 = 5a + 45(-0.22) 

=>  35 = 5a – 9.9 

=>  5a = 35 + 9.9 = 44.9 

So, a = 8.98 
 

Putting the value of a and b in the equation, 

The regression equation of X on Y: 

X = 8.98 – 0.22 Y 
 

2) Let Y = a + bX be the line of Y on X. To determine the values of a and b, the following two normal 

equations are to be solved simultaneously 

∑Y = Na + b∑X 

∑XY = a∑X + b∑X2 
 

Substituting the values, 

45 = 5a + 35b           …… (1) 
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302 = 35a + 279b           …… (2) 
 

Multiplying equation (1) by 7, 

315 = 35a + 245b 
 

Subtracting equation (2) from (3), 

13= – 34b      or       b = – 0.38 
 

Substituting the value of b in equation (1), 

45 = 5a+ 35 (–0.38) 

5a = 45 + 13.3 = 58.3    or     a = 11.66 
 

Putting the values of a and b in the equation Regression equation of Y on X: 

Y= 11.66 – 0.38 X 
 

REGRESSION EQUATIONS WHEN DEVIATION TAKEN FROM ACTUAL MEAN 

Following formulae are used to find out the deviation of X and Y series when deviation is taken from the 

actual mean. 

1) Regression Equation of X on Y 

 
X̅ = Mean of X series and Ῡ = Mean of Y series  

 

= Regression Coefficient of X and Y or bxy 

 

 
Where, x = (X – X̅); y = (Y – Ῡ) 

 

2) Regression Equation of Y on X 

 
X̅ = Mean of X series and Ῡ = Mean of Y series  

 

= Regression Coefficient of Y and X or byx 
 

 
Where, x = (X – X̅); y = (Y – Ῡ) 

 

Example 2: Using the following data obtain two regression equations: 

X 15 19 24 21 25 22 16 20 27 21 

Y 31 36 48 37 50 45 33 41 39 20 
 

Solution:    Calculation of Regression Equations 

X Y x = X – X̅ y = Y – Ῡ x2 y2 xy 

15 31 -6 -7 36 49 42 

19 36 -2 -2 4 4 4 

24 48 3 10 9 100 30 

21 37 0 -1 0 1 0 

25 50 4 12 16 144 48 

22 45 1 7 1 49 7 
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16 33 -5 -5 25 25 25 

20 41 -1 3 1 9 -3 

27 39 6 1 36 1 6 

21 20 0 -18 0 324 0 

∑X = 210 ∑Y = 380 ∑x = 0 ∑y = 0 ∑x2 = 128 ∑y2 = 706 ∑xy = 159 

 

 

 

 
REGRESSION EQUATIONS WHEN DEVIATION TAKEN FROM THE ASSUMED MEAN 

If we take the deviation from the assumed mean then the following formulae are used to solve the regression 

equation. 

Note: Assumed mean is taken because value of actual mean is in the fraction form. 
 

Regression Equation of X on Y is:  

  

Now find out the value of by applying the following formula: 

 
   

 
 

Regression Equations of Y on X is:   

 

Now find out the value of by applying the following formula: 

 

 

 
Where, dx = X - Ax, dy = Y - Ay 
 

Example 3: From the following data find the regression equations, and estimate the likely value of Y when 

X = 100. 

X 74 98 76 82 58 76 94 88 51 

Y 124 131 117 131 96 121 136 97 85 

Solution: Let assume that the mean for X-series is 80 and for Y-series is 120. 

X Y dx = (X – Ax) dy = (Y – Ay) dxdy dx
2 dy

2 

74 124 -6 4 -24 36 16 

98 131 18 11 198 324 121 

76 117 -4 -3 12 16 9 

82 131 2 11 22 4 121 
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58 96 -22 -24 528 484 576 

76 121 -4 1 -4 16 1 

94 136 14 16 224 196 256 

88 97 8 -23 - 184 64 529/ 

51 85 -29 -35 1015 841 1225 

∑X = 697 ∑Y =1038 ∑dx = – 23 ∑dy = – 42 ∑dxdy = 1787 ∑dx
2 = 1981 ∑dy

2 =2854 

 

 
 

Example 4: Find equation of regression line Y on X for the following data: 

X 25 23 28 26 29 21 30 24 33 36 

Y 28 26 28 24 29 26 31 32 36 27 

Also estimate Y, if X = 55. 

Solution:     Calculation of Regression Equations 

X Y XY X2 

25 28 700 625 

23 26 598 529 

28 28 784 784 

26 24 624 676 

29 29 841 841 

21 26 546 441 

30 31 930 900 

24 32 768 576 

33 36 1188 1089 

36 27 972 1296 

∑X = 275 ∑Y = 287 ∑XY = 7951 ∑X2 = 7757 

Regression equation of Y on X is: Y = a + bX 

To determine the value of a and b, the following two normal equations are to be solved: 

∑Y = Na + b∑X 

∑XY = a∑X + b∑X2 
 

Substituting the values, 

287 = 10a + 275b           …… (1) 

7951= 275a + 7757b          …… (2) 
 

Multiply 275 in equation (1) and 10 in equation (2), 

78925 = 2750a + 75625b          …… (3) 

79510 = 2750a + 77570b          …… (4) 
 

Subtract equation (3) from equation (4), 
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585 = 1945b 

=> b = 0.3 
 

Putting the value of b in equation (1), 

287 = 10a + 275 × 0.3 

=>       287 = 10a + 82.5 

=>       10a = 204.5 

=>     a = 2045 

So, regression equation of Y on X is: 

Y = 20.45 + 0.3X 

When, X = 55 then, 

Y = 20.45 + 0.3 × 55 = 36.95 

 

Example 5: The following data gives the experience of machines operator and their performance rating as 

given by number of good parts out of 100 pieces: 

Debaters 1 2 3 4 5 6 7 8 

Marks by A 16 12 18 4 3 10 5 12 

Marks by B 87 88 89 68 78 80 75 83 

Calculate the regression line of performance ratings on experience and estimate the probable performance of 

operator has 7 years experience. 
 

Solution: Let experience be denoted by X and performance by Y. 

Let Y = a + bX be the line of Y on X. To determine the values of a and b, the following two normal 

equations are to be solved simultaneously 

∑Y = Na + b∑X 

∑XY = a∑X + b∑X2 

Calculation of Regression Equations 

X Y X2 XY 

16 87 256 1392 

12 88 144 1056 

18 89 324 1602 

4 68 16 272 

3 78 9 234 

10 80 100 800 

5 75 25 375 

12 83 144 996 

∑X = 80 ∑Y = 648 ∑X2 = 1018 ∑XY = 6727 

the values, 

648= 8a + 80b           …… (1) 

6727 = 80a + 1018b          …… (2) 
 

Multiplying equation (1) by 10, 

6480 = 80a + 800b          …… (3) 

6727 = 80a + 1018b           …… (4) 
 

Subtracting equation (3) from (4), 

247 = 218b      or      b = 1.13 
 

Substituting the value of b in equation (1), 

648 = 8a + 80 (1.13) 

8a = 648 – 90.4 = 557.6    or     a = 69.7 
 

Putting the values of a and b in the equation 

Regression equation of Y on X: 

Y = 69.7 + 1.13 X 
 

When, X = 7 years then, 

Y = 69.7 + 1.13 × 7 = 69.7 + 7.91 = 77.61 
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MULTIPLE REGRESSION 
Three or more variables, such as X1, X2, and X3, are analysed in multiple regression analysis. Here, X1 is 

taken as a dependent variable and its relative movement is found out, according to the movement in both 

independent variables X2 and X3. Thus, the effect of two or more independent variables on one dependent 

variable is studied in the ‘multiple regression analysis’. The procedure for studying multiple regression is 

similar to simple regression, but there is a single difference that the independent variable is more than one. If 

there are three variables, X1, X2 and X3, the multiple regression will take the following form: 

X1 = a1.23 + b12.3 X2 + b13.2 X3 

In the above equation there are three constraints. The subscript after the dot indicates the variables, which 

are held constant. 

If X2 and X3 are 0 then X1 = a1.23 
 

For multiple regression models with two independent variables the result is determined with the use of three 

simultaneous equations, with three unknown (b0, b1 and b2) values. Statistical software, such as SPSS, 

MINITAB, MS-EXCEL etc., are used in multiple regression models because this analysis involves lengthy 

calculations. 
 

ASSUMPTIONS OF MULTIPLE REGRESSION ANALYSIS 

Following are the assumptions of multiple regression analysis: 

1) The dependent variable should be a random variable whereas the independent variable need not be 

random variable, 

2) The relationship between various independent variables and dependent variable is linear, and 

3) The variances of the conditional distributions of the dependent variable and various combinations of 

values of the independent variables are all equal. The conditional distributions for the dependent variable 

follow the normal probability distribution. 
 

STEPS IN MULTIPLE REGRESSION 

1) State the research hypothesis. 

2) State the null hypothesis. 

3) Collect the data. 

4) Calculate each variable separately (calculate measures of central tendency and dispersion, frequency 

distributions, graphs). Check, whether the variables are normally distributed or not. 

5) Calculate the relationship between the dependent variable and the independent variables (find the 

correlation coefficient, obtain a scatter plot). Check, whether the variables are linearly correlated or not. 

6) Calculate the relationship between all the independent variables with each other (calculate the correlation 

coefficient matrix for all the independent variables). 

7) Calculate the regression equation from the data. 

8) Calculate and examine appropriate measures of association and test of statistical significance for each 

coefficient as well as for the equation as a whole. 

9) Accept or reject the null hypothesis. 

10) Reject or accept the research hypothesis. 

11) Explain the practical implications of the findings. 

 

MODELING TREND AND SEASONALITY 
When a researcher collects information and plots a pattern or trend (based on that information) then this 

process is known as “trend analysis”. Trend analysis is used to estimate and forecast the future and past 

events. For example, a researcher can make an estimate that how many ancient kings may rule in a given 

time period (between two dates). This calculation is based on various data, such as average years in which 

other kings reigned. 

To fit or plot a trend line based on a time series data, trend analysis uses the least square method. The 

resultant line is used for forecasting. This technique is a special case of regression analysis, where time is the 

independent variable and the dependent variable is to be forecasted. The benefit of trend analysis is that it is 

simple to use and also helpful in inferring the data. This analysis has one limitation that it is not always 

applicable for long-term time series. 
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Purpose of Measuring Trends 

There are three basic purposes of measuring trends: 

1) The first purpose of measuring a trend is to study the past growth and decline of a series. The basic 

growth tendency is explained by the secular trend while ignoring the short-term fluctuations. 

2) The projection of the curve into the future as a long-term forecast is the second purpose of measuring a 

trend. If the past growth has been in a steady state and if the conditions which determine this growth are 

expected to continue in the future then the trend curve may be projected over five to ten years into the 

future as a preliminary forecast. 

3) Eliminating a trend is the third purpose of measuring a trend i.e., to clarify the cycle and other short-term 

fluctuations in data. Minor cycles represent a steep trend in data. If the data is divided by the trend value 

yield ratios then they show a cyclical fluctuation around the horizontal line. 
 

DETERMINATION OF TREND 

The secular trend is determined by four methods which are as follows: 

a) Graphic Method     b) Semi-Average Method 

c) Moving Average Method    d) Least Squares Method 
 

1) Free-Hand or Graphic Method→ Free-Hand or Graphic Method is the simplest and the most flexible 

method of estimating secular trend. In this method, following is the procedure to obtain a straight line 

trend: 

a) Time series is plotted on a graph. 

b) The direction of the trend should be carefully examined on the basis of plotted information (dots). 

c) A straight line is drawn according to personal judgment which will best fit the data. 

Some points should be considered for getting proper trend line by the free-hand method: 

a) The curve should be smooth. 

b) The number of points above and below the curve should be approximately equal. 

c) The total deviations of data above the trend line should be equal to the vertical deviations below the 

line. 

d) Trend is small as compared to the sum of the squares of the vertical deviations. 
 

2) Semi-Average Method→ In the semi-average method the original data is divided into two equal parts 

and then an average is calculated for each part. The calculated averages are called semi-averages. For 

example, we can divide the 6 years, 2003 to 2008, into two equal parts; from 2003 to 2005 and 2006 to 

2008. If the given period is an odd number of years then the value of the middle year is omitted. If one 

considers the years between 2001 to 2011 (11 years), then one omit the year 2006. A straight line can be 

drawn by joining the two points of average. An intermediate value or future value can be predicted by 

extending the line downward or upward. The following example will make it clear. 
 

3) Ratio to Moving-Average Forecasting Method→ The device which reduces the fluctuations and 

obtains trend values with a fair degree of accuracy is known as ‘moving average method’. In this method 

the trend value for the middle point of the period of moving average is taken from the average value of 

the number of years. The curve can be smoothened and fluctuations are reduced by the process of 

averaging. The period of moving average is primarily decided in this method. 

Let us consider that 5 years, months, weeks or days (as the case may be) are selected as the period of the 

moving average then the arithmetic average of the first five items would be plotted against item no. 3 

and then the arithmetic average of item nos. 2, 3, 4, 5 and 6 would be plotted against item no. 4. When 

the arithmetic average of the last five items has been calculated then the process ends up. 
 

4) Least Squares Method→ It is the most widely used method. This method is used to fit the trend line to 

the data. To fit a trend line this method should satisfy the following condition: 

∑(Y – Ye) = 0 

i.e., the summation of deviations of the actual values of Y and the calculated values of Y is zero. 

∑(Y – Ye)
2 is least, 

The above equation shows that the sum of squares of the deviations of the actual and calculated value is 

least from this line. Due to this reason this method is known as ‘method of least squares’ and the line 

obtained from this method is called ‘best fit’. 

This method is not only used to fit a straight line but also used to fit a parabolic trend. Equation below 

represents the straight line trend. 
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Ye = a + bX 

Where, 

Ye = Denotes the trend (computed) values, 

a = The Y intercept or the value of the Y variable, 

b = It represents (when X = 0) the slope of the line or the amount of change in Y variable that is 

associated with a change of one unit in X variable, 

X = Variable in time series analysis represents time. 

 

SEASONAL VARIATIONS 
By seasonal variations in a time series we mean such variations which occur regularly and periodically with 

period less than one year. For example, the sale of ice cream is affected by weather conditions so that in 

every summer the sale would be more than what it is in winters. This is the seasonal effect on the sale of ice 

cream and would be in every season. 

Seasonal movements affect most of the economic and business phenomena and unless a business executive 

knows about the nature of such variations, he cannot take policy decisions. Decisions relating to inventory 

control, purchases and sales have to be taken after accounting for seasonal variations. 
 

OBJECTIVES OF SEASONAL VARIATION 

1) To Study Seasonal Variation→ Seasonal variations in themselves give a clear idea about the relative 

position of each season on the basis of which it is possible to plan for the season. 

2) To Eliminate them→ It is necessary to eliminate seasonal factor to get the cyclical or irregular factors. 

This is called deseasonalization of the data. 
 

COMPUTATION OF SEASONAL VARIATION 

Before we proceed to discuss various methods of isolating seasonal variation it must be clearly understood 

that the effect of the seasons on a variable is present only when we have six-monthly, quarterly, monthly, 

weekly, daily data. Since seasonal fluctuations recur during the course of a year, we cannot see the effects of 

seasons if the data is lumped together by years or by longer time periods. This is so because if the values of 

a variable for any twelve consecutive months, or four consecutive quarters, or fifty-two consecutive weeks 

are totaled up the effects of the seasons automatically disappear. 

First, we take an illustration of isolating short-term and seasonal fluctuations by the additive model. 
 

Example: Calculate the seasonal fluctuations of the given outputs in various years. 

Quarter/Year 2006 2007 2008 2009 2010 

1 35 38 47 61 72 

2 86 109 158 177 206 

3 67 91 104 !34 141 

4 124 176 226 240 307 

Solution: 

Year 
Quarter 

Q 

Output 

Y 

Moving total 

(4) 

Moving total 

(8) 

Moving Average 

(T) 

Short-term Fluctuation 

Y–T 

2006 

1 
 

2 

 

3 
 

4 

 

35 
 

86 

 

67 
 

124 

 
 

 

312 

→ 
315 

→ 

338 

 
 

 

 

627 
 

653 

 
 

 

 

78 
 

82 

 
 

 

 

–11 
 

+42 

2007 

1 

 

2 

 
3 

 

4 
 

38 

 

109 

 
91 

 

176 

→ 

362 

→ 

414 
→ 

423 

→ 
472 

700 

 

776 

 
837 

 

895 

88 

 

97 

 
105 

 

112 

–50 

 

+12 

 
–14 

 

+64 

2008 1 47 → 957 120 –73 
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2 

 

3 

 
4 

 

 
158 

 

104 

 
226 

485 
→ 

535 

→ 

549 
→ 

568 

 
1020 

 

1084 

 
1117 

 
128 

 

136 

 
140 

 
+30 

 

–32 

 
+86 

2009 

1 

 
2 

 

3 
 

4 

 

61 

 
177 

 

134 
 

240 

→ 

598 
→ 

612 

→ 
623 

→ 

652 

1166 

 
1210 

 

1235 
 

1275 

146 

 
151 

 

154 
 

159 

–85 

 
+26 

 

–20 
 

+81 

2010 

1 

 

2 

 

3 

 

4 

 

72 

 

206 

 

141 

 

307 

→ 

659 

→ 

726 

 

 

 

 

1311 

 

1385 

 

 

 

 

164 

 

173 

 

 

 

 

–92 

 

+33 

 

 

 

 

 

Calculations of Seasonal Fluctuations 

Year Q.l Q.2 Q.3 Q4 

2006 – – – 11 +42 

2007 – 50 +12 – 14 +64 

2008 – 73 +30 – 32 +86 

2009 – 85 +26 – 20 +81 

2010 – 92 +33 – – 

Total – 300 +101 – 77 +273 

Average – 75 +25 – 19 +68 
 

MEASUREMENT OF SEASONAL VARIATIONS 

The following are some of the methods more popularly used for measuring seasonal variations: 

a) Simple Average Method    b) Ratio to Trend Method 

c) Ratio to Moving Average Method   d) Link Relative Method 
 

SIMPLE AVERAGE METHOD 

This is the simplest method of obtaining a seasonal index. The following steps are necessary for calculating 

the index: 

1) Arrange the unadjusted data by years and months (or, quarters if quarterly data are given). 

2) Find the totals of January, February, etc. 

3) Divide each total by the number of years for which data are given. For example, if we are given 

monthly data for five years then, we shall first obtain total for each month for five years and divide each 

total by 5 to obtain an average. 

4) Obtain an average of monthly averages by dividing the total of monthly averages by 12. This method is 

the simplest of all methods of measuring seasonality. However, it is not a very good method. It assumes 

that there is no trend component in the series, i.e., the original series comprise, C × S × I. Since most 

economic series have trends, the index computed by this method is actually an index of seasonal 

variation plus trend. 

5) Taking the average of monthly averages as 100, compute the percentages of various monthly averages as 

follows: 

     Monthly average for January     

Seasonal Index for January = –––––––––––––––––––––––––––– × 100 

           Averages of monthly average 
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If, instead of the average of each month, the totals of each month are obtained, we will get the same 

result. 
 

Example: Compute seasonal indices by the method of monthly averages to determine the monthly indices 

for the following data of production of a commodity for the years 1989, 1990, 1991: 

Month Jan Feb Mar Apr May Jun July Aug Sep Oct Nov Dec 

Production 

in Lac of 

Tonnes 

2007 12 11 10 14 15 15 16 13 11 10 12 15 

2008 15 14 13 16 16 15 17 12 13 12 13 14 

2009 16 15 14 16 15 17 16 13 10 10 11 15 

Solution:    Computation of Seasonal Indices 

Month 
(Production in Lac of Tonnes) 

Total 
Average 
Monthly 

Seasonal 
Index 2007 2008 2009 

(1) (2) (3) (4) (5) (6) (7) 

January 12 15 16 43 14.33 104.886 

February 11 14 15 40 13.33 97.566 

March 10 13 14 37 12.33 90.247 

April 14 16 16 46 15.33 112.205 

May 15 16 15 46 15.33 112.205 

June 15 15 17 47 15.66 114.620 

July 16 17 16 49 16.33 119.524 

August 13 12 13 38 12.66 92.662 

September 11 13 10 34 11.33 82.928 

October 10 12 10 32 10.66 78.024 

November 12 13 11 36 12.00 87.832 

December 15 14 15 44 14.66 107.301 
   Total 492 163.9500 1200.000 
   Average 41 13.6625 100.000 

 

Average of Averages, X̅ = l/12(14.33+14.33 + ...14.66) 

       163.95 

  = ––––––– = 13.6625 

          12 

         14.33 

Seasonal Index for January = ––––––––– × 100 = 104.884 

       13.6625 
 

         13.33 

Seasonal Index for February = ––––––––– × 100 = 97.566 and so on. 

       13.6625 

 

Example: Calculate the seasonal index from the following data using the average method: 

Year 1
st
 Quarter 2

nd
 Quarter 3

rd
 Quarter 4

th
 Quarter 

1994 72 68 80 70 

1995 76 70 82 74 

1996 74 66 84 80 

1997 76 74 84 78 

1998 78 74 86 82 

Solution: 

Year 1
st
 Quarter 2

nd
 Quarter 3

rd
 Quarter 4

th
 Quarter 

1994 72 68 80 70 

1995 76 70 82 74 

1996 74 66 84 80 

1997 76 74 84 78 

1998 78 74 86 82 

Total 376 352 416 384 

Average 75.20 70.40 83.2 76.80 
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Seasonal Index 98.43 92.15 108.9 100.52 

 
Seasonal Index = (Average Monthly + Grand Average) ×100 

(75.2 / 76.4) × 100 = 98.43; (70.4 / 76.4) × 100 = 92.15 

(83.2 / 76.4) × 100 = 108.9; (76.8 / 76.4) × 100 = 100.52 

 

 

Example: Assuming that trend is absent, determine if there is any seasonality in the data given below: 

Year 1
st
 Quarter 2

nd
 Quarter 3

rd
 Quarter 4

th
 Quarter 

1982 37 41 33 35 

1983 37 39 36 36 

1984 40 43 33 31 

What are the seasonal indices for various quarters? 
 

Solution:    Computation of Seasonal Indices 

Years Q1 Q2 Q3 Q4 

1982 37 41 33 35 

1983 37 39 36 36 

1984 40 43 33 31 

Total 114 123 102 102 

Average 38 41 34 34 

 
 

Advantages of Simple Average Method 

1) Simple average method is the simplest method of measuring seasonal variations. 

2) This method is suitable for those time services where no definite trend exists. 
 

Disadvantages of Simplex Average Method 

1) This method assume that there is no trend component in the series i.e., T = 0 whereas most of economic 

series have trends. 

2) The effect of cycles on the original values may or may not be eliminated by the averaging process. 

 

RATIO-TO-TREND METHOD 

This is also called the Percentage to Trend Method. It is an improvement over the above said method. It is 

based on the assumption that the seasonal fluctuation for any season (month or quarter) is a constant factor 

of the trend. It is based on the multiplicative model. The steps are: 

1) By applying the method of least squares, we can obtain the trend values. 

2) We must divide the original data of time series for each season (month quarter) by the corresponding 

trend values and multiply these ratios by 100, i.e., 

T × S × C × I 

          ––––––––––––– × 100 = S × C × I × 100 

        T 
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Thus the trend eliminated values are obtained. This percentage will include seasonal, cyclical and 

irregular fluctuation. 

3) In order to eliminate the irregular and cyclical movement, the seasonal figures are averaged with any one 

of the measures of central tendency, mean or median. Thus we obtain the indices for seasonal variation 

for different seasons. 

4) These indices are adjusted to a total of 1,200 for monthly data or 400 for quarterly data by multiplying 

each index by a suitable factor. 

 

 
It gives a more representative value of seasonal variation than the simple average method. It is easy to 

understand and simple to calculate. However the limitation of this method is that it does not follow the 

actual data as a 12 month moving average method. So the seasonal index calculated by this method is more 

biased. 
 

Example: Find seasonal variations by ratio-to-trend method from the data given below: 

Year 1st Quarter 2nd Quarter 3rd Quarter 4th Quarter 

2004 30 40 36 34 

2005 34 52 50 44 

2006 40 58 54 48 

2007 54 76 68 62 

2008 80 92 86 82 

Solution: For determining seasonal variation by ratio-to-trend method, first we will determine the trend of 

yearly data and then convert it to quarterly data. 

Calculating Trend by Method of Least Squares 

Year 
Yearly 

Totals 

Yearly 

Average 

Deviations 

from Mid-Year XY X2 
Trend 

Values 
Y X 

2004 140 35 -2 -70 4 32 

2005 180 45 -1 -45 1 44 

2006 200 50 0 0 0 56 

2007 260 65 +1 +65 1 68 

2008 340 85 +2 +170 4 80 

  ∑Y = 280 ∑X = 0 ∑XY = 120 ∑X2 = 10  

The equation of the straight line trend is Y= a + bX. 

 
 

RATIO TO MOVING AVERAGE METHOD 

The Ratio to moving average method, also known as the percentage of moving average method, is the most 

commonly used method of measuring seasonal variations. This method of computing seasonal indices 

consists of the following steps: 

1) Seasonality from the data is eliminated by computing twelve monthly or four-quarterly moving averages. 

The trend and cyclical elements tend to be present in the moving averages (T × C) 

2) The original data for each quarter is divided by the corresponding moving average figure, and this ratio 

is expressed in percentages 
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These ratios to moving average figures contain only the seasonal and irregular movements since the 

trend and cyclical components were eliminated in the division by moving average. 

3) The ratio-to-moving average figures are arranged by quarters, that is, all the first quarters in one group, 

all the second quarters in another and so forth. Then average the ratio to moving average figures for each 

quarter in an attempt to eliminate the irregular movements and thus to isolate the stable seasonal 

components. 

It is a flexible, widely used and the most satisfactory method. If the cyclical fluctuations are regular in 

periodicity, this will give true seasonal indices. However, we cannot obtain seasonal indices for each 

month. There is loss of trend values in the earlier 6 months and in the later six months. So we cannot 

calculate seasonal indices for that period. 
 

Example: Obtain seasonal indices by the ‘ratio-to-moving average’ method from the following data: 

Year 
Quarters 

I II III IV 

2007 68 62 61 63 

2008 65 58 66 61 

2009 68 63 63 67 

Solution: In the ‘ratio-to-moving average’ method, we first calculate 4 quarterly moving averages and ratios 

to moving averages as under: 

Computation of Ratios to Moving Averages 

Year and 

Quarter 

Original 

Data 

Y 

4-Quarterly 

Centred Moving 

Totals 

4-Quarterly 

Centred Moving 

Totals 

4 

4-Quarterly 

Centred Moving 

Averages 

(T) 

Ratio-to-Moving 

Averages 

(Percentage) 

= Y/T x 100 

2007   I 68       

II 62 

 

 

→ 

 

254 

    

III 61 

 

 

→ 

 

251 

→ 505 63.125 96.63 

IV 63 
 

 
→ 

 
247 

→ 498 62.250 101.20 

2008   I 65 

 

 

→ 

 

252 

→ 499 62.375 104.21 

II 58 
 

 
→ 

 
250 

→ 502 62.750 92.43 

III 66 

 

 

→ 

 

253 

→ 503 62.875 104.97 

IV 61 

 

 

→ 

 

258 

→ 511 63.875 95.50 

2009   I 68 

 

 

→ 

 

255 

→ 513 64.125 106.04 

II 63 

 

 

→ 

 

261 

→ 516 64.500 97.67 

III 63       

IV 67       

Again, the percentage of original data to moving averages are arranged according to years and quarters to 

obtain the seasonal indices as shown in the following table: 
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LINK RELATIVE METHOD 

The procedure for computing seasonal variations by this method is somewhat complicated. We like to give 

the steps necessary in its computation. 

1) Calculate the seasonal link relatives for each seasonal figures by the following method: 

           Current Season Figure 

Link Relative = –––––––––––––––––––– × 100 

   Previous Season Figure 

2) Calculate average of the link relatives for each season. Arithmetic mean is generally used but even 

median could be used. 

3) Convert these averages into chain relatives on the basis of the first season. 

4) Calculate the Chain relative of the first season on the basis of the last season. 

5) For correction, the chain relative of the first season calculated by the first method is deducted from the 

chain relative of the first season calculated by the second method. The difference is divided by the 

number of seasons. The resulting figure multiplied by 1, 2, 3, etc., are deducted respectively from the 

chain relatives of the 2nd, 3rd, 4th, etc. seasons. 

6) The seasonal indices are available when we express the corrected chain relatives as percentages of their 

respective averages. 

 

USING S CURVE TO FORECAST SALES OF A NEW PRODUCT 
New product revenue and sales forecasting approaches can be as simple as “guesstimating” the first year 

sales of a given product, escalating it for future year forecasts by an annual growth rate until a specific level 

of saturation is reached. This simple approach assumes that sales will continually grow throughout the 

product’s lifecycle. Is there justification for assuming that sales will grow in such a pattern other than it is 

the result of an inexpensive and easy-to-apply forecasting tool? 
 

Although there are a myriad of both qualitative and quantitative methods for new product sales forecasting 

from simple growth escalation to forecasting with econometrically-estimated demand functions, a question 

arises as to whether there is a causal theory of new product sales in the market research academic literature 

that lends guidance to the type of forecasting method chosen. This matter is of practical importance when 

doing the “road show” for raising venture capital and for convincing oneself of the credibility of your 

forecasts. 
 

New Product Sales Forecasting S Curve Models: Product Diffusion 

A large literature in marketing research strongly demonstrates that product sales life cycles follow an S-

curve pattern. An S-curve pattern implies that new product sales initially grow at a rapid rate, then the rate 

of growth tapers off, and finally declines with time. Historical analysis of new product sales curves indicates 

this is one of the most common, if not the most common pattern of new product sales over time. 
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The new product sales model explains this S-curve shape based on diffusion theory. Diffusion theory is 

actually a theory of communication regarding how information is dispersed within a social system over time. 

Because people place different emphases on how much they rely on media and interpersonal communication 

for new ideas and information, they “adopt” new products either earlier or later in a product’s lifecycle. 
 

The consumer product adoption process based on 

relative adoption time categorizes individuals as 

innovators, early adopters, early majority, late 

majority, and laggards, beside figure shows the 

cumulative percentage of the potential market (i.e., 

total number of adopters) that has made an initial 

purchase of a new product. 

As you move up and to the right of the S-curve in 

this figure i.e., as you look at the rate of adoption of 

a new product over time by first time purchasers, 

there are initially the innovators buying the product, 

then early adopters, and so on as we move up the S-

curve, until the point of market saturation is 

reached, where the last set of first-time buyers are 

known as the laggards. 

This figure shows the time of adoption of 

buyers for the product. If the buyer is to 

the left of the vertical line in their time of 

adoption they are innovators, early 

adopters or part of the early majority, if to 

the right they are the late majority or the 

laggards. 

 

 

 

 
 

Below figure displays different types of S curves developed from alternative types of product sales 

forecasting models. 

 
The “S-curve” model is what is known as a “single purchase” model in that it forecasts sales of products that 

are typically bought just once, or infrequently, such as consumer durables or industrial products such as 

mainframe computers. In addition, the model can be used to forecast trial or first time purchases for repeat 

purchase goods such as snack foods and detergents, but it does not provide a forecast of repeat purchase 

levels. In order to estimate repeat purchase sales and differentiate them from trial sales, businesses would 

typically need to carry out test markets or simulated test markets and apply different forecasting methods 

that would provide a steady-state market share estimate rather than a time-based adoption curve as is 
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provided by diffusion models. However, all products, regardless of how often they are purchased, have a 

first-purchase sales volume curve (Mahajan and Wind 1986). 
 

Assumptions of Diffusion models 

Diffusion models are dependent on a number of assumptions, each of which should be considered prior to 

implementing such models. The assumptions include: 

1) The product whose sales are being forecast by the model is a product that is destined to be a successful 

new product introduction. Estimates of new product failure rates vary from 33% to 60% or higher. The 

present model is appropriate only for successful new product entries. The present model cannot predict 

which new product launch will be successful; it is instead designed to project sales volume over time for 

those product launches that are successful. 

2) The model requires that the user input an estimate for the total market size for the particular brand within 

the product category (i.e., total number of adopters of the branded product). To the extent that this 

estimate is inaccurate, the new sales forecasts will also be inaccurate. The user firm may choose to use 

historic sales data, however it needs to produce an estimate of potential market size, and then estimate 

the brand’s share within the market. 

3) When the user estimates their brand’s market share within the product category, a number of underlying 

assumptions about competitive response underlie such an estimate. It is possible that competitive 

response, such as imitative competitive alternatives, or heavier promotional responses, will adversely 

affect the share of the new product’s sales. Again, to the extent that the market share estimate is 

inaccurate, the new product sales estimates will also be inaccurate. 
 

The model recommended here has been developed from theoretical work in the area of diffusion processes 

and the customer new product adoption process. Diffusion process models attempt to forecast the market 

penetration rates of innovative products (air conditioners, cell phones, the internet, hybrid gas/electric cars, a 

new brand of coffee, etc.) over time. The customer adoption process refers to differences among customers 

in the degree to which they are innovative, and thus willing to try a new product. Some customers are very 

innovative and are the first to try new products, whereas others are less so, and typically wait until many of 

their neighbours, etc., have already bought the new product before they do the same. 
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UNIT-4: CUSTOMER ANALYTICS (8 HRS) 

 
Customer Lifetime Value: Concept, Basic Customer Value, Measuring Customer Lifetime value, 

Estimating Chance that customer is still active, Using Customer Value to value a business 

Market Segmentation: The segmentation-targeting-positioning (STP) framework, Segmentation, The 

concept of market segmentation, managing the segmentation process, Deriving market segments and 

describing the segments using Cluster analysis. 
 

MEANING OF CUSTOMER ANALYTICS 
Customer Analytics essentially refers to the techniques that are employed by business organisations to 

extract extensive information about their customer base while also keeping a close watch on customer 

behaviour. It allows companies to identify potential customers and devise strategies to attract new customers 

as well as retain the old ones. 

Today, customers are more hooked up to the Internet than ever. They are always active on social media, 

online shopping portals, online platforms with informative content, and so on. As a result, consumers are 

now always updated about the latest trends in the market, be it regarding technology, products, and services, 

fashion, or education - they know it all. This has made it all the more important for business firms and 

organisations to gather an all-comprehensive knowledge about their customer base, their likes and dislikes, 

and their tastes and preferences. 

In the cut-throat competitive business world, if marketers fail to ‘learn’ about customers’ behaviour and 

preference, they might fall behind in the race. If customers see that marketers are failing to understand their 

‘pain points’, they know they have other options to look up to. Thus, to retain a loyal customer base, 

marketers need to invest in Customer Analytics. Customer analytics comprises the backbone of a business’ 

marketing strategies and integrates advanced techniques like data visualisation, predictive modelling, 

information management and segmentation. 
 

KEY CUSTOMER ANALYTICS IN USE TODAY 

Some important customer analytics in use today are given below: 

1) Customer Satisfaction Analysis→ Customers who are happy will come back again for more purchases. 

This type of analysis determines whether the customers’ needs are being met - in short, it determines 

whether they are satisfied or dissatisfied with what the company offers. 

2) Customer Lifetime Value Analytic→ This is the process of analysing the entire relationship with a 

customer in order to determine his or her value to the business. It determines how Jong a customer stays 

a customer, their likelihood of making purchases during that period and their entire value in that 

timeframe. The main goal is to focus marketing strategies to the best customers in order to increase the 

customer-business relationship. 

3) Sales Channel Analytics→ Sales channel analytics analyses all the different ways a product can be 

distributed to the market and determines the most effective channel for better resource management. 

Customers may be exposed to a different sales channel so it is crucial to determine whether-customers 

prefer to purchase physically or online. 

4) Customer Segmentation Analytics→ All customers are not equal. This process identifies sub-groups 

within the customer base and splits them into segments depending on their purchasing power. This 

allows the company to customise its marketing and communication efforts. 

5) Web Analytics→ Online sales in just about every industry are increasing. Web analytics is the process 

of analysing online behaviour so as to optimise website use and increase engagement and sales. There 

are two types of web analytics: off-site and on-site. Off-site web analytics is useful for assessing the 

market and opportunity whereas on-site is useful for measuring commercial results. 

6) Social Media Analytics→ Social media analytics is the process of gathering and analysing data from 

social media to see what people are saying about the product, service, brand or company. In social media 

analytics, text data from social media posts and blogs is gathered and mined for commercially relevant 

insights using text analytics and sentiment analysis. 

7) Customer Engagement Analytics→ Customer engagement analytics is a rapidly evolving field where 

businesses are trying to map the entire customer interactive journey on- and off-line. Essentially it is the 

process of assessing how well (or otherwise) companies engage the customers with products, services or 
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brand through these various interactions. Ways of measuring customer engagement include surveys and 

social media analytics. 

8) Customer Churn Analytics→ Customer churn analytics is the process of assessing how many 

customers companies are losing over the course of a year. It also allows predicting customer churn in the 

future and taking evasive action before losing those customers. Customer churn can be assessed using 

KPIs such as customer retention rate and customer turnover rate. 

9) Customer Acquisition Analytics→ Customer acquisition analytics seeks to establish how effective 

companies are at acquiring new customers, including how effective they are at pinching customers from 

their competitors. There are a number of metrics that can help to establish customer acquisition, such as 

the cost per lead and customer conversion rate KPIs. 
 

IMPORTANCE OF CUSTOMER ANALYTICS 

There is an impeccable and straightforward logic behind investing in customer analytics - the better the 

marketers understand and know their customers (their buying habits, their preferred choices, and the offers 

that they respond to), the more accurately will they be able to draw predictions regarding their future buying 

behaviour patterns. According to a McKinsey & Company survey, businesses that heavily invest in customer 

analytics are more likely to outperform their competitors, be it on the grounds of sales, or revenue, or ROI. 

Customer analytics can help to: 

1) Reduce attrition rates significantly be accurately forecasting about the time periods when customers are 

most likely to leave, thereby allowing to chalk out proactive plans and campaigns to retain them. 

2) Boost the response rates, customer loyalty, and ROI by allowing to target the right audience with 

attractive and befitting offers. 

3) Reduce campaign costs by streamlining campaigns to target only the customer base that is most likely to 

respond. 

4) Optimise the overall customer experience by creating personalised selling and marketing strategies for 

the different customer segments. 

5) Identify the current trends in Big Data to boost sales. 
 

BEST PRACTICES FOR EFFECTIVE CUSTOMER ANALYTICS 

1) Walk in Customers’ Shoes→ Every interaction with customers leaves a trail of data - information that 

becomes more valuable when it is combined to generate a richer picture of everything from their product 

choices and channel preferences to when, how, and why they want to interact with the organisation. 

Build on that picture by walking in their shoes. Marketers must interact with their own organisation’s 

channels. Talk to customer-facing employees to hear their “voice of the customer” insights. These 

experiences can help identify the most pressing areas for improvement. 

2) Ask Smart Questions→ What information will help the marketers better serve customers, gain 

competitive advantage, or fulfil the business strategy? Smart analytics is about knowing the right 

questions to ask. And answering those questions will likely require an innovative approach to data 

analysis - one that can deliver actionable insights to keep the marketers a step ahead of the competition. 

3) Know the Data→ Do marketers have access to internal or external data that provide the insights that 

can help answer questions? The strength of current data should not be underestimated. It does not have 

to be complete to be valuable. Along the way, marketers should not settle for aggregate views, or 

someone else’s summary of what they think marketers need. Marketers should have the technology 

muscle to zoom directly to the most granular level of data to develop a more intelligent understanding of 

the customers. 

4) Make it Count→ Before starting; marketers should plan for how they can turn the insights into actions, 

and how to measure results. Marketers must make sure that they have the necessary organisation, 

systems, and processes in place that support business implementation and add value. At the same time, 

all this should not be used as an excuse for inaction. Marketers must know the constraints they will be 

working within, and stay focused on determining what they can do with customers now to deliver a 

return on their investments. 

5) Target a Quick Win→ Pick a tight, focused project that can generate valuable insights and 

recommendations that will likely be easier to execute. Use this experience to learn how to tackle more 

complex, broader-scale projects across the enterprise and to gain internal cultural buy-in for future 

changes. 
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SEGMENTATION-TARGETING-POSITIONING (STP) FRAMEWORK 
The awareness about the product amongst the consumers is the basic requirement of marketing. It is the 

responsibility of the marketer to effectively communicate with customers in order to inform them about the 

products and services being offered by the company. Since, requirements and demands vary from individual 

to individual; marketing planning cannot afford to be a clean sweep. The marketing planning has to have 

such campaigns made so that USPs (Unique Selling Prepositions) are logically and clearly communicated to 

the customers. A single product cannot satisfy all customers. Therefore, due to the varying needs and 

requirements, it is essential to make different segments of consumers and plan for each segment separately. 

This process in marketing is called ‘Target Marketing’ which is also termed as STP (Segmentation, 

Targeting and Positioning). 
 

STEPS IN TARGET MARKETING 

After segmenting the market, the marketers have to select the segments to create their target market. This is 

known as targeting a target market. This makes the consumer aware of the product. The products are placed 

into the minds of the customer, which is called positioning of the product. The entire process of segmenting, 

targeting and positioning is referred as market selection. These three activities in the target marketing of 

market selection are as follows: 

 
1) Identifying Market Segments (Market Segmentation)→ The first and foremost action in target 

marketing is to locate the target markets which have not been served yet. The unsatisfied needs of such 

markets become the basis of segmentation. Following three phases are involved in segmentation: 

a) Analysing the pattern of demand, 

b) Determining the segmentation bases, and 

c) Identifying the available market segments. 
 

2) Selecting Target Market (Market Targeting)→ After dividing the market into homogenous segments, 

the marketers aim at identifying those segments for which they could develop their products. This 

involves: 

a) Analysing the segments to determine their attractiveness, and 

b) Selecting the potential segment(s). 
 

3) Developing Market Positions (Market Positioning)→ Each selected segment differs from the other 

one on the basis of different types of customers and their expectations about the product. Thus, 

positioning includes: 

a) Identifying possible positioning concepts for each target segment, and 

b) Developing marketing mix for each target segment. 
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CONCEPT OF MARKET SEGMENTATION 

The customers differ from each other in their habits, preferences, hobbies, income, culture, purchase 

decisions, etc. In order to streamline the marketing process, the consumers of similar characteristics are 

grouped together in segments. This is termed as ‘market segmentation’. Market segmentation means 

division of market into smaller groups having similar needs and qualities. 

This helps the company to modify the products or services to suit the different groups more effectively. 

Even, the advertisement messages and promotional methods are needed to be modified so that they are well-

understood by the group. For example, a product being sold in the State of Tamil Nadu is required to be 

advertised in Tamil language. Here, getting the endorsement of local popular film star will be an added 

advantage. 

According to Philip Kotler, “Market segmentation is sub-dividing a market into distinct and homogeneous 

subgroups of customers, where any group can conceivably be selected as a target market to be met with 

distinct marketing mix”. 

The actual objective of segmentation is to develop separate marketing plan for each segment so that 

consumers can be better served and their expectations are met effectively. In marketing planning, the market 

segmentation is perceived as the first step towards betterment. After identification of a particular consumer 

group and application of four Ps, i.e. product, price, place, and promotion, in proper manner, the marketers 

are able to design products and services according to the target market. 
 

NEED FOR MARKET SEGMENTATION 

Market segmentation is essential for marketers because of the following reasons: 

1) Meeting the Needs and Demands of Customers→ Different customers have different types of needs 

and demands. By segmenting a large market, customers of different segments can be offered products or 

services which provide them higher level of satisfaction. 

2) Increasing Profits for Organisations→ The price sensitivity of customers varies in accordance with 

their disposable incomes. By segmenting the markets, organisations can increase their average price of 

the products and services, thereby improving their profits. 

3) Greater Chances for Growth: Segmentation of a market can lead to high volume of sales. For example, 

a customer can be lured or motivated to purchase a product in future when a firm offers first sample of 

the product at an introductory price which is very low. 

4) Retain Customer Base: Customers go through various types of transition phases such as they become 

adults, start working, get married, have children, get promotion, and hence keep on changing their 

purchasing pattern. Any business organisation can continue to retain its customer base by offering them 

the products and services which they may need at different phases of their life cycle; otherwise, these 

customers may get diverted to other brands or products. 

5) Target Marketing Communications: All the business organisations should communicate with their 

target customers. Organisations may face the following challenges if the target audience is too large: 

a) The important customers may be left unnoticed. 

b) The cost of communicating with the customers may be very high, making the marketing 

communication unprofitable. Hence, through market segmentation, target customers can be 

approached frequently and offered products at lower prices. 

6) Gain Share of Market Segment→ The profitability of any organisation cannot be increased until it has 

a substantial or major market share. Brands that are less popular in the market may face problems such 

as diseconomies of scale in manufacturing and marketing processes, lesser shelf space in outlets, 

continuous pressure from distributors, etc. 
 

BASIS OF SEGMENTATION: DESCRIBING THE SEGMENTS 

The bases for segmentation are as follows: 

1) Geographic Segmentation→ This includes the segmentation of market based on location, size, 

population density, climate, etc. This type of segmentation enables the planning for better marketing. 

Rural and urban markets can be easily segmented by such segmentation. The geographic location is very 

helpful for marketers to design the marketing plan. 

For example, there are different regions in India like Assam, Bengal, Punjab, Gujarat and Tamil Nadu 

which prefer clothes and food-items based on their regional culture and food habits. Marketers must be 

very much conversant with regional languages. Also, places known for extreme climate conditions affect 
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the need as well as the buying behaviour. For example, in cold climate, there is permanent need for 

woollen garments and heating systems whereas for hot climate, air-conditioners are needed. 
 

2) Demographic Segmentation→ Another important basis commonly used for market segmentation is the 

demography, i.e. age, gender, income, education, religion, family size, social class, nationality, etc. This 

type of division of market is admired by most marketers. These are discussed below: 

a) Age and Life Cycle Stage→ Under this segmentation, the requirements of consumers are related to 

age group and this can be divided into four categories, i.e. children, young, adult and old. For 

example, Dabur produces oils especially for children. 

b) Gender and Sexual Orientation→ Males and females have different requirements and it is inherent 

in their nature. For example, females generally prefer to spend on expensive clothes, cosmetics, 

jewellery whereas males prefer to purchase cars, hot drinks, going to clubs, etc. 

c) Marital Status→ Lifestyle of married and unmarried individuals is totally different. A bachelor 

normally spends his earning on entertainment, hotels, whereas, a married person will generally spend 

on home furnishing, children education or purchase of house, etc. 

d) Income→ Buying behaviour of consumers is derived from their income. In our country, it varies 

from few thousands rupees to even millions. Therefore, individuals have different buying behaviour. 

e) Social Class→ As per the social status of a person, the buying patterns change. A business tycoon 

will prefer Mercedes, Audi, BMW cars, expensive cell phones, spacious and luxurious apartments or 

bungalow. A commoner will go for economy cars, common cell phones and a suitable 

accommodation for family. 

f) Family Size→ The purchase requirements vary with family size. The consumption-level are 

different for joint family and nuclear family. 

g) Occupation→ Occupation of an individual affects the buying behaviour to a great extent. For 

example, people related to glamorous film world have totally different orientation in buying 

behaviour in comparison to researchers and academicians. 

h) Educational Level→ People with same educational background and income have different 

preferences for certain products but it cannot be taken as a thumb rule. 

i) Religion→ Certain rituals, festivals, eatables, clothes, colours, etc. are related to religion. The 

market can also be segmented on such considerations. 
 

3) Psychographic Segmentation→ Psychographic segmentation of the market is not absolutely correct 

and it is generally found that persons of same age, financial status, educational background and 

occupation, adopt different procedures in purchasing the products, selecting a new product or choosing a 

shop. This is due to some psychographic factors which include personality, values, lifestyles, beliefs, etc. 

These are described below: 

a) Lifestyles→ Lifestyle of a person greatly affects his/her buying behaviour. The lifestyle is associated 

with the standard of living and the way in which money and time is spent by a person. This is also a 

result of social background, culture, religion, psychology and demography. It is an important factor 

in dividing the market and should not be ignored. For example, corporate icons prefer to buy costly 

suits and luxurious cars, whereas an executive goes for normal clothes and shoes. 

b) Personality→ Another variable in psychographic segmentation is personality. Different individuals 

have different personality which determines their buying behaviour. Marketers utilise this 

phenomenon to design products having brand personality. Thus they segment the market according 

to the personality of individuals. For example, Levi’s Jeans, Vimal Suiting’s, Tanishq Jewellery, 

Sabyasachi and Gaurang Shah for Sarees, Paris perfumes, etc., have personality statement which 

automatically attracts a particular segment of the society. 

c) Values→ Values are the belief systems of individuals, which affect their buying behaviour. These 

are also utilised for segmenting consumer market. This is the most appealing strategy to attract the 

customers because it touches their inner-self due to which selection of the product becomes easy. 

d) Beliefs→ Marketers know the fact that belief plays an important role in buying and hence they 

accordingly divide the market. People adopt certain characteristics from childhood which gradually 

becomes their firm conviction or belief that govern their buying behaviour. For example, it is a 

common observation that people exhibit buying behaviour and lifestyle as per their religion, 

irrespective of festivals or normal days. 
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4) Behavioural Segmentation→ It involves segmenting the market on the basis of understanding how 

customers use a particular product, how they respond towards a particular product, what they know 

about product or what their attitude towards a product is. The market segmentation is based upon the 

analysis of behavioural variables like occasions, benefits, user status, usage rate, loyalty and attitude of 

the consumers. The analysis of these variables helps in developing the market segments. These 

derivatives are described below: 

a) Occasions→ The marketers do recognise the occasions that are helpful in developing needs. The 

household items are regularly purchased by the salaried people on every first working day of the 

month. Festivals, family functions or celebrations for specific events develop needs for purchase. 

The companies can plan to enhance the supply of products based on these occasions. Two types of 

occasions are common: 

i. Regular: These include occasions like Republic Day, Holi, Diwali, Dushehra, Eid, Christmas, 

Independence Day, etc. 

ii. Special: These include marriage, anniversary or any happy occasion like winning an award, 

promotion, etc. 

b) Benefits→ The market is also segmented on the basis of benefits derived by the consumer. A 

consumer may purchase a watch as an essential need to know the exact time or to gift someone or 

use it as a status symbol, wear it to match with the dress or even wear it as a jewellery item. The 

marketers do recognize this fact and provide different brands of the product to take care of each 

segment separately. 

c) User Status→ The market can also be segmented qn the basis of user status. For example, the users 

for deodorant can be categorised as: 

i. Non-user: This category is not interested in using the given product. For example, children and 

aged people generally do not use deodorants. 

ii. Potential User: This category heavily relies on given product consumption. For example, 

deodorants are frequently used by fashionable teenagers and corporate executives. 

iii. First Time User: There are consumers who use a new product for the change. For example, 

deodorants used by college going students. 

iv. Regular User: There is a section in the society who leads a lifestyle which requires regular use 

of deodorants or other cosmetics like film stars, models, corporate big-wig and fashion conscious 

ladies. 

v. Ex-user: Some people give up using a particular product (like deodorants) because of allergy or 

medical advice. 

d) Quantity Consumed/Usage Rate→ The quantity consumed or the rate of consumption of a product 

is also an established basis for segmentation of market. This segmentation is commonly used in tea, 

coffee and soft drink markets. There are three categories: 

i. Light: The frequency of consumption of the consumer is not constant but occasional. For 

example, use of cosmetics by a housewife who is not so fashionable. 

ii. Medium: The frequency of consumption of product is frequent. It is observed that teenagers 

frequently use cosmetics. 

iii. Heavy: The consumption of product is regularly made in large quantity. For example, the 

celebrities working in the film industry, models, etc., use cosmetics regularly since it is a part of 

their profession. 

e) Buyer Readiness Stage→ There are different readiness stages of consumers regarding a product 

purchase. Some consumers may be unaware, others may not be interested, and some might be 

interested while some might be ready to buy the product definitely. The market is segmented as per 

the readiness of the consumers. 

f) Loyalty Status→ There are different levels of loyalty of consumers for specific brands as described 

below: 

i. Hard Core Loyals: Such consumers always buy the same brand of product, like newspaper, 

coffee, certain brand in clothes and sarees. They get hooked to these products due to their long 

experience and develop a sort of addiction and do not switch to other brands. 

ii. Soft Core Loyals: Such consumers limit themselves to two or three type of brands of the 

product. For example, a consumer using Sony, LG, Voltas products is a soft core loyal 
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consumer. Such consumers need to be motivated by marketers to stick to one brand so that they 

could be turned into hard core loyalist. 

iii. Split Loyals: Such consumers shift their loyalty for a change. For example, majority of 

customers prefer Colgate tooth paste but some also use Pepsodent or Close Up. 

iv. Switchers: Such consumers never stick to a brand rather they enjoy switching to new brands for 

experience and thrill. 

g) Attitude→ Attitude is the principal driver behind a product purchase. Some people lose interest in 

life due to some sad events, while some lead a very simple life as directed in scriptures. Such people 

do not indulge in fun or luxuries of life and behave differently. However, normal persons want to 

enjoy their life to the fullest and have fun. Keeping these things in mind, the customers are 

categorised as enthusiastic, positive, indifferent, negative and hostile. 
 

SEGMENTATION METHODS 

There are several methods for market segmentation. Some of these are described below: 

1) Factor Analysis 

2) Cluster Analysis 

3) Regression Analysis 

4) Choice Based Segmentation 
 

CLUSTER ANALYSIS 

The clustering technique has several applications in marketing research. This technique is used extensively 

by academicians as well as marketing professionals to cluster individuals or occasions which can be of use 

to them in the future. Clustering techniques are widely used as a classification tool. The typical application 

of clustering is in segmentation of customers but it also has other applications like evaluation of consumer 

shopping behaviour and preparing company’s brand architecture. 

The two main types of application of clustering techniques are: 

1) Psychographic Market Segmentation→ It is often seen that two persons having the same demographic 

traits may display completely different type of behaviour. People, who have similar types of education,  

skills, socio-economic status, income, etc., differ in terms of their attitudes towards issues like risk 

taking, purchasing new products, etc. This is because of psychographic variables like attitudes, 

motivations, perceptions and lifestyles. Many market research firms conduct researches based on 

psychographics to get a better perspective on various variables like consumer’s values, motivations, 

lifestyles and attitudes. 

Cluster analysis allows the analyst to cluster the data into groups that are formed in such a manner that 

differences between group and similarities within the group are maximum. In some sense, cluster 

analysis is similar to factor analysis as it does not classify variables as independent or dependent. It can 

therefore be used in psychographic segmentation. 

2) Lifestyle Market Segmentation→ The consumer buying behaviour can also be defined using the 

lifestyle segmentation. Lifestyle indicates the manner in which people spend their time and monetary 

resources. The understanding of this helps the marketers in predicting the behaviour of consumers. 

Lifestyle segmentation involves interplay of disciplines like sociology, culture, psychology and 

demography. The lifestyle method of market segmentation is very useful and popular with researchers. 

For example, Fastrack targets youth consumers who are trendy and fashion conscious. 

To develop such lifestyle segmentation, it is necessary to cluster customers into homogeneous groups on 

the basis of their attitudes, values and behaviour patterns in such a manner that people in the same 

cluster exhibit similar traits. This kind of segmentation is done on the basis of the responses that the 

researcher gets in response to lifestyle questions. 

The psychographic and lifestyle segmentation techniques are based on the extensive usage of AIO 

(Activities, Interests and Opinions) surveys. This leads to a very nice and effective description of the 

lifestyle pattern of consumers. 
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CRITERIA FOR EFFECTIVE SEGMENTATION 

Market segmentation is a complex decision and requires due care while selecting the criteria on which 

decisions are to be taken. It is very essential for products and services to be planned for a particular market. 

The product being launched should attract the market segment. It should have substantial size and growth 

potential alongwith the capacity to provide remarkable returns. The market segmentation criteria are 

discussed below: 

1) Measurable→ While establishing a market segment, the consumers of the product are counted along 

with their financial status and characteristics. The number of such consumers should be enough to be 

measured with ease. These calculations are obtained only after the marketing analysis and research work 

is done. 

2) Substantial→ The market segment must have customers of similar characteristics like age group, 

financial status, culture and should be aware about the different brands of the product. The size of the 

segment should be substantial so that suitable marketing strategy can be adapted which is convenient to 

all. The products should be supplied as per consumer preferences like quantity-wise, i.e., in small or big 

packs. 

3) Accessible→ The product and market segment should be compatible in price and financial status of the 

population. The location of the segment should have easy transportation facility for smooth flow of the 

product. The marketing strategy adopted for one consumer group is always different from other 

consumer group due to differences in their needs. For example, the fashion needs may vary on the basis 

of age groups therefore each group requires different products respectively. The effectiveness of 

marketing lies in catering to real needs of the customers belonging to different segments. 

4) Differentiable→ The marketing managers should clearly differentiate between the different segments 

since each segment requires different strategy for marketing. The consumers react differently to different 

products, and the advertisements are also designed in accordance with the consumers of different 

locations. Various marketing tools are used to take due care of nuances of local area to attract the 

customers. 

5) Actionable  A well defined market segmentation is always actionable on the part of the consumers, who 

are captivated by the products, services, advertisements and marketing strategies and as a result indulge 

in purchasing activity. The product placed at reasonable price coupled with marketing efforts is bound to 

bring favourable returns. 
 

MANAGING THE SEGMENTATION PROCESS: DERIVING MARKET SEGMENTS 

As per the universally accepted view, market segmentation process primarily includes three stages, which 

are as follows: 

 

 

 

 

 

 

 
 

Process of Market Segmentation 

1) Determining Demand Pattern/Survey Stage→ It is crucial to ascertain the demand patterns related to 

products and services as they signify the changing needs of customers as well as their consistent or non- 

varying tastes and preferences for a definite class of products and services. There are following three 

demand patterns which are usually encountered by a company:  

a) Homogeneous Preferences→ Homogeneous preferences can be understood as a marketplace where 

majority of the customers have similar tastes and preferences. 

b) Diffused Preferences→ It symbolises that consumers have a wide range of preferences which are 

altogether different from each other. The  first firm to enter the market will hold the central position 

in the market and can have the potential to attract most of the consumers. 

c) Clustered Preferences→ A particular market can be divided into different preference clusters. Such 

preference clusters can be termed as market segments. The first company or brand to enter the 

market has three alternatives, viz. to position itself in the centre position so as to engage most of the 

Determining Demand Pattern/ Survey Stage 

Establishing Possible Bases of Segmentation/ Analysis Stage 

Identifying Potential Market Segments/Profiling Stage 
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customers, to come up with different brands and position them at different market segments or to 

position itself in the largest market, i.e., concentrated marketing. 

In case the first company entering the market is engaged in developing a single brand in a particular 

segment, then the other entrants (competitors) would try to develop and launch their brands in the 

other market segments. 

Furthermore, the survey stage is categorised into following segments: 

a) In-depth interviews and focus group discussions with an intention to know or understand consumer 

behaviour, attitude, preferences and motivation. 

b) On the basis of the information gathered from the above mentioned activities, a questionnaire is 

developed which is dispensed or issued to a sample group of customers. The main purpose of this 

questionnaire is to gather data related to: 

i. Patterns in which customers make use of a product. 

ii. Attitude of customers towards a general product or the entire class of product. 

iii. The priority ratings of customers associated with different products and to know on what basis 

they prioritise a particular product. 

iv. Prevailing habits of customers, namely, their psychographic, demographic and media habits. 

v. Brand awareness among customers and ratings given by them to different brands. 
 

2) Establishing Possible Bases of Segmentation/ Analysis Stage→ The most significant activity of 

segmentation is to locate the variable(s) that are responsible for dividing the market into prospective 

segments. Generally, there are two kinds of segmentation variables, which are as follows: 

a) Needs 

b) Profilers 

Customer needs are the fundamental basis for any market segmentation. Market research is essentially 

required to discover the needs and wants of consumers in a market. Illustrative and computable 

consumer attributes like age, location, gender, income, nationality, etc., are known as profilers, which 

are useful in informing a segmentation exercise. For the purpose of identifying factors that can 

distinguish different customer groups, factor analysis is used. That is, once the data collection process is 

complete, it is reviewed with the help of factor analysis. However, for clustering customers into different 

groups, cluster analysis is used. 
 

3) Identifying Potential Market Segments/ Profiling Stage→ This stage involves profiling each cluster 

of customers on the basis of their behaviour, attitude, consumption pattern, alongwith their 

psychographics, demographics and media habits. Every segment can be named by the marketer either on 

the basis of dominants or unique characteristics. Customer segmentation helps the marketer to 

understand the potential customers of the firm from a demographic viewpoint. In order to understand the 

penetration rates and the market potential for different products and services, a perfect and explicit 

profile of consumers is required. 

It helps in analysing a particular market as well as gives an idea about the closely related markets. Such 

analysis enables the marketer to explore the market opportunities and implement the market penetration 

strategies. Highest market penetration can be achieved by identifying and understanding the customers in 

clusters which helps in target marketing. It also helps in planning business activities for the prospective 

buyers. Moreover, the ROI and response rates can be increased by specifically marketing to the potential 

customers with attractive offers. Profiling the customers becomes a necessity in the process of evaluating 

the entire market opportunities and the profits that can be generated from such markets. Further, it also 

helps in identifying the potential customers present in the selected market. It is possible only for few 

companies to make effective site selection decisions in the absence of appropriate information of 

customer profiles. 
 

FACTORS INFLUENCING MARKET SEGMENTATION 

Segmentation gets influenced by the following factors: 

1) Size, Resources, and Objectives of the Company→ Market segmentation of a company is greatly 

influenced by its size, the objectives according to which it works, and the resources available with it.. 

For example, a global automobile company considers many countries as its market and segments 

accordingly, whereas a local boutique caters to a city and does its segmentation on a local level.  

2) Type of Product and Market→ Product portfolio of a company also influences its process of 

segmentation. For example, a company of bakery products, cleaning materials, etc., can do the 
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segmentation easily; however, the process of segmentation will be complicated for the companies of 

apparels, financial services, etc. 

3) Competitive Structure of the Industry→ Process of segmentation for a company also depends on the 

competitive structure of the industry in which it is operating. Companies attempt to differentiate their 

products from that of competitors, if the competition in the industry is very high. This in turn creates the 

need for tight segmentation because in such competitive industries where numerous options are 

available, customers demand more and more features in a product. 

4) Nature of Market→ Decisions related to market segmentation depend on the nature of the market also. 

For example, company operating in a high competitive environment will have a different segmentation 

approach than one operating in a less competitive environment. 

5) Life Cycle Stage→ Product life cycle also influences the segmentation decision of a company. For 

example, the segmentation approach of a company would be different when its product is in growth 

stage. 

6) Competitive Strategy of Firm→ Segmentation decision of a company also depends on its competitive 

strategy. And the companies which strategically target their markets and segment its consumers are more 

likely to achieve success in a highly competitive industry. 
 

IMPORTANCE OF MARKET SEGMENTATION IN MARKETING 

The benefits of market segmentation are as follows: 

1) Adjustment of Product and Market Appeals→ Marketing is a complex activity but segmentation has 

slightly simplified it. This gives an opportunity to analyse each segment separately and make 

adjustments to attract maximum number of customers by suitable advertisements or other attractions.  

2) Better Position to Spot Marketing Opportunities→ Depending upon the sales volume of the product 

in different segments, the marketer can make alterations in distribution or advertisements. The inputs 

from market research can further help in modifying marketing strategies. 

3) Allocation of Marketing Budget→ Different segments generate different sales volumes. This helps to 

analyse and regulate the budget allocated to these segments. In case of markets with limited sales budget, 

the allocation of budget can be curtailed or diverted to other progressing segments. 

4) Understanding and Meeting the Needs of Consumers→ Since, every smaller market segment is 

concentrated, it gives marketer an opportunity to fully understand the needs, habits, tastes and 

expectations of the customers. This enables to make better decisions related to customers, which further 

improves the business opportunities. 

5) Stronger Positioning→ Positioning is all about establishing an image of the product in the minds of the 

consumers for satisfying their needs and improving the situation in the best possible manner. The four 

tools, i.e. price, place, product and promotion, when used in analytical way make the position of the 

product stronger. In a market, varieties of similar products are available offering similar benefits. A good 

positioning makes a product stand out from the rest. Thus, market segmentation gives the product a 

stronger positioning. 

6) Enhanced Efficiency→ The purpose of market segmentation is to make marketing more effective. The 

practice of locating customers in a segment and trying to attract them through advertisement (by sending 

messages), will have little or no effect and it will be a mere waste of money. Accurate segmenting 

enables the marketers to locate the most interested customers, and deliver them specific marketing 

messages to improve their buying behaviour. In this way, segmentation enhances the marketing 

efficiency. 

7) Competitive Advantages→ In the present competitive scenario, the company which can retain its 

customers is a winner. After understanding the customer segments, a common opinion can be made on 

what attracts a customer to a particular brand. An extensive market research is needed to study the 

buying behaviour of the customers and suggest an appropriate brand which suits their requirements and 

needs. The inputs from the market can be successfully used by the marketers for their competitive 

advantages. 

8) Targeted Media→ Segmentation divides the market into small groups comprising selected people. This 

enables the marketer to select suitable media for advertisement of a product. This can be done through 

hoardings, SMS on mobile phones or advertisements on local television channels, etc. 

9) Market Expansion→ Segmentation also helps in market expansion. For example, if a business is setup 

in a particular region and it is a success, then it can be extended to a nearby region without much hassle. 

Similarly, a demographic basis of segmentation may also be utilised for expanding one’s range of 
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products or adding new product lines. For example, Reebok provides t-shirts and other sportswear along 

with shoes. 

10) Better Communication→ The effective communication is possible only after understanding the target 

market. The customer is convinced up to the hilt about the product due to the identical products present 

in the market. Thus, segmentation results in better communication between customers and sellers. 

11) Increases Profitability→ Various aspects of business like brand equity, customer retention, brand 

recall, communications, competitiveness, etc., are influenced by effective segmentation strategies. The 

overall impact of segmentation finally leads to profitability of the business. As a result, the product 

becomes a USP for different businesses. 

12) Identifies New Markets→ Segmentation of market also brings in new market segments which have not 

been tapped due to some reasons. This can even be a small segment that needs a different product, which 

certainly opens a new business opportunity. 

13) Reduces Costs→ Market segment is a smaller portion of the market which can be operated 

economically. This may lead to reduction in transportation costs, advertisement costs, manpower, paper 

work and time. 

14) Reduces Credit Risks→ It is generally found that some individuals or companies do not make 

payments of the products purchased or even cause delay in making payments. Such customers should be 

avoided or offered products only when they make on-the-spot payment in cash. On the other hand, the 

customers with good payment records may be offered products on credit. These decisions are taken on 

the basis of market segmentation since it helps to manage the market, business and the consumers. 
 

TARGETING 
It is very expensive and inefficient for the marketers to satisfy the needs and requirements of every single 

individual in the population; therefore, they focus on a particular type of individuals or groups with specific 

needs and requirements which can be easily fulfilled by their product offerings. These individuals or groups 

are called target market of the marketer. 

Market segmentation helps the company to identify various opportunities. On the basis of these market 

segments the marketer can determine the specific markets to be targeted. Market targeting is a process of 

ascertaining groups of customers who are likely to purchase the products and services of the company. This 

is done in ways where some companies can cater to the entire market while others can focus on developing 

products and services for small niche markets which are profitable. Targeting is undertaken by companies of 

all sizes in order to retain and maintain their customers. 

Market targeting is not the same as target marketing. In market targeting, the product positioning is done 

beforehand and only decisions related to choosing of suitable target market has to be made. In target 

marketing, it is the other way around. The company first chooses a target market and then decides on what 

products and services it has to offer. 

Marketing is all about understanding the customers’ needs and wants, and developing the products that 

satisfy them. Both market segmentation and targeting is practised by all organisations, ranging from the 

small corner book store to large MNCs. A successful marketing plan can be developed by the company only 

when there is complete synchronisation between what the customer wants and what can be provided by the 

company. 
 

TYPES OF TARGETING: TARGETING STRATEGIES 

Once all the segments have been evaluated and analysed, the company has to decide the number of markets 

that it wants to serve. A target market consists of a group of customers who have homogeneous needs which 

the company chooses to fulfil. Alternative segments targeting strategies can be of two types: 

1) Limited coverage market targeting, and 

2) Full market coverage targeting. 
 
 

Limited Market Coverage Targeting 

When the company chooses to operate in one or a few market segments then it is called limited market 

coverage targeting. This strategy involves limited or fewer resources. It is thus, appropriate for a small 

company or new entrants who are trying to compete alongside large players in the industry. 

The different forms of limited market coverage targeting are: 
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1) Single-Segment Concentration→ The Company may choose to operate in a single segment. By 

adopting concentrated marketing strategy, a company is able to identify the needs and wants of a 

particular segment, which may help to attain large market share. The company can achieve economies of 

scale by focusing on its production, distribution and promotion activities. A high return on investment 

can also be achieved by market leadership. 

2) Selective Specialisation→ Under this type of targeting, firm operates in large number of segments, each 

of which is profitable and attractive. There may or may not be interaction between the various segments 

but they are all profit-making segments. Being operational in various segments helps the company to 

diversify their risk. 

3) Product Specialisation→ Here, the strategy of the company is product-based. The company decides to 

specialise in a product and then sell it to various market segments. For example, a manufacturer of 

generators, who sells the generators to hospitals, organisation, educational institutions, etc., provides 

generators of different size and capacity, as per the needs of the customer. The company specialises in 

this product and does not sell any other product to the customers. 

4) Market Specialisation→ In this strategy, the company focuses on a particular customer segment and 

tries to supply as many products as possible to this segment. For example, company supplying 

laboratory equipment like Bunsen burners, beakers, microscopes, etc., to universities and colleges labs 

may earn profit and reputation by specialising in this particular area. The only drawback related to this 

type of targeting is that sometimes the customer may cut-short its demand due to its limited budget. 
 

Full Market Coverage Targeting 

In this strategy, the firm chooses to satisfy all types of customers by providing different products. This is 

suitable for only large firms who can cover full market. For example, Mahindra and Mahindra in 

automobile market, Pepsi and Coke in beverages market and Hindustan Unilever in FMCG industry are 

practising full market coverage targeting. This can be done in three ways: 

 
1) Mass Marketing/Undifferentiated Marketing→ In this, the firm does not consider different market 

segments and offers homogenous products to the entire market. The seller only focuses on the 

fundamental needs of the customers than the variations in customer choices. The firm develops a product 

which captures a large number of customers using standard marketing mix strategies for product, price, 

place and promotion. The best example of this is Coke and Pepsi who use same pricing, advertising and 

packaging means throughout various consumer segments and geographic areas. 

The major benefit of undifferentiated marketing is that it earns economies of scale through mass 

production and marketing activities. Undifferentiated marketing can also be termed as mass marketing. 

Here, the company assumes the entire consumer market as a single market. It adopts a single marketing 

mix, i.e., a standardised product, uniform pricing, same promotional schemes and the same distribution 

channels to reach out to its consumers. 
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2) Differentiated Marketing→ In differentiated marketing, the firm produces and designs different 

product value propositions for different market segments. It therefore, caters to the individual needs and 

wants of customers belonging to a particular segment. For example, Maruti Suzuki serves various 

segments of customers by offering them variety of cars like level cars (800, Alto), Sedans (Esteem, 

SX4), Hatchbacks and Vans. Differentiated marketing is also called selective marketing or multi-

segment marketing. Unlike undifferentiated marketing, here, the firm markets different products to 

address different needs of customers in different segments. With this, the firm is able to find out 

consumer groups who are loyal towards its products. 

Then the firm mainly focuses on those customers and creates good relations with them. The parameters 

like age, income, gender, economic status, and occupation are considered which are commonly found in 

customer groups. For example, Indian railways have different product offerings for different customers 

like general coach, sleeper coach, AC coach, etc. In this, the socio-economic status of customers in each 

category is different. The price of each coach also varies accordingly. 
 

3) Concentrated Marketing→ This is the third market coverage strategy. This strategy is adopted by the 

companies having limited resources. The firm targets a large share of one or more sub-markets instead of 

a small share in a large market. An example of this strategy is recycled paper products, which is used for 

making greeting cards. This strategy is a combination of standardisation and differentiation and is also 

known as focus marketing. Here, the core strategy used is alike for all segments but differences occur in 

relation with the diverse requirements of the customers. This strategy also helps to recognise the 

customer groups who generate revenue and enable the firm to earn profits. In other words, the focused 

marketing tries to find a profitable niche of customers and develops products and services which are not 

being offered by their competitors. 

However, focussed marketing as a strategy is losing out to its significance to other forms of marketing 

since the companies want to cater as many customer segments as possible. A classic example is 

Mahindra’s Scorpio which has five or six variants to cater to different categories of customer needs. The 

basic version of the model has certain basic features but customers can opt for upgraded models having 

features like power steering, airbags, GPS services, etc., by paying more. In this way, the company can 

achieve economies of scale and large market share. All this depends on the type of strategy adopted by 

the marketer so as to achieve high market penetration. 
 

CRITERIA FOR SELECTION OF TARGET MARKET 

Five criteria for selecting a target market are explained below: 

1) Company’s Image and Experience→ The process of targeting a market segment should be in 

accordance with the overall corporate image of the organisation. Usually, a business organisation tries to 

have a consistent and integrated image for all of its business activities. Thus, a target market that does 

not have a consistent image is removed from any kind of consideration. 

2) Responsiveness→ Responsiveness refers to the reactions of the target market towards the marketing 

mix of a company, i.e., what the target market likes or ignores about the company. If various kinds of 

marketing stimuli such as price discounts, product specifications, sales promotions, etc., are not able to 

affect the prospective business customers, then these activities are a complete waste. 

Such non-responsiveness occurs when a company’s manager is totally against the use of new alternatives 

and is strongly devoted towards implying predefined methods. Similar situation can also take place when 

the prospective customer has a less scope to analyse the offerings of a marketer because there are 

numerous guidelines and rules to be followed or because of time and resource constraints. 

3) Substantial→ The size of a market segment needs to be considered not only in terms of the number of 

business customers but also the amount of products and services purchased by them over a certain period 

of time. There are segments that have long-term viability whereas some get saturated or matured 

quickly, which leads to limited or no selling opportunity or a very slow rate of growth. The market 

segments get affected by the changing buying behaviour of organisations and they may not remain 

attractive as before. Therefore, substantiality is the most crucial factor in the industrial segmentation 

because technological advancements can prove to be meaningless for a certain approach. 

4) Competitive→ Competitive advantage is one of the key elements of an effective segmentation. Though, 

a market segment is in accordance with the corporate image of the organisation and it looks quite viable 

and substantial, still a business organisation may not address the needs and wants of the customers of 

this segment. While selecting a segment, a business organisation must ensure the strengths needed to 
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maintain the competitive advantage over other players for a longer period of time in that particular 

market segment. 

5) Profitable→ Most of the marketing decisions are taken after evaluating their profitability. While 

selecting the target market, profitability and maintenance of profitability over time is considered as the 

most important aspect. In some market segments, there can be numerous buyers and they may purchase a 

huge quantity of products and services of the organisation but in order to acquire such customers, the 

organisation has to compromise on its profit margins. 

Apart from this, in order to maintain the competitive advantage in such segment, the company may have 

to incur huge cost on fulfilling the requirements of several activities such as, product development, 

distribution, promotion, etc., which may make the segment less profitable because of lower rate of 

return. 
 

IMPORTANCE OF TARGETING 

Targeting is not only significant, it is essential. The main advantages of targeting are explained below: 

1) With the help of targeting, the marketer can predict and analyse the features of products and services 

which are of utmost importance to the target customers. For example, a tailor can serve all those 

customers who want to get their clothes stitched. But different people may like different benefits and 

features which depend on their usages such as, clothes used for wedding dress, casuals, office wears, etc. 

2) A marketer can provide the right product to the targeted customers. A product manager who is targeting 

a certain market segment has a clear idea about the customer’s price affordability, age range, tastes and 

preferences, etc. On this basis, a manager can develop products that match the requirements of target 

customers in best possible way. 

For example, the manufacturer of laptops can produce a laptop for the customers at a price of □15,000. 

Because with the help of market feedback, a marketer may know that the students need laptops at low 

prices for the purpose of their studies. 

3) With the help of target market, a marketer can have a fair idea about the price which the targeted 

customers are willing to pay for a particular offering. Experienced marketers generally have a clear 

picture about the average income of their target customers as well as price sensitivity of their target 

market. For example, a high quality apparel company will focus on businessmen or customers with high 

incomes. 

4) A marketer can induce more sales on the amount spent on advertising activities with the help of target 

marketing. In simple words, target marketing will enable a marketer for not spending the financial 

resources on those advertising activities which are not directed towards their target customers. As a 

result, their advertising becomes more efficient as they do not spend on those customers who are not 

interested in the products or services of the firm. 

Target marketing helps the company to become more effective by approaching right customers with a 

right message which is appealing to them. The company can choose the best media for advertising to 

reach to the target customers. Most of the advertising firms provide vital demographic information about 

the audience which they reach to. For example, a business magazine is more popular among corporates 

and bureaucrats. 

5) With the help of target marketing, the organisations can also have information about the target 

customers’ location which in turn helps them in identifying more potential customers from those 

localities. The market segmentation maps can be used for viewing different income levels of customers 

residing in different areas. 

Such information is very important for the marketers to position their outlets in relevant areas. Apart 

from this, the changing tastes and preferences of customers also depend upon the geographical 

locations. With the help of target marketing, the organisation can also address these varying 

preferences effectively. 
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DIFFERENCE BETWEEN SEGMENTATION AND TARGETING 

Basis Segmentation Targeting 

Definition 

Segmentation of market can be defined as a 

process of dividing the market on the basis of 

customers having homogenous needs and 

wants. 

Market targeting is a process of identifying 

customer groups that are most probable to buy 

the products or services of a firm. 

Types 

Geography, demographics, behaviour and 

psychographics of the customers are the 

major basis of market segmentation. 

There are two bases of market targeting, 

namely, limited market coverage and full 

market coverage. 

Function 

Segmentation permits an organisation to 

customise the marketing communication for 

different segments of the market. 

Targeting allows the firm to effectively 

develop strategies for marketing 

communication for the target market. 

Benefit 
It allows companies to concentrate on the 

needs and wants of the potential customers. 

It helps the marketers in concentrating on 

particular segment of market for designing of a 

well-planned and cost effective marketing 

campaign. 

CONCEPT OF PRODUCT POSITIONING 

Positioning is a marketing approach which creates a distinct position for a brand or a product in the minds 

of the customers. It aims to provide a different and new product to the customers in comparison to the other 

competing brands or products. Here, the organisation decides the basis on which the product offers have to 

be placed in front of the consumers. David Ogilvy explains the importance of product positioning that, ‘the 

results of your campaign depends less on how we write your advertising than on how your product is 

positioned.’ 

According to Kotler, “Positioning is the act of designing the company’s offering and image to occupy a 

distinctive place in the target market’s mind”. 

According to Ries and Trout, “Positioning starts with a product a piece of merchandise, a service, a 

company, an institution, or even a person. But positioning is not what you do to a product. Positioning is 

what you do to the mind of the prospect. That is, you position the product in the mind of the prospect”. 
 

Tasks Involved in Positioning: Conducting a Positioning Study 

Positioning involves the fulfilment of many objectives. The marketer can generate a successful positioning 

strategy only if the various required tasks for positioning a product are done properly. These tasks are as 

follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1) Competitor’s Identification→ The company has to be very careful in the way in which it defines the 

competition. The definition of the competitor has to be broad. It need not only be limited to companies 

which are making the same type of products as the company. It should actually include all companies 

which are the likely competitors of the company. A company should analyse this keeping the customers 

in mind and the way they use the products. 

2) Determining How Competitors are Perceived and Evaluated→ After the definition of the competitor, 

the next task is to map the perception of the customers with regard to these competitors and products. 

Competitor’s Identification 

Determining how Competitors are Perceived & Evaluated 

Determining the Competitor’s Position 

Analysing Customer’s Preferences 

Making the Positioning Decision 

Monitoring the Position 
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One needs to understand the various features/ attributes that are considered important by the customers. 

These have to be analysed through marketing research techniques. The customers indicate their 

preference via focus groups and other survey method and this helps the company to understand their 

perceptions. 

3) Determining the Competitor’s Position→ Once the various attributes and their importance to 

customers is understood, the next step is to rate each competitor on these attributes. This helps us to 

understand how each competitor is positioned with respect to the attribute. This also helps to understand 

the relative positioning of the competitors, i.e., which competitors are similar and which are not so 

similar in terms of an attribute. 

4) Analysing Customer’s Preferences→ By the process of segmentation it is possible to classify the 

customers into various segments based on age, income, psychographics, education, etc. These various 

segments have different motivation to purchase and also have different ratings for the attributes that 

have been identified. 

Marketers generate the ideal preference for each segment, which is nothing but the ideal product or 

brand that the customers seek among all available alternatives, including those that are not available. 

Once the ideal product is recognised, it is very easy for the marketers to recognise the ideals for different 

segments. It also helps to identify segments which are similar in terms of ideal points. 
 

5) Making the Positioning Decision→ The next task involved in positioning is about making positioning 

decision. It is not easy for the marketers to take clear and accurate positioning decision. Even market 

research is not so helpful to determine the positioning. Therefore, some subjective decisions are taken by 

marketers by keeping in mind the following questions: 

i) Whether the segmentation is suitable or not? 

ii) Whether enough resources are available for communication or not? 

iii) What is the level of competition? 

iv) Whether the present positioning strategy is productive or not? 
 

6) Monitoring the Position→ Once the positioning strategy is generated, the company needs to check how 

successful the strategy is in the marketplace. These are typically noted through tracking studies. These 

studies check the change in the image of the company over a period of time. The perceptions of 

consumers are noted without any lag time. The competitive impact of the positioning strategy is also 

noted. 
 

POSITIONING STRATEGIES 

The creation of brand differentiation considering the value frame of the customers is the key role of 

positioning strategy. For this, positioning of a product can be done by using different strategies, such as: 

1) Attribute Positioning→ This strategy involves multiple product attributes or uses that the brand can 

offer to its customers, other than the competitors. For example, a movie theatre publicising that it offers 

the best movie experience is an attribute positioning. A fairness cream can be positioned by stating the 

attribute that it is made from herbal ingredients. 

2) Price/Quality Positioning→ This approach stresses the product’s place on the price/quality continuum 

by positioning it in the minds of consumers. This can be executed at both ends of the continuum (e.g., at 

the high end with Mercedes cars and at the low end with Tata Nano cars). 

3) Use or Application Positioning→ In this strategy, a product is positioned on the basis of its usage or 

applicability. For example, Kent RO purifier can be an example of application positioning. Here, the 

purifier is positioned by affirming that it has an inbuilt seven stages of water purification. 

4) Product User Positioning→ This type of product is associated with the specific category of user. For 

example, Lady Bird brand has positioned its bicycles as fashionable and sporty for young females only. 

5) Usage and Use Time Positioning→ This type of positioning is done on the basis of the product usage or 

its usage time. For example, Livon hair serum is positioned to be used after shampoo to detangle hair. 

6) Product Class Positioning→ Product class positioning involves association with a particular group of 

products, which are different from the conventional products. For example, positioning an exclusive 

limited edition of Ferrari watches as race day watches. Olay a skin care brand has a new product line of 

vitamins that are positioned as beauty supplements. 

7) Category Positioning→ In this type of strategy, the product is positioned other than its original category 

to which it belongs. This is advisable when the existing product category is overcrowded and brand 
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differentiation becomes difficult. For example, an herbal tea brand may position itself as a health brand 

instead of positioning itself in the beverage category. 

8) Benefit Positioning→ Usually, consumers’ purchase products for acquiring the benefits related to the 

product. With the help of this strategy, marketers may select an exclusive and not-yet-offered benefit to 

position the brand. For example, a tea brand (Red Label natural care) can help improve immunity of a 

person if consumed regularly. 

9) Price-Quality Positioning→ A brand may also position itself on the basis of price-quality continuum. 

At the bottom end, it means an ‘economy’ position (like wheel detergent, with both low quality, low 

price positions) and at the top-end, it means premium position (Ariel Matic, with both high quality and 

high price). 

10) Competitive Positioning→ Here, the positioning of a product is done in reference to the prevailing 

competition in the market. This product is set as a favourable substitute against the established brand. 

For example, the toothpaste brand Colgate Sensitive is launched as a competitor against the tooth paste 

brand Sensodyne in the market. 

11) Corporate Identity Positioning→ A brand attempts to make a direct connection with the corporate 

identity and tries to play on its key credentials. A corporate brand is used by products to label their 

offerings in the market. The offerings by Nestle, Cadburys and Kellogg’s, all disclose their corporate 

identity on their products. 

12) Brand Endorsement Positioning→ Unlike the previous method, here a successful brand acts as an 

endorser of a new product. For example, Cadbury uses its successful brand, Dairy Milk, to promote its 

other confectionaries. 
 

IMPORTANCE OF POSITIONING 

The importance of positioning is explained below: 

1) Placing the Product in Customers’ Mind→ Positioning and differentiation are the marketing activities 

which help the marketers to place the product in the minds of the target customers. The product fails to 

survive in market if the positioning decision goes wrong. 

And if the product is positioned wrongly then enormous time and effort is needed to retrieve the product. 

Despite the fact, repositioning of a product at a later stage is much easier than correcting a wrongly 

positioned product. 

2) Connects Product Offerings with Target Market→ The process of target market selection helps to 

determine the actual target audience for whom the offering is proposed, and the marketing mix assists in 

bringing the 4Ps in line with the intended target market. Therefore, market positioning acts as a linkage 

between the product and the target market. 

3) Product cannot be ‘Everything to Everyone’→ A product cannot be ‘everything to everyone’ but a 

little or more to some. This may define the need for differentiation and positioning of a product. For this, 

some distinctive features of the product or some unusual requirements of the market, or some visible 

gaps in the competitor’s products are identified and on the basis of these specifications the product is 

positioned for a specific target market. 

4) Creates a Locus in Customers’ Mind→ The customer’s mind may be viewed as geometric perceptual 

space which is occupied with diverse products and brands having specific positions. A new product can 

take hold of the space by replacing the existing brands from their position. A brand position in the 

customer’s mind can be achieved through several ways. Placing a brand against another existing brand 

or against certain expectations raised by the consumers may seek a position in customer’s mind. 

5) Providing Competitive Advantage→ Positioning of a product is the finest method for providing a 

competitive advantage to a product or service. This helps the marketer to determine the competitor’s 

potential moves and responses so that appropriate steps can be taken, such as: 

i) Providing the target markets the motive to buy the services and then plan the entire strategy. 

ii) Providing the guidelines to device the marketing mix, such that every element is aligned with the 

positioning. 

6) Better Serving and Covering the Market→ Here, the marketer identifies that every consumer or group 

of customers has different requirements and belongs to different market categories. In this approach, the 

main aim of marketer is to recognise the potential market segments, monitor the market in those 

segments and offer the customers’ with their desired needs and wants. 
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CUSTOMER VALUE: BASIC CUSTOMER VALUE 
The introduction of new philosophies is essential for the survival and success of companies. In the current 

scenario, companies have become customer-centric and give full attention to their potential customers. 

Hence, the company should be competent enough to build and retain its customers rather than just focussing 

on delivering of goods and services. 
 

Customer value refers to the maximum level of satisfaction delivered by offering the acquisition, ownership, 

and use of a product to the customer at the lowest possible cost. This is the only way by which companies 

can implement their marketing concepts. 
 

Therefore, it can be observed in the prevailing business environment that many companies are constantly 

increasing their customer value to attain customer satisfaction. Thus, it can be said that creating and 

providing high customer value is the core marketing principle. 
 

From the customer’s viewpoint, value can be defined as a trade-off between the prices paid versus the 

benefits received. In a specific value situation, when the product and the customer meet each other, the value 

is created. Hence, the value can be evaluated in terms of high satisfaction, low satisfaction or dissatisfaction. 

The services offered by the companies to the customers decide their long-term relationships. 
 

Undoubtedly, it can be observed that value is a wider concept rather than just being a fair price. The concept 

of value is a multi-dimensional approach as it measures the low cost, high quality and superior services of a 

particular target market. Other than this, the value proposition of the company can be defined as the 

combination of varying considerations on service, price, or quality along with the company’s image and 

intangible elements. 

                 Perceived Benefits 

Value =  ––––––––––––––––– 

                           Price 
 

From the above equation, it can be ascertained that when the perceived benefits exceed the price of the 

product, only then the customer notices the value of a product or service. 
 

A smart marketer knows that there are two ways by which the value of the company can be increased, i.e., 

firstly, by increasing perceived benefits and secondly, by lowering the price. However, it is suggested that 

the company should adopt the method of increasing benefits rather than indulging in price competition. 
 

CHARACTERISTICS OF CUSTOMER VALUE 

Following are the basic characteristics of customer value: 

1) Customer-Centric→ The values should be customer centric as the customers differ in terms of their 

type, their requirements and the benefits they are seeking out of a product. 

2) Intangibility→ Value is intangible in nature; therefore it can only be felt or experienced and cannot be 

seen. 

3) Contextual→ There are three main dimensions of context such as the final consumer, end-use 

conditions, and the environment. 

4) Multi-Dimensional→ Customer value is multi-dimensional, as it can possess numerous dimensions like 

price, promotion, quality, service, etc. 

5) Trade-Off→ Customer value is the equilibrium between the benefits received by the customers against 

the total costs paid by them. 

6) Relative→ It is the tendency of the customers to relate their value with the available value offerings in 

the market. 

7) Mindset→ All the actions and strategies of company must also focus towards its customers and not just 

towards its products. 
 

CLASSIFICATION OF CUSTOMER VALUE 

The concept of value is based on the total expected benefits over the cost of the product. The basic 

proposition in the classification of customer value includes: 

1) The choice of end-users partially depends upon the consumption values. 

2) A particular consumption value contributes differently in different situations. 

3) All the consumption values are independent in nature. 
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Customer values are classified into functional, social, emotional, epistemic and conditional values. These 

types of values frequently exist in acquisition of items like food, groceries, computer peripherals, games, etc. 

They are: 

1) Functional Value→ The functional value depends on the utility received by the customer from the 

functional, utilitarian or physical performance of the product. From the economic viewpoint, functional 

value is related to the economic utility theory. The main attributes of such a value includes price, 

durability and reliability of a product or choice. For example, when a person is purchasing a scooter, he 

has the purpose of travelling. 

2) Social Value: Here, the value of a product is determined by the benefits received by one or more 

consumer choices and social groups. The social value is attained when a consumer conveys a positive or 

negative feedback of a product to the reference groups, i.e., demographic, socio-economic and cultural-

ethnic groups. 

3) Emotional Value: An emotional value of a product is attained by a marketer only when he is able to 

stimulate the emotions and feelings of consumers. When a product relates with the feelings or triggers 

the emotions correctly then the emotional value is created because many times customers’ responds 

emotionally. 

4) Epistemic Value→ Epistemic value refers to the benefits that are perceived from the product’s ability to 

provide uniqueness, develop interest and gratify the desire for knowledge, of the customers. This value 

can be mainly delivered by making new purchases and consumption experiences. For example, if a 

customer changes his ice-cream flavour from vanilla to chocolate, then this shift also delivers epistemic 

value. As new products provide some uniqueness therefore, all marketers should make an effort to 

design new products. 

5) Conditional Value→ It is the perceived value of a product or service which is offered by the company 

to its customers based on a particular event or situation. Here, the utility derived by the customer differs 

according to the conditions. For example, some products have specific time or climate conditions like 

sunscreen lotions, raincoats, etc. Some products have once-in-a-lifetime events like buying of a first car. 

This type of customer value can be best offered when the product is related with the usage conditions, 

e.g., various automobile companies offer heavy discounts in the festive seasons to its customer with 0% 

interest on credit purchases. 
 

CUSTOMER PERCEIVED VALUE 

Customer perceived value is the value that the customer expects to get when he purchases a product or 

service. It can also be defined as the cumulative value of total perceived benefits that a customer gets minus 

the cost that he has to pay for it. If the net perceived value is higher than the cost then the customer becomes 

a loyal customer of the product or service and is likely to buy it again. The challenge for the marketers is to 

create a positive perceived value for the product. 
 

Perceived Value = Total Perceived Benefits - Total Perceived Costs 
 

Organisations can change the perceived value of customer in three ways - they can increase the perceived 

benefits, reduce the perceived cost or combine these two approaches. For example, by adding new value 

added features the perceived benefits can be increased. This can be done at the same price or a slight 

increase of price. The perceived cost can be reduced by bringing in various efficiencies or by reducing the 

product price. 
 

For example, when a car company increases the fuel efficiency of its product. This improves the mileage of 

the product. This lowers the customer perceived value by lowering the cost incurred in operating the 

product. Even if the other benefits remain the same, the customer benefits as the net perceived value 

increases. 
 

The loyalty of the customers can be increased by delivering superior perceived value to the customers. 

Although, it is a very difficult activity, this leads to repeat purchase by the customers. The organisation 

needs to have a complete understanding of how the customer behaves and what the organisation can do to 

fulfil his needs and wants. In the true sense, perceived value increases when the organisation consistently 

delivers value to the customer irrespective the medium of exchange or the channel. 
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MEASUREMENT OF CUSTOMER VALUE 

The idea to satisfy the customers is the entire concept of customer value. This can be measured by making 

an implied comparison between: 

1) The expected performance of the offering before its purchase or use, and 

2) The actual performance, i.e., perception regarding the offer after using it. 
 

After the comparison, there can be three possibilities: 

1) If the expectations of the customers exceed the perceived benefits and performance of products or 

services, then dissatisfaction is experienced. This means that the customer has not perceived good 

value.. 

2) If the perceived benefits or performance of products or services matches with the customer’s 

expectations, then satisfaction is experienced. Here, the customer receives what he has paid for, and 

3) When the perceived benefits or performance of products or services exceed the customer’s expectations, 

then the customers feel delighted. In such cases, customer is a hard-core loyal buyer of the product. 
 

Customer Value = Perceived Benefits - Perceived Sacrifices 
 

Where, ‘perceived benefits’ means the final product, associated services of product (e.g., delivery, after sale 

service, etc.), and customer relationship while, ‘perceived sacrifices’ are the factors such as cost, risk and 

time involved in purchase. 
 

CUSTOMER LIFETIME VALUE (CLV): USING CUSTOMER VALUE TO VALUE A BUSINESS 

Customer value is a very important factor which has a great impact on the buying process of the consumer. 

It is intangible in nature and comprises many psychometric factors like the brand recall and equity, the 

customer association in terms of loyalty, the customer referral, etc. The customer lifetime value is not built 

in a day; it takes time and efforts by the company to influence buyer decisions. CLV influences how 

consumers feel about a particular brand and the marketing efforts play an important part in augmenting the 

value. 
 

Customer Lifetime Value (CLV) is a significant component of Customer Relationship Management (CRM). 

Very few researches support the predictive modelling of CLV even though this metric is very popular 

among marketing research scholars. In a nutshell, CLV is the net profit that an organisation earns from its 

customer when all interactions are aggregated over the lifecycle of the customer. Various investments that 

the company makes are first analysed like - rate of retention of customers, cost per sale, conversion costs, 

etc., and then the company uses Customer Lifetime Value as a performance yardstick. 
 

CLV is thus the excess of revenues which are earned from an individual customer over the costs incurred in 

the form of promotions, advertising and also extending after sales service to the customer. It can also be 

considered the Net Present Value (NPV) of all future profits which are/will be generated by the individual 

customer purchases. 
 

Customer Lifetime Value can also be considered an indicator of the projected profitability of the firm. It can 

be considered the sum total of contribution generated over the lifetime of the customer. Contribution can be 

considered as the difference of revenues and costs. When marketers’ decisions are based on CLV, they give 

much importance to customer service and maximising the long-term satisfaction of the consumers instead of 

concentrating on short-term profits. 
 

Initially organisations did not pay much of an attention to Customer Lifecycle Value. This was because there 

was no statistical proof that there was a link between CLV and the profitability of the organisation. Then the 

focus was mainly on customer acquisition. However, this was not the right strategy as many customers 

purchased only once. Organisations need to look at how much profits individual customers will bring to the 

company from their future purchases. 
 

Customer Lifetime Value looks at measuring how valuable the customer is over the entire course of 

relationship with the firm. Hence the company can rank all of the customers in terms of contribution to the 

company’s profits once it has calculated their CLVs. It can thus know which set of customers are most 

profitable to the organisation. It can also look at devising strategies which are aimed at increasing the length 

of relationship and customer’s lifetime profits during the customer’s time with the company. In other words, 

CLV helps the company to devise a customised strategy for its customers. It can look at individual 

customers and select the most profitable ones. 
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MEASURING CUSTOMER LIFETIME VALUE 

CLV can be computed for a single customer or for the collective set of customers that an organisation has on 

an average. A simple template for calculating CLV is as follows: 
 

Estimated customer revenue per annum Rs. 10,000 

Estimated number of loyal years of the customer 30 

Total estimated revenue from the customer Rs. 3,00,000 

Profit margin the firm makes on the customer 20% 

CLV of the customer Rs. 60,000 

The three main elements of customer lifetime value are - the aggregate value over a period of time, the 

duration of relationship that the customer has and the various services that are offered to the customer by the 

firm. 
 

ESTIMATING CHANCE THAT CUSTOMER IS STILL ACTIVE 

The calculation of CLV includes determining the future contribution margin and future costs, both of which 

are adjusted for the time value of money. To calculate the future contribution from a customer in a non-

contractual setting, firms should first determine the probability of the customer being active with the firm at 

future time periods. In other words, the firms should calculate the P (Active) of customers at period n. 

According to V. Kumar, P (Active) is calculated as: 
 

P (Active) = (T/N)n 

Where, 

n is the number of purchases in the observation period, 

T is the time elapsed between acquisition and the most recent purchase and, 

N is the time elapsed between acquisition and the period for which P (Active) needs to be calculated.  
 

Another simple formula for finding the probability that the customer is active in time t is 

P (Active) = Tn 

Where, 

n is the number of purchases in a given period and 

T is the time of the last purchase (expressed as a fraction of the observation period). 
 

IMPORTANCE OF CUSTOMER LIFETIME VALUE 

CLV is important for organisations because of the following reasons: 

1) Calculating the CLV allows the firm to estimate the sum that can be invested to retain the customer so as 

to have positive rate of returns. With limited resources, every firm aims at maximising profits from its 

investment and thus retain those customers who will bring it the maximum profits in future. This is 

possible only if the firm is aware of the future benefits that will accrue from each customer so that every 

customer can be segregated in terms of contribution. 

2) The organisation can make the most effective use of the resources at its disposal once the CLV of the 

customers is known. The CLV approach is also very useful in selecting the organisation’s customers, 

deciding on the features of the product that are to be offered to customers and also finalising the 

communication/advertising strategies. Organisations can use CLV as a metric that achieves the most 

optimum allocation of the resources of the firm. It also creates a customer centric organisation. 
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UNIT-5: RETAILING & ADVERTISING ANALYSIS (8 HRS) 

 
Market Basket Analysis: Computing two way and three way lift, RFM Analysis, Allocating Retail Space 

and Sales Resources: Identifying the sales to marketing effort relationship & its modeling, optimizing sales 

effort. 

Advertising Analysis: Measuring the Effectiveness of Advertising, Optimizing advertising, Pay per Click 

(PPC) Online Advertising. 
 

MEANING OF RETAIL ANALYTICS 
Retail analytics is the process of providing analytical data on inventory levels, supply chain movement, 

consumer demand, sales, etc., that are crucial for making marketing, and procurement decisions. The 

analytics on demand and supply data can be used for maintaining procurement level and also for taking 

marketing decisions.  

Retail analytics is used to help make better choices, run businesses more efficiently, and deliver improved 

customer service analytics. 

Retail analytics software collects lot of data ranging from pricing information, stock levels, catalogue 

assortments, discounts, and much more. This information is stored and collected into large databases where 

it is processed using statistical algorithms to record and track trends and patterns. From this data, there is a 

huge breadth of intelligence that can be extracted, allowing marketers to make data-informed decisions on 

anything from creating on-the-fly pricing strategies, to accurately benchmarking seasonal discounts. This 

software helps to mitigate the risks of human assumptions that can trigger margin loss, overstock situations, 

and missing the boat on market trends.  
  

FEATURES IN A RETAIL ANALYTICS TOOL 

Retail analytics software allows to develop a deep understanding of historical trends, helping to facilitate the 

building of an accurate, fact-based case to provide insights into future trends and pricing movements. The 

following are six must-have features in a retail analytics tool: 

1) Active and Customised Competitor Monitoring→ It is essential to have control over the source of the 

data. As a fundamental base for intelligence, having the ability to control who and what the marketers 

are monitoring in the marketplace is of the utmost importance. Any data set must have a minimum of 

three sources to be measured, with five being the optimal number, and should comprise the competitors 

and other retailers that fit the product catalogue and style that the marketers are offering through online 

or offline store. 

2) Ability to Drill Down into the Data→ The most effective strategies in profitable departments stem 

from taking a holistic view of the market landscape while still being able to drill down to granular detail. 

Having the ability to track data at all market stages - from supply chain metrics and merchandising and 

catalogue assortment, through to retail pricing and discounting - enables all stakeholders to make critical 

decisions at exactly the right point in time. This can be the difference between being the biggest winner 

in a category or the biggest loser. Knowledge on where products are located and which are selling 

through (or not) allows the retailer to make informed decisions and act quickly. 

3) Trend Prediction→ The ability to identify trends in order to create a successful product catalogue 

offering while maintaining a well-balanced stock level and sizing range is challenging. With the right 

platform, reports can be produced that assess the rate at which certain “on-trend” catalogue items are 

selling through, allowing supply chain operators and merchandisers to select and identify an optimised 

and profitable product catalogue. The accumulation of historical data and analysis can help create a clear 

picture of what will be in demand in upcoming months. 

4) Action Triggers and Alerts→ These functions automate the process of dynamically setting pricing and 

product assortments across categories in real-time, helping to save time and effort, while also optimising 

pricing updates. Making the right decision based on predictive intelligence and retail analytics is all 

about being the first one to interpret and leverage a situation as it unfolds. Manually making time-

sensitive modifications to the assortment of products across multiple platforms can be next to impossible 

given the number of product items and outlets managed. 

5) Real-time Competitor Benchmarking→ Pricing agility in a post-recession, price-sensitive consumer 

landscape can be very challenging. In this day and age it is becoming easier for consumers to effectively 

price check and shop around for the best deals, both in store and online. Therefore, benchmarking the 
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pricing against competitors’ in real-time will enable marketers and their team to make swift and effective 

changes to pricing strategy. This removes the burden of lengthy, manual researching of competitors’ 

pricing, a process which oftentimes delays actions and ultimately renders repricing effort ineffective. 

6) Onsite (website) Recommendations and Cross-sell Suggestions→ As shoppers proceed through an 

online store, searching for and selecting items to purchase, the recommendation engine serves up items 

that might be of interest to them based on their browsing history and trends in the analytics platform. 

This may include products that the shoppers are viewing and/or placing in their shopping carts, slow-

selling product lines, and trending items. The engine can deploy various strategies including product-

bundling and discounting to maximise product up-selling and cross-selling effectiveness. 
 

IMPORTANCE OF RETAIL ANALYTICS 

Retail analytics is the process of providing valuable data on inventory levels, supply chain movement, 

consumer demand, sales, and much more that can be used for a variety of applications like maintaining 

procurement levels and making crucial marketing decisions. Importance of retail analytics is given below: 

1) Customer Behaviour Insights→ The first and foremost advantage of leveraging retail analytics is that 

they offer tangible and actionable insights into customer behaviour. Managing any aspect of a business 

becomes many times easier when one knows how to measure the return on investment. Retail analytics 

makes this possible. From studying the social responses to a product to gauging how a campaign 

improved the store’s conversion rates, retail analytics give a highly accurate picture to retailers of what 

works and what does not. 

2) Improving Marketing ROI→ As established, retail analytics help in measuring return on investment 

across various aspects of business management. Consequently, they can have a deep impact on 

enhancing the ROI from marketing endeavours. Since a store manager can measure the effect of in-store 

influences on purchase patterns, he can alter future campaigns accordingly. He can focus on effective 

campaigns and streamline marketing initiatives based on what clicks with its specific clientele. DSD 

Retail analytics also help in assessing the viability of customer loyalty programs, seasonal discounts, 

one-time offers etc. 

3) Optimising In-Store Operations→ In-store analytics offer a profound understanding of the consumer 

behaviour inside the store. Tracing their shopping patterns and dwelling times can unlock innumerable 

opportunities for all kinds of retail operations, from individual stores to sprawling shopping malls. 

Managers can better fathom the kind of layouts that catch eyeballs, the product placements that draw 

maximum attention and the service delivery quality that customers feel more pleased with. With these 

metrics at hand, retailers can analyse the best staffing options, the most appealing design techniques and 

the most effective selling tactics. 

4) Managing the Basics→ Retail analytics can play a vital role in elevating the efficiencies in everyday 

business management. Predictive analytics allow the seller to take swift actions for decision-making on 

stocking, tracking, and restocking SKUs regularly. By keeping a track of how often a particular product 

moves from the shelves to the shopping carts, sellers can chart the trends that are dominant in the current 

market. This information can also help them in identifying their most popular items and then focusing on 

these and similar products for increased sales. 

5) Enhancing Loyalty→ By giving meaningful insights into customer behaviour, retail analytics helps in 

bolstering the relationship between a store and its visitors. It allows the retailer to get the right 

information across to the right recipient and ensure a rewarding shopping experience for the buyer. By 

personalising marketing content, remembering purchase history and preferences, retailers are able to 

showcase the relevant products and offers to the most responsive audience and thereby enhance the 

propensity in them to buy. This also augments the brand resonance with the customers who feel more 

valued. Naturally, this increases the loyalty that they feel towards the store. 
 

MARKET BASKET ANALYSIS 
In simple words, the market basket is a list of some fixed items that are used to track the inflation and 

overall price movements of a specific market in an economy. In other words, it is a basket that contains a set 

of standard goods or services that people commonly buys. Market basket tracks the cost of living of various 

groups. 
 

A market basket contains some sample goods and services to know the inflation. The Government put some 

goods or services as a sample into an imaginary market basket and calculates the average cost of living. The 
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prices or cost of different periods is compared to know the inflation of an economy. In this technique, the 

inflation rate is the change in the cost of living of two baskets. 
 
 

A Market Basket Analysis: 

1) Is performed with transactional data. For example product items included in each invoice. 

2) Establishes the strength of association between pairs of products purchased together. 

3) Enables the businesses to identify patterns of co-occurrence (how likely that two or more events take 

place together). 

4) Produces rules in the form of if-then scenarios. These rules are probabilistic (How likely is an event to 

happen, not that it will always happen). 
 

MBA is one of the fundamental techniques used by large retailers to uncover the association between items. 

In other words, it allows retailers to identify the relationship between items which are more frequently 

bought together. Market basket analysis creates actionable insights for: 

1) Designing store layout 

2) Online recommendation engines 

3) Targeted marketing campaign/sales promotion/email campaign 

4) Cross/up selling 

5) Catalogue design 
 

OBJECTIVES OF MARKET BASKET ANALYSIS 

Market basket analysis can be used effectively to increase the overall spending from the customer by placing 

complimentary items close together or bundling such items at a discounted price. Following are the 

objectives of market basket analysis: 

1) Helps in Setting Prices→ Market basket analysis helps a retailer to identify which SKU’s are more 

preferred amongst certain customers. For example, milk powder and coffee are frequently bought 

together, so analysts assign a high probability of association compared to cookies. Without market 

basket analysis retailers would usually mark down on coffee on certain days, assuming coffee will be 

sold at certain times. However, market basket analysis can point out that whenever a customer buys 

milk, they end up purchasing coffee as well. So whenever the sale of milk and coffee is expected to rise, 

retailers can mark down the price of cookies to increase the sales volume. 

2) Arranging SKU Display→ A common display format adopted across the supermarket chains is the 

department system, where goods are categorized as per department and sorted. For example, groceries, 

dairy products, snacks, breakfast items, cosmetics, and body care products are properly classified and 

displayed in different sections. Market basket analysis helps identify items that have a close affinity to 

each other even if they fall into different categories. With the help of this knowledge, retailers can place 

the items with higher affinity close to each other to increase the sale. For instance, if chips are placed 

relatively close to a beer bottle, customers may almost always end up buying both. In contrast, if they 

were placed in two extremes, then the customer would just walk in the store buy beer and leave the store 

causing lost sales of chips. 

3) Customizing Promotions→ Marketers can study the purchase behavior of individual customers to 

estimate with relative certainty what items they are more likely to purchase next. Today, many online 

retailers use market basket analysis to analyse purchase behavior of each individual. Such retailers can 

estimate with certainty what items the individual may purchase at a specific time. For example, a 

customer fond of barbecues would likely purchase meat and barbecue sauce on some weekends. So 

retailers can customize offers to create a combo of 21bs of meat with one pack of. barbecue sauce at a 

discounted price every weekend to increase his purchase frequency. 

4) Identifying Sales Influencers→ All items in a retail store have some relationship with each other - be it 

strong or weak. In most cases, the sale of one item is driven by the increase or decrease in the sale of 

other items. Market basket analysis can be used to study the purchasing trend of a certain SKU. For 

example, two SKUs can exhibit a strong affinity for a period of time and suddenly decrease because of 

various factors ranging from an increase in the price of one SKU, new brand introduction, or 

unavailability of a certain brand in the SKU. For example, if Corona is the favourite beer among the 

consumers, and the brand is suddenly removed from the beer SKU, the sales of chips will go down as 

well, even though the sales of other beer brands are steady. These way marketers can understand the 

influence of such activities in the sales figure. 
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BENEFITS OF MARKET BASKET ANALYSIS 

The market basket analysis will help the retailers to better plan their store layout and make the necessary 

changes. This analysis helps marketer discover association rules between products. Following are some 

benefits arising out of this analysis are: 

1) Store Layout→ Based on the insights from market basket analysis one can organize your store to 

increase revenues. Items that go along with each other should be placed near each other to help 

consumers notice them. This will guide the way a store should be organized to shoot for best revenues. 

With the help of this data one can eliminate the guesswork while determining the optimal store layout. 

2) Marketing Messages→ Whether it is email, phone, social media or an offer by a direct salesman, 

market basket analysis can improve the efficiency of all of them. By using data from MBA one can 

suggest the next best product which a customer is likely to buy. Hence marketer will help his customers 

with fruitful suggestions instead of annoying them with marketing blasts. 

3) Maintain Inventory→ Based on the inputs from MBA one can also predict future purchases of 

customers over a period of time. Using initial sales data, one can predict which item would probably fall 

short and maintain stocks in optimal quality. This will help one improve the allocations of resources to 

different items of the inventory. 

4) Content Placement→ In case of e-commerce businesses, website content placement is very important. 

If goods are displayed in right order than it can help to boost the conversions. MBA can also be used by 

online publishers and bloggers to display content which consumer is most likely to read next. This will 

reduce bounce rate, improve engagement and result in better performance in search results 

5) Recommendation Engines→ Recommendation engines are already used by some popular companies 

like Netflix, Amazon, Facebook, etc. If marketer wants to create an effective recommendation system for 

his company then he will also need market basket analysis to efficiently maintain one. MBA can be 

considered as the basis for creating a recommendation engine 

6) Advertising and Promotion→ Modern retailers are using market basket analysis’for making 

advertising and promotions more predictable by understanding how consumers respond to various offers 

and communications. For example, this technique will help companies in the retail industry to know 

when and where a discount will have an impact on top-line sales and cut down on unnecessary 

reductions. It will give retailers a clearer picture of whether their promotional activities are merely 

shifting revenue around or if it is genuinely contributing to boosting the gross sales. 

7) Precise Targeting and Improved ROI→ By understanding what exactly their customers need, retailers 

can easily engage in specific targeting. Companies in the retail industry are using market basket analysis 

to optimize campaigns and promotions for with margins and sales uplift with more precise campaigns. 

This method will also yield good ROI as only the right customers who might be interested in the 

campaigns are targeted. 

8) More In-Store Traffic→ Retail companies can use market basket analysis to get a better understanding 

of what products and offers will drive more traffic to the stores. This can be done by correlating market 

basket analysis with foot traffic counts to understand what customers purchased when they were in the 

store. Once a retailer successfully identifies what initially bought the customers to the store, they can use 

market basket analysis to determine how to make their customers come back to the store next time. 

9) Optimised Store Layout→ Players in the retail industry can use market basket assessment to enhance 

their space planning and visual merchandising, consequently ensuring better efforts to cross-sell and 

upsell. For example, it will help retailers identify if end caps in the retail store are helping to drive more 

sales. In case they are, it can be analysed if they are also driving sales of complementary products. 
 

MARKET BASKET ANALYSIS AND LIFT 

Lift is the most commonly used tool in market basket analysis. The lift for a combination of purchase 

products and/or day of week is defined by this equation: (The actual number of times combination occurs) 

divided by (Predicted number of times combination occurs if items in combination were independent). 
 

Computing Two-way Lift 

On a given visit to a store, a consumer’s market basket is simply the list of products purchased by the 

customer. Market basket analysis is therefore concerned with extracting information from consumers’ 
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market baskets that can be used to increase a retailer’s profit. Most of the time, market basket analysis draws 

actionable insights after looking at the association between products bought during a given transaction. 

For example, for most supermarket customers there is a positive association between the purchases of 

cereal and bananas because a shopper who purchases cereal is more likely than a typical shopper to purchase 

bananas. 

Lift is probably the most commonly used tool in market basket analysis. The concept of lift enables the 

analyst to easily identify combinations of items (like handbags and makeup or cereal and bananas) that tend 

to be purchased together. The lift for a combination of purchase items and/or day of week is defined by 

Equation 1: 

(Actual number of times combination occurs) 

(Predicted number of times combination occurs if items in combination were independent) 
 

A two-way product lift therefore is simply a lift involving two products and can easily be computed in Excel. 

It can be generalized to situations involving the computation of lifts involving more than two items or other 

transaction attributes (such as day of week). 

To practice computing lift, you will use the superstore transaction data in the file marketbasket.xls. Below 

figure shows a subset of the data. The day of the week is denoted by 1 = Monday, 2 = Tuesday ... 7 = 

Sunday. For example, the first transaction represents a person who bought vegetables, meat, and milk on a 

Friday. 

 
For the superstore data, the lift for meat and vegetables would equal: 

(Actual number of transactions where meat and vegetables were purchased) 
(Total number of transactions) × (Fraction of times meat was purchased) × (Fraction of time vegetables were purchased) 

 

To be more specific, suppose that in 1,000 transactions, 300 involved a meat purchase, 400 involved a 

vegetable purchase, and 200 involved a purchase of meat and vegetables. Independence of meat and 

vegetable purchases implies that the likelihood of a transaction involving meat is 0.30 irrespective of a 

transaction involving a vegetable purchase. Thus independence implies that 1,000 (0.40) (0.30) = 120 

transactions should involve purchase of meat and vegetables. Because 200 transactions involved a purchase 

of meat and vegetables, knowing that a transaction involves meat makes it 1.67 times (200/120) more likely 

that a transaction involves vegetables. This is consistent with Equation 1, which tells you that the lift for 

vegetables and meat is: 

            200 

–––––––––––––––– = 1.67 

  1,000(0.40)(0.30) 
 

Product combinations with lifts much greater than 1 indicate items tend to be purchased together. This is 

valuable information for the retailer because placing products with large lifts near each other in a store 

display can increase sales based on the assumption that the sales of one product will stimulate sales of the 

other product. Because handbags and makeup have a large lift, this explains why Bloomingdale’s placed 

handbags and makeup together. 

Promoting cross-selling of products with high lifts can also stimulate profits. Therefore, in the 

Bloomingdale’s example, giving a customer who purchases at least $50 of makeup a coupon for 20 per cent 

off a handbag would likely yield increased profits. 
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Computing Three-Way Lift 

The other way to look at lift is as a ratio of three probabilities. To illustrate how the concept of lift applies to 

three or more attributes associated with a transaction, consider calculating the lift for the purchase of baby 

goods and DVDs on Thursday. This lift would be computed as follows: 
(Actual number of Thursday transactions where baby goods and DVDs were purchased) 

(Total number of transactions) × (Fraction of transactions with DVDs) × (Fraction of transactions with baby goods) × (Fraction of 

transactions with DVDs) 

One can use the same concept to compute for the superstore data the lift of an arbitrary combination of two 

products and a day of the week. See below figure and the Initial worksheet in the marketbasketoptimize.xls 

file. 

 
 

Complete the following steps: 

1) In cell Q14 use the array formula = Sum ( (INDIRECT (P13) = $P$14) × (INDIRECTCT (N13) = 1) × 

(INDIRECT (013) = 1) ) to compute the actual number of transactions involving vegetables and baby 

goods on Friday. This formula computes three arrays: 

a) An array containing a 1 if the day of the week matches the number in P14 (here a 5) and a 0 

otherwise. 

b) An array containing a 1 if the vegetables column contains a 1 and 0 otherwise. 

c) An array containing a 1 if the baby column contains a 1 and 0 otherwise. 

2) For each row of data the array formula in Q14 creates a new array. Create the new array element in any 

row by multiplying the three listed arrays. A 1 is obtained in a row of the product array if and only if 

baby goods and vegetables were bought on Friday. 

3) Sum up the entries in the product array to yield the actual number of Friday transactions where baby 

goods and vegetables were purchased. 

4) In cell R14 compute the predicted number of transactions involving baby goods and vegetables 

purchased on Friday with the following formula: 

IF(N13<>013, VLOOKUP(N13, K9:L14, 2, FALSE)*L7*VLOOKUP(013, K9:L14, 2, FALSE)* 

VLOOKUP(P14, K17:L23, 2), 0) 

5) If you enter the same product class twice, this formula yields a 0. Otherwise, multiply (total number of 

transactions) * (fraction of baby transactions) * (fraction of vegetable Transactions) * (fraction of Friday 

transactions). This gives a predicted number of Monday meat and vegetable transactions (assuming 

independence). 

6) Finally, in cell S14, compute the lift with the formula = IF(R14=0, 1, Q14/R14 ). 

The lift for vegetables and baby goods on Friday is 0.85. This means that on Fridays vegetables and baby 

goods are bought together less frequently than expected. 
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ALLOCATING RETAIL SPACE AND SALES RESOURCES 
The placement of merchandise within the store in the most profitable manner is called space management. It 

is one of the most important activities because the location of merchandise at different location, have 

different values. Some parts of store are more valuable because customers visit those more frequently, which 

results in higher sales. It is easier to make sales along. Space closest to the entrances and exits is the most 

valuable, and values decrease further into the store. 
 

Space management is the important part of designing and planning the layout of the store. Retailers assign 

more space for merchandise that registers a higher volume of sale. Under this principle of retail space 

allocation, it is always favourable for retailers to have large stocks of goods which experience high demand 

to avoid stock-out situation and inconvenience to the customers. Retailers have to decide about the sales data 

to be used for the allocation of space among merchandise. Three options available with retailers are 

historical sales data, market share, and projected sales. 
 

Retailers tend to use historical sales data as it is easy to access and provides market inputs in terms of the 

preferences of the target segment. Data related to the share of the product sale as a proportion of its total 

turnover is important for space allocation. This share data is preferred by retailers due to its ease of access 

and the high value placed on fast-moving products by most retailers. Projected sales are advantageous to 

retailers as they take into consideration historical sales data, which exhibits preferences of its target segment 

and also incorporates sales estimates for new and promising product categories. 
 

OBJECTIVES OF SPACE MANAGEMENT 

The management of retail space is concerned with a number of key objectives: 

1) To optimise both short-term and long-term returns on the investment cost of retail space. 

2) To provide a logical, convenient and inspiring interface between the product range and the customer. 

This can be particularly important in a large store, where customers can easily become overwhelmed and 

lost. 

3) To make sure that the right selection of products is available; that products fit into the retail space and 

that stock-outs are avoided. Choice for the customer is maximised when the best selection for them is put 

into the available space. 

4) To obtain a high return on investment by increasing the productivity of retail space, this requires 

effective utilisation of space for merchandise display and customer movement, and 

5) To ensure a compatible, exciting, and rational interface between the customer, merchandise, and 

salespeople. 

 

SPACE MIX 

For the retailer, space is money. The store has to be planned in such a way that it optimises the selling area 

and minimises the non-selling parts. The selling area is used to present the merchandise and the non-selling 

part is accounted for by circulation space, aisles, staircases, lifts, facilities, the back area, etc. The area mix 

in a typical department store is: selling area about 60%, circulation area 15% and back area 25%. 

The typical elements of space mix in a retail store may be defined as: 

1) Check-in Space→ Assigned for products which attract the customer attention as soon as the customer 

enters the store and makes the store attractive like beauty products and other cosmetics and jewellery 

sections. 

2) Red Carpet Space→ This is the space allocated in store which is in the centre of store. As the consumer 

moves inside the store the area on both the sides of the consumer is known as red carpet space. 

3) POP Display and Selling Space→ Assigned for interior displays, product demonstrations and sales 

transactions. 

4) Merchandising Space→ Allocated to items that are kept in inventory for selling. 

5) Customer/Circulation Space→ Assigned for the comfort and convenience of the customer, including a 

cafe or food court, dressing rooms, lounges and recreation areas for children. 

6) Personnel Space→ Assigned to store employees for lockers, lunch breaks and restrooms. 

7) Back Office/Storing Space→ Storing as the name suggests is the space where the inventory is being 

stores. It basically includes warehouses, godowns etc. 

8) Checkout Space→ Checkout space is generally allotted to the products which generate impulse buying 

on  the-part of consumer and also the space from where consumer is suppose take exit. 
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9) Dead Space→ Dead space is the space which cannot be utilised in the store due to some specific 

reasons. 
 

RETAIL SPACE MANAGEMENT STRATEGIES 

Space Management in a different dimension is the job of a Retailer. Retailers can view vendors as those who 

would obtain the space for rent. In this view, the Retailer needs to take space-related decisions very 

carefully. Some of the decisions that have an impact on marketing are: 

1) Space Configuration→ While the retail chain would be interested in a standardised and replicable space 

configuration of the stores to preserve its identity, the vendors would be interested in a special space 

provision for its products in order to enhance visibility. This means a compromise required on both 

sides. The introduction of concepts like “Shop-in-shop” is a step in that direction. Food World 

accommodating the growing importance of MTR as a major ready-to-eat products vendor in Bangalore 

and providing a corner for MTR in their Outlets is a good example of this kind. 

2) Shelf Position→ The way in which the outlet positions shelves in a store determines the effect of visual 

merchandising on consumers. Design interaction with the product category and shelf position has an 

impact on sales. Therefore, a clear understanding of the store shelf positions with the prospective 

vendors makes sense. 

3) Shelf Allocation→ There are varying pressures towards allocation of shelves. One of the key 

dimensions could be the margin from the product category or brand. Other important determinants are 

remuneration paid for a favourable shelf allocation in the case of a large retail outlet. In addition, 

introduction of a new category requires special shelf allocation. The vendor-retailer relationship helps in 

sorting out the multiple pressures on shelf allocation effectively. 

4) Special Store Needs→ This point is especially true in the case of a Heterogeneous Market like India as 

well as the absence of a standardised store concept. Special store needs in terms of highlighting product 

categories, makes the job of Space Management very difficult. Moreover, space itself may be a 

constraint in the case of locations like the central business district of metros. Here an appreciation of the 

space constraint by the vendor makes the job of Space Management much more effective. 
 

RETAIL SPACE PLANNING PROCESS 

A retailer goes through a number of stages when allocating space to products. These four stages will be as 

follows: 

1) Measuring Retail Space→ Although space in a store outlet is three dimensional, retail space is often 

measured in square, rather than cubic units. Square units are appropriate where, for example, in fashion 

retailing, a variety of single tier fixtures stand on the shop floor. Many fixtures, however, are multilevel 

and so more appropriate ways of measuring space to allocate might be on the basis of linear or cubic 

footage. 

Measurements of space that are more specific to individual retailers might be useful, such as the number 

of pages to be published in a catalogue or the total number of fixtures available in an outlet. 

Space productivity depends on two principal measures of retail success which are sales and profits. Sales 

volume and profitability can also be measured in relation to the amount of space used to generate those 

levels of sales and profits. This can then be compared with the level of financial investment in that space. 

The resulting measures express the productivity of retail space. Sales (or profits) per square meter is a 

commonly used measure of retail space productivity, which is an important concept in the evaluation of 

retail product management performance. 
 

2) Dividing the Space into Selling Areas→ At this stage, space management is concerned with allocating 

space to different product areas, defined according to individual retail businesses but usually on the basis 

of product department or category. The amount of space will be determined to a greater extent on 

previous performance indicators, typically sales values. However, some products, because of their 

physical characteristics may need disproportionate amounts of space in relation to sales. In a department 

store, home furnishings may need a relatively large amount of space to generate a good level of sales 

because the products are bulky, a large variety of merchandise is needed for customers to choose from 

and a lot of display space is needed to do the product justice. 

On the other hand, jewellery is a high value product category that needs relatively small amounts of 

space for display and selling purposes. The stage a product category is at in its lifecycle is likely to 

influence the space allocation at this level. If a category is growing, then more space should be allocated, 

whereas a declining category needs to have its space rationalised. 
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3) Determining the Layout→ At this stage product adjacencies will be decided, and the location of the 

selling areas will be determined. Individual outlet characteristics will influence this stage of the planning 

process; for example, location of entrances, set walkways around the store, lift and escalators, pillars and 

divisions all need to be taken into consideration in a store plan. In a catalogue the product categories that 

are going to go at the front of the book need to be decided. The relationships between one product 

category and another also have to be considered when determining the layout. 
 

4) Determining the Space Allocation of Product Lines→ This involves the allocation of space on 

individual fixtures to each product line or stock keeping unit. The availability and characteristics of 

fixtures, individual product performances, product features and characteristics and the compatibility of 

products will all have a bearing on these decisions. Many retailers use sophisticated computerised space 

allocation systems at this stage. 

 

IDENTIFYING THE SALES TO MARKETING EFFORT RELATIONSHIP 

Sales and marketing are both working towards the same goal: securing business and helping their company 

grow. Sales is a direct process in which the salesperson talks to the customer and steers them towards 

making a purchase. This might be in person, over the phone, or using a digital communication medium like 

email or even social media. The process might be very long, taking place over multiple conversations in 

which the salesperson learns about the customer and their pain points, and helps them understand how the 

product on offer can help solve them. It could also be a very short process consisting of a single 

conversation in which the salesperson lays out the terms of the deal and processes the sale. 

Marketing is a much more holistic process that is designed to increase awareness of a brand or product to the 

target consumer as a whole. Rarely will a marketer deal one-on-one with a customer. 

The methods, tactics, and channels used by the marketing department look very little like they did even 15 

years ago. It is primarily digital, including (but not limited to): 

1) Content marketing 

2) Social media marketing (SMM) 

3) Email marketing 

4) Organic traffic and search engine optimization (SEO) 

5) PPC ads 

6) Influencer marketing 
 

 

1) Collaborate on Sales Content Creation→ A recent CSO Insights study showed that 32% of a sales 

rep’s time was spent looking for or creating sales content. Creating content that sales teams can use in 

their proposals and throughout the selling process is a major factor in an outstanding sales enablement 

strategy. Both sales and marketing need to work together to understand their audience and create 

targeted content that speaks directly to customers. 

2) Inform Outbound Emails: In an ideal world, all sales would be inbound with customers lining up to get 

their hands on your product or service. But the reality is that, at some point, sales needs to be in charge 

of sourcing and contacting their own leads. To effectively do this, sales should work with marketing to 

be knowledgeable on what marketing materials are already readily available. Marketing and sales can 

also work together to create new, dynamic material that focuses on the winning strategies of each 

department. This creates a unified brand image and voice. 

3) Systemise Lead Scoring: Marketing and sales teams need to have an ongoing conversation about lead 

conversion — what is working, what is not, who it is working for, etc. Creating and converting MQLs to 

SQLs and, ultimately, to win deals is an always moving target — that is why it is important to ask these 

questions, to figure out why it is working or not working. Those changing results and targets of a 

company’s “why” increase the urgency for clear communication and getting on the same page. Both 

sales and marketing teams need to create one system for scoring and evaluating. The system is entirely 

conditional and depends entirely on the product, the audience, and the buying cycle. Turning an MQL 

into an SQL too soon can hurt conversion, so you need to find the sweet spot in the life cycle. This can 

only be found by trial and error, communication, and evolution. 

4) Develop Buyer Personas: Sales is the front line of any successful company. They know who is buying 

and why those customers are motivated to buy in the first place. Marketing understands the industry at 

large and who they should be targeting. The best buyer personas are born from a mixture of marketing 

research and insights from your actual customer base. The sales team can provide important insights and 
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generalizations on the leads they’re interacting with the most, while marketing research can inform 

broader insights like patterns and commonalities. Sales and marketing must direct their efforts at the 

same prospects and be completely aligned on decisions and pricing. Together, sales and marketing need 

to create comprehensive buyer personas to better target their ideal customer, increase acquisition, and 

create targeted ads and pitches that are symbiotic. 

5) Leverage Marketing to Showcase Sales Team’s Expertise: Ideally, sales teams are brilliant at lead 

generation and closing sales but are not always their own best advocates when it comes to selling 

themselves. That is why they need marketing team’s power to create materials that showcase their 

expertise. 

6) Hold Regular Meetings: Even the most amicable and aligned departments need actual face time to 

develop their internal relationships and sense of how the other works. Hold regular meetings to discuss 

new strategies, go over the results of current campaigns, and learn more about each team’s processes. An 

added benefit is getting marketing’s feedback and insight on the sales team’s agenda, and vice versa. 

7) Break Down Barriers: Aligning sales and marketing teams may require more than weekly meetings, 

and it might take a refresh in terminology and perspective. Break down departmental barriers and replace 

the concept of a sales funnel with a revenue cycle. Work through the foundation of what that revenue 

cycle should look like. This is the time when both sales and marketing get to flex their muscles and bring 

their expertise to the table. Remember, some areas will overlap, but they may be called different things. 

The marketing department may be focused on digital assets and ROI, while the sales team may be 

looking at the same assets regarding what types of sales leads they generate. Work together to determine 

the best lead generation techniques and ROI as a team instead of by department. 

8) Use Collaborative Analysis: When marketers are trying to align two departments, it is not enough to 

just focus on KPIs and collaborative practices. When they are breaking down departmental barriers, the 

lines will likely blur between what the marketing and sales teams are working on. It is important to 

analyze and measure the results as a team, which will help everyone get on the same page about ROI and 

understand how collaborative efforts are impacting your bottom line. The team ROI may require both 

departments to analyze email campaigns or lead generation data to determine what is working and what 

is not. Looking at these numbers individually just pushes your teams back into a silo situation where the 

work becomes fragmented. 

 

MODELLING THE MARKETING RESPONSE TO SALES FORCE EFFORT 

It is the job of marketing managers to determine the profit maximizing allocation for products, shelf space 

and at times the sales force as well. The key here is to understand how the changes in the allocation affect 

the product sales. To better understand this, the relationship between the resources allocated and the 

response achieved must be charted out on a graph. 

1) The Power Curve: y = axb→ Values of a and b that best fit the power curve can be found with Excel 

Trend Curve. Assuming 0< b<l, the power curve exhibits diminishing returns, i.e., each additional ad 

yields fewer extra sales. 
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2) ADBUDG Curve→ The ADBUDG Curve was developed by MIT Professor John Little. This curve is 

used to chart the graph of response to sales or advertising. The ADBUDG Curve can sometimes be S-

shaped, which means that for a small amount of marketing effort little sales response is observed, and for 

an intermediate amount of marketing effort, increasing returns are observed and finally beyond a certain 

point, decreasing returns to marketing response are generated. 

Suppose the marketers want to determine a curve that predicts the sales of a product as a function of the 

sales effort allocated to the product. Researchers have found that the response to a sales force effort can 

often be well described by the ADBUDG function of the following form. 

                   (b – a)xc 

Sales of drug i when x calls are made for drug i = a + –––––––– 

                                                                                 (d + xc) 

 
An S curve starts out flat, gets steep, and then again becomes flat. This would be the correct form of the 

sales as a function of effort relationship if effort needs to exceed some critical value to generate a 

favorable response. To illustrate how an ADBUDG response curve can be fit to a product, try and 

determine an ADBUDG curve that shows how unit sales of a drug depend on the number of sales calls 

made on behalf of the drug. 

 

3) The Gompertz Curve: y = a*exp (-c exp (-bx))→ Any change in profit resulting from allocation of 

additional shelf space is modelled by the Gompertz Curve. The Gompertz curve is also an S-shaped 

curve. 
 

OPTIMISING SALES EFFORT 

Optimising the sales team requires continuous monitoring to evaluate the systems, processes, people, and 

technology at disposal. However, the fundamental difference between high and low performing sales teams, 

according to an HBR survey of 786 sales professionals, is the sales process “50% of participants from high-

performing sales organisations said they had sales processes that were closely monitored, strictly enforced or 

automated.” Sales optimization is the discipline of maximising your sales team’s performance by analysing 

past interactions, guiding sales reps how to sell effectively, and managing future sales incentives. There are 

several ways by which sales effort can be optimised: 

1) Establish Long-Term Goals→ Every company wants to grow revenue year on year. But the only 

sustainable way to achieve this growth is by ignoring quick-wins and establishing long-term goals 

focused on quality. The best way to achieve long-term growth is by creating the right sales culture. So, 

rather than emphasizing short- term goals like hitting monthly quotas, celebrate long-term milestones 

like client anniversaries or upsells.  

For example, one of the core values at LinkedIn is to “act like an owner” which empowers employees to 

behave and make decisions as though it were their company. This change in mindset empowers 

individuals to look for sustainable revenue streams instead of immediate revenue and commission: 

a) Low-quality revenue creates short-term value 

b) High-quality revenue drives long-term value 

It is better to have predictable and profitable revenue streams to build long-term growth. 
 

2) Build an Ideal Customer Profile→ Building an ideal customer profile or buyer persona helps you 

focus on the right type of prospect. It’s better to create long-term strategic relationships with ideal 
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customers rather than chasing short-term quick wins elsewhere. Building your buyer persona takes you 

past demographics and deeper into buying behaviours and emotional characteristics such as: 

a) Likes/Dislikes 

b) Buying patterns 

c) Motivation to purchase services and products 

d) Feelings and emotions that will trigger them to buy 

e) Common objections (and how to handle them) 
 

3) Track and Analyse Sales Data→ If you are going to optimize your sales team, then you need an 

effective way to track and analyse sales data. Tracking sales leads gives your team access to metrics on 

what needs doing and what has already been done as part of the sales process. Team members can also 

compare how they are performing against peers, which promotes healthy competition. 

4) Spot Holes in the Pipeline→ Have you got issues in prospecting, nurturing, closing or upselling? It is 

important to check your sales pipeline regularly to ensure you do not have any holes. For example, if it 

takes 200 days to convert a prospect to a new customer and your conversion rate is 10%, then you should 

have at least 200 prospects in your pipeline. Without enough prospects, you would not hit your sales 

target. If you spot a hole - i.e., you do not have enough prospects - then you can take action to fix the 

problem. Depending on the size of your sales team, there are several tools you could use to monitor your 

pipeline. For smaller teams, you could use a spreadsheet to spot any holes as you record your sales data. 

5) Align Sales and Marketing Teams→ Although sales and marketing teams have similar goals to 

increase revenue and growth, they often struggle to work together effectively. According to a report 

from Marketo, sales reps ignore 50% of marketing leads. 

a) Sales reps puzzle why they have to generate their own leads. 

b) Marketing execs do not understand why sales ignore their leads. 

Who is right and who is wrong does not matter. But finding a way to work together is essential. Three 

ways to align sales and marketing teams are: 

a) Share Funnels: Create one funnel, so each team knows what the other is doing. 

b) Share Accountability: Create joint goals and objectives, so both teams are accountable for results 

and have to perform to a high level. 

c) Share Planning: Create strategic and operational plans together, and hold regular review meetings. 

By working together, marketing teams can provide the right type of content and qualified leads that 

enables sales teams to retain and win more customers. 
 

6) Strategically Assign Territories→ Many sales teams neglect to assign territories strategically and 

therefore miss a sales optimization opportunity. Sales territory management aligns salespeople with the 

most appropriate customer base - whether that is by geography, vertical, expertise, or past relationship. 

Each territory is unique. And in order to optimise sales, it is important to assign your top performing reps 

to the most valuable accounts in each territory. 

7) Nurture and Manage Leads Effectively→ Nurturing and managing leads is an essential step in the 

sales optimization process. Timing is crucial. Contact leads too soon, and you may lose them and their 

business forever. That is why building relationships is important. Investing time with the right prospects 

can lead to long-term customer relationships. And remember, long-term relationships not only generate 

more revenue but also enhance your credibility in the market. According to SBI, sales reps tend to give 

up on reaching a prospect after 3-4 unsuccessful attempts. But their research shows that on average 

prospects respond or decide to answer after 9x nurture impressions. 

8) Monitor and Provide Continuous Feedback→ If you want your sales process to be effective you need 

to identify, track, and measure the right data. Salespeople need to know what KPIs they’re working to, 

and you need to provide continuous feedback on their progress. 

a) Identify KPIs: Use metrics that improve sales performance rather than vanity metrics. HBR lists 12 

sales metrics that matter most. 

b) Collect Data: Use tools that make it easy for salespeople to input and update data. Or consider 

automating the process where possible. According to HubSpot: “Over 20% of sales professionals 

cited manual data entry as their top CRM challenge. Other issues included lack of integration with 

other tools and invalid or incorrect data.” 
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MEASURING EFFECTIVENESS OF ADVERTISEMENT 
Organisations allocate a major portion of the total budget on advertising now-a-days. In order to assess the 

worthiness of allocating a huge sum of funds towards advertising, advertisers wish to determine the 

usefulness of advertising. It is necessary to compare the functioning of advertising activities with the 

established objectives of the organisation to evaluate its effectiveness. This performance determination 

process is called ‘measuring advertising effectiveness’. 

Objectives related with advertising may include sales objectives and/or communication objectives. The 

evaluation process calculates how far the sales and communication objectives have been accomplished with 

the help of advertising. If it is unsuccessful in achieving the planned objectives, it will result in wastage of 

advertising funds. 
 

Rise in sales figures after advertising, indicates whether the advertising campaign has been successful or not. 

It can be concluded that advertising campaign has been effective if there is a sharp rise in the sales figures. 

The other way of evaluating advertising effectiveness can be by identifying as to what extent the 

advertisement has been successful in accomplishing communication goals. This method includes conducting 

an interview session with few customers to find out if they can remember the advertisement, slogan and the 

brand name stated in the ad, or if the message stated in the ad is interpreted correctly by them, etc. If the 

response is positive and they are able to remember the details, then ad is said to be quite successful. Thus, at 

this very step, the firm can locate the deficiencies and take remedial measures during the next advertising 

campaign. 
 

METHODS OF MEASURING ADVERTISING EFFECTIVENESS 

Several techniques can be used to evaluate the different constituents of an advertising campaign. The two 

most comprehensively used evaluation mechanisms are as follows: 

1) Message Evaluations→ Under this method, the advertisement copy (or the message) as well as the 

whole advertisement infrastructure (or the physical setup of the advertising) is examined to know the 

efficiency of the advertisement. It includes examining commercials, newspaper ads, billboards, coupons, 

etc. It also includes analysing the people involved in commercials (whether on TV or radio). Both the 

cognitive elements concerning an ad (like recall and recognition along with attitudinal and emotional 

responses) are considered while evaluating an advertisement message. 

2) Evaluating Respondent Behaviours→ This mechanism deals with evaluating the apparent customer 

responses to different advertising efforts. Customers’ responsive behaviour may include inquiries, store 

visits or actual buying of the product. The techniques used for evaluating respondent behaviours are 

based on numbers, like, determining total number of redeemed coupons, total number of calls made in a 

telemarketing plan and sales fluctuations in terms of numbers or values. Majority of advertising 

agencies, now-a-days, are asked to represent convincing evidence of the success of their ads and this 

evidence can be developed by analysing the respondent behaviour. Total number of coupons redeemed, 

number of customers visiting the stores, alteration in sales figures, etc., act as evidence for measuring 

advertising effectiveness. 
 

Thus, the above mentioned techniques are helpful for marketing managers to generate short-term results and 

achieve long-term favourable outcomes. 
 

TESTS FOR MEASURING ADVERTISING EFFECTIVENESS 

The advertising has wide range of testing techniques or the methods to choose for evaluation purpose. What 

methods or techniques he is going to use is dependent on when he is going to measure the ad effectiveness. 

Accordingly, there can be three sets of methods to meet his needs namely, pre-testing, concurrent testing and 

post-testing methods. 
 

1) PRE-TESTING OF AD→ It is preferred because it enables the advertiser to know how effective an ad 

is likely to be, before spending the budget and adopting ad actions. The advertiser should use only those 

messages and media which prove to be the strongest in producing the desired results. It includes 

following tests: 

a) Check-List Test→ A check-list is a list of good qualities to be possessed by an effective 

advertisement. A typical check- list provides rating scale or basis for ranking the ads in terms of the 

characteristics. These characteristics may be—honesty—attention getting—readability— 

reliability— convincing ability—selling ability and the like. The ad that gets highest score is 

considered as the best. 
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b) Opinion Test/Consumer Jury→ This involves a group of potential buyers of the product who 

compare and rank several advertisements according to their preference, interest or the influence to 

buy the product. Their reactions may be required either to the entire advertisement or about specific 

features of ads such as illustrations, headlines, themes, slogans, etc. Accordingly, the top ranking ad 

gets selected. 

c) Dummy Magazine and Port-Folio Test→ A group of ads, usually a mixture of ads to be tested and 

control ads are placed in a portfolio. The ads can also be placed in dummy copies of newspapers or 

magazines. Dummy magazines are used to pre-test the ads under conditions of approximation 

resembling normal exposure. The respondents are asked to go through the portfolio, reading 

whatever interests them and taking as much time as they want. After they finish looking at the whole 

portfolio, the respondents are asked to recall the ads that they can remember. Such recalls may be 

unaided or aided, depending on the objective of testing. The ad with highest recall score is taken as 

the best. 

d) Inquiry Tests→ Another method of pre-testing an advertisement is the inquiry test. An 

advertisement may carry a coupon or invitation to consumers to respond or reply or request for a 

sample. By making an offer to consumers, some advertisements get an immediate response from the 

consumers in the form of enquiries or sales which help in measuring the advertisement’s worth. 

e) Theatre Tests→ In theatre tests, attitudes towards a set of brands are measured. In the context of a 

TV show, respondents are presented a number of advertisements, including those to be tested. 

Respondents use electronic equipment to indicate what they like or dislike as they view TV 

commercials shown in a theatre setting. 

f) Laboratory Testing→ In this type of testing, pre-test measures can be taken using special 

laboratory equipments such as eye cameras, pupil metrics, brain waves, etc., which can be used to 

measure respondent’s physiological responses to advertising including galvanic skin response, eye 

movement, pupil dilation, brain pattern analysis, etc. 

g) Trailer Test→ Respondents are shown products and they see or listen to commercials in trailers at 

shopping centers and receive coupons for advertised products. Redemption rates indicate 

commercials’ influence on buying behaviour. 
 

2) CONCURRENT TESTING OF AD→ Concurrent or coincidental testing is that which takes place 

while the ads are running. The feedback is received from such testing and corrective actions can be taken 

while the ad campaign is on. It includes following ads. 

a) Co-Incidental Surveys→ This is called as coincidental telephone method also whereby a sample of 

households is selected, calls are made during the time programme broadcast, the respondents are 

asked whether their radio or television is on, and if so, to what station or programme it is tuned? The 

results of the survey are used to determine the share of response for the advertisement. 

b) Consumer Diaries→ This method involves giving the families a diary or individual diaries to the 

members of the family. The selected families and individual respondents are asked to record the 

details about the programme they listen or view. The diaries are collected periodically to determine 

the scores. 

c) Mechanical Devices→ The mechanical devices used to measure the ad effectiveness concurrently 

are more common to broadcast media. These are—Audio meters— Psychogalvanometer—

Tachistoscope and Truck Electronic Unit. 

d) Traffic Counts→ Traffic counts are of special applicability to outdoor advertising. One can get 

good deal of information through traffic counts. This counting is done by independent 

organizations— may be private or public. This work is also undertaken by advertising agencies. For 

instance, how many automobiles and other vehicles were exposed to a bulletin board or a poster or a 

wall painting and how many times? These all can be determined. 
 

3) POST-TESTING OF AD→ It is applied after the ad has ended to find out how far advertising has been 

successful. It includes following tests: 

a) Inquiry Test→ It is controlled experiment conducted in the field. In inquiry test, the number of 

consumer inquiries produced by an advertising copy is considered as to the measure of its 

communication effectiveness. Therefore, the number of inquiries is the test of effectiveness which 

can be produced only when the ad copy succeeds in attracting and retaining reader or viewer 

attention. 
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b) Split-Run Test→ A split-run test is a technique that makes possible testing of two or more ads in the 

same position, publication, issued with a guarantee of each ad reaching a comparable groups of 

readers. Different copies of ads are created and placed into one magazine or newspaper. It is an 

improvement over the inquiry test in that the ad copy is split into elements like appeal—layout—

headline and so on. Here also, the readers are encouraged to reply the inquiries to the given address. 

c) Recognition Test→ Recognition is a matter of identifying something as having seen or heard before. 

It is based on the memory of the respondent. In such tests, readers are shown magazines or 

newspapers page-by-page with which they are familiar and they are asked to point out the 

advertisements they saw and read. It attempts to measure the ad effectiveness by determining the 

number of respondents who have read or seen the ads before. The recognition method helps to 

measure the interest shown by the respondents though one has to make sure that the respondent does 

not confuse specific advertisement with similar or identical ones seen elsewhere. 

d) Day-After Recall Test→ Recalling is more demanding than recognizing as a test of memory. Day-

after recall test is the most widely used method to test television commercials. It involves 

respondents to answer as to what they have read, seen or heard without allowing them to look at or 

listen to the ad while they are answering. After an on-air exposure of a finished commercial in a city, 

viewers are interviewed to determine if they can recall the message. Recall may be unaided or aided. 

e) Sales Test→ The effect of TV commercials can be measured through the use of consumer panels 

located in a number of cities. These consumer panels are being used to understand their purchase 

behaviour as well as usage behaviour. Marketers can also use different media in different locations to 

see which one is more effective in generating sales. Alternatively, sales changes in different markets 

can be monitored to compare the effects of different messages. 

In practice, no single technique may be found suitable to test all ads. Depending on the specific objectives of 

the advertisement campaign, often a combination of different techniques may have to be used to get 

effective results. 
  

IMPORTANCE OF MEASURING ADVERTISING EFFECTIVENESS 

Measuring advertising effectiveness is important for the given below reasons: 

1) Justifying the Cost of Advertising→ Advertising involves a lot of cost. The amount spent on 

advertising can be justified by measuring advertising effectiveness. In this regard, the cost-benefit 

analysis is adopted whereby comparison is made between the advertising benefits and the cost incurred 

on advertising. The expenses incurred can be justified to the higher organisational executives and 

authorities, if advertising benefits exceed the cost. By doing so, it is made sure that the expenses incurred 

on advertising do not go to waste. Furthermore, the justification also helps in increasing the advertising 

expenditure (if required) in the future. 

2) Exercising Control on Advertising Campaign→ Control over the ad campaign can be exercised 

through advertising effectiveness evaluation. It helps in knowing whether or not the outcomes of the ad 

campaign are in compliance with the predetermined objectives of the ad. Corrective actions and remedial 

measures can be taken in time if the outcomes of the ad campaign are not in compliance with the 

predetermined objectives of the ad. 

3) Evaluating Ad-Copy→ The advertising copy as well as the message in the ad copy can be assessed by 

measuring the effectiveness of advertising. The desired outcomes cannot be expected from the 

advertisement if the appeal made in the advertisement and the brand name is not understood by the target 

audience. Therefore the drawbacks in advertising copy, viz., drawbacks in the appeal made, content of 

the message, etc., can be identified by measuring the effectiveness of the ad. This will also help in 

designing more effective ads in the future. 

4) Comparing Different Market Areas→ Comparison can be made among different geographical market 

areas to know which market area is comparatively fruitful for the firm. A firm operates in various market 

areas and its ads also are also carried in those areas. Evaluations of the results of all the market areas are 

performed after some time period. This is done from the perspective of the level of change in the display 

of the dealer, level of change in the customers’ attitude regarding the firm’s product, level of change in 

sales, etc. By doing so, the strong and the weak market areas can be determined which would help the 

firm in designing appropriate and proper marketing strategies for its weak and strong market areas. 

5) For Effective Media Planning and Media Scheduling in Future→ The impact of various media can 

be known by proper evaluation of the effectiveness of advertising. This will help in making improved 

decisions related to media scheduling and media selection, such as choosing appropriate media vehicle, 
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purchasing appropriate time and space in the media, timing of the ad, its frequency, suitable TV 

programs and channels to broadcast the ad, and so on. 

6) Knowing the Saturation Point of Advertising→ The saturation point of advertising is the point past 

which negligible or zero sales response is generated through advertising. Before this point, the 

advertising should be stopped. The saturation point of advertising can be known by evaluating the 

effectiveness of the ad. This is achieved by making a comparison between the advertising’s marginal 

cost and its generated revenue. When the marginal revenue becomes at par or less than the marginal cost 

of advertising, then further expenditure on advertising should be stopped. 

7) Reducing Wastage in Advertising Expenses→ Ads which are ineffective in getting the message across 

and in increasing the sales of the organisation can be identified through a proper evaluation of 

advertising effectiveness. Spending on wasteful advertising is reduced by discontinuing such 

advertisements. 

8) Keeping in Touch with New Trends in Advertising→ The firm can keep in touch with the current and 

the emerging trends in the field of advertising through the evaluation of advertising effectiveness. The 

field of advertising is dynamic. It is not necessary that an advertisement will be effective tomorrow if it 

is effective today. The tastes, preferences and attitudes of people change. Therefore, the latest trends in 

the field of advertising and people’s preferences towards advertisements can be known by evaluation of 

advertising effectiveness. 
 

DIFFICULTIES IN MEASURING ADVERTISING EFFECTIVENESS 

Following are the major difficulties which are faced while measuring advertising effectiveness: 

1) Advertising is not the only Factor Affecting Sales→ It is assumed under most of the ad effectiveness 

evaluation methods that sales are affected only through advertisements. However, an increase in sales 

can be the result of several other factors like, price change, schemes for sales promotion, improvement in 

the features of the product, etc. Therefore, it would be wrong to assume that advertising is the only factor 

affecting sales. 

2) Effect of Past Advertisement→ It is also assumed under most of the ad effectiveness evaluation 

methods that advertisement conducted in the test period is the reason behind the customers’ response in 

the test area. However, past or previous advertisement can also be the reason for the response of the 

customers. For example, there is a possibility that an individual had seen an ad a long time back but did 

not purchase the product at that time due to lack of financial resources or due to absence of need. 

However, there is also a possibility that the individual is still carrying a very positive impression of the 

past ad. The individual can buy the product at present time if he/she has the need and the adequate 

financial resources. Therefore, here it can be said that the past ad is responsible for the sale of product in 

the present. 

3) Difficult to Evaluate the Effectiveness of Goodwill Advertisement→ Improving the organisation’s 

image in the long run, by fulfilling certain social responsibilities like generating awareness regarding 

environment and pollution control, etc., is the purpose behind goodwill advertisements. The advertiser 

cannot measure the impact of such ads on the goodwill, image or sales of the organisation. 

4) Ad-effectiveness using a Communication Objective is not sufficient in itself→ Certain product 

advertisements might not increase sales but may attain the communication objectives. Similarly, certain 

ads of products might be entertaining and attractive but not effective enough to increase sales. It is 

possible that such ads grab the attention and are easy to recall because of catchy jingles, punch-lines and 

visuals, but the products are still not purchased. This might be because those products are not liked by 

the viewers. For example, many viewers might be remembering the very attractive ad of Royal Stag with 

Ranveer Singh. But the Royal Stag products are still not purchased by those viewers. Therefore, it is not 

sufficient to evaluate advertising effectiveness on the basis of objectives of communication only. 

5) Subjective Method for Measuring Advertising Effectiveness→ Several ad effectiveness measurement 

methods have been proposed by experts. However, these methods do not provide standard criteria for the 

evaluation of advertising effectiveness. Therefore, they are highly subjective. Several criteria are 

available such as sales increase, ability to grab attention, entertaining, convincing, humorous, 

memorable, etc. There is a possibility that an ad is effective as per one criterion and ineffective as per 

another. 

6) Not Suggestive in Nature→ The advertisements are classified as either effective or ineffective by most 

of the ad effectiveness measurement methods. However, they are not suggestive, i.e., they do not 

recommend or suggest ways to increase the effectiveness of the ads. 
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7) Difficult to Evaluate Percentage Response→ Certain degree of customer response is required for 

measuring the effectiveness of the ads. However, the advertiser cannot measure the response generated 

due to the advertisements because the overall number of media readers or viewers is unknown. This 

number is known if direct mail advertising is adopted but not exactly known if the message if spread 

through mass media vehicles like, newspapers, magazines, television, radio, etc. 

 

OPTIMISING ADVERTISING 
In a world shaped by digital, customer interactions define a brand’s success. For marketers, this can be a 

significant challenge. While digital advertising is growing rapidly, it is struggling with wasted spends, 

leaked revenues, and ineffective targeting and tracking of the operators (advertisers and publishers) in the 

ecosystem. Studies indicate that the total wastes in the advertising ecosystem ranges from 2% to 4% of the 

overall campaign spend. 

Advertisers and publishers can ensure better ROI for their campaigns by analysing spend allocations at each 

step of the advertising campaign cycle to curb revenue leakage. Marketers can drive deeper customer 

engagement through relevant customer insights. To supercharge that cycle, they need a campaign strategy 

built on a strong enterprise marketing technology platform - one that accelerates innovation with analytics. 

This will help track marketing campaigns and regulate how they perform at each step with respect to dips 

and raises in sales. 

 

ONLINE/INTERNET ADVERTISING 
Online advertising is any type of marketing message that shows up with the help of the Internet. That means 

it could appear in a web browser, search engine, on social media, on mobile devices, and even in email. 

Savvy advertisers are increasingly making use of this forum for reaching consumers, for a number of 

reasons: 

1) It is relatively inexpensive, 

2) It reaches a wide audience, 

3) It can be tracked to measure success (or failure), and 

4) It can be personalised for a target audience. 

There are different types of online advertising: banner advertising, video advertising (either placed before or 

embedded within a video), search engine advertising and social network advertising. These different 

manifestations are a consequence of the fast-paced development of the Internet and Internet technologies. 

The age of the Internet has taken the world by storm in the last decade and has changed the way consumers 

behave and buy products. With this charge has come a new type of consumer that is more educated and able 

to do vast amounts of research before making a purchasing decision. It has also brought about a consumer 

that spends a lot of time online, whether it is for personal or professional reasons. This gives marketers new 

opportunities to interact with their customer base and reach out to different audiences. 

This is where online or digital advertising is able to aid businesses in reaching more of their target audience 

in less time. The world of digital advertising, although relatively new, is still rooted deep in the fabric of 

traditional advertising. This means that companies are able to add a digital form of advertising to existing or 

upcoming campaigns that have always relied on traditional mediums. Tying the offline and online strategies 

together sets the company up for success in its next advertising campaign and will do well in reaching the 

specific audience. Digital advertising refers to marketing media that is digitally displayed. Digital 

advertising technology exists on the Internet, on smart -phone and hand-held media devices, and even on 

automobiles and billboards. Businesses and product manufacturers use digital advertising to build or 

maintain a brand image and market products and services to consumers. 
 

COMPONENTS OF ONLINE ADVERTISING 

There are a variety of different components that combine to create internet marketing campaigns. Some of 

the key components are: 

1) Websites→ The first step in an internet marketing campaign is to create and set-up a website. A website 

will include a lot of text, some images, and perhaps even audio and video elements. This gives visitors a 

clear picture of the message that one may send about the company. It will show potential customers, the 

features and the benefits of the products or services that the company is offering. Some websites include 

lead capture for customers or even sell their product or service directly through the website. These 



                                                                            

                                                                                 100 

websites are essentially the same as brochures or mail order catalogues. They are a wonderful way to 

start establishing the business and getting noticed. 

2) Search Engine Marketing→ Search engine marketing is another component of internet marketing. This 

means that a website is marketed through search engines by improving the ranking of the site through 

search engine optimisation, pay per click advertising, or pay for inclusion listings in directories. This is 

similar to offline advertising that is done through listings in the yellow pages. 

3) E-Mail Marketing→ The next component is e-mail marketing. This distributes information about the 

products or services or is used to get feedback from customers about products or services through e-mail. 

Customers and prospective customers can supply their e-mail addresses or one can choose to purchase 

email addresses through lists. There are various e-mail methods that are used including newsletter 

distribution or mass mailings or even offering the customers special things related to the company’s 

products or services that are being offered. This is basically the same as direct mail advertising that is 

done offline. 

4) Banner Advertising→ Banner advertising allows for placement of advertisements on a website for a 

price. There are many providers that are offering banner advertisements on their sites. It can be a very 

effective part of internet marketing campaign and can increase the traffic. Newspaper and magazine ads 

would be the offline comparison to banner advertisements. 

5) Press Releases on Internet→ Press releases on the internet require a story being written about a 

company, products, services, or website. These stories or articles must be newsworthy and very attention 

getting. There are many sites on the internet that are centered on press releases. 

6) Blog Marketing→ The next component is blog marketing. This is where comments are posted, opinions 

are shared, or announcements are made. This can be done through hosting a blog or by adding comments 

and URLs in blogs that are related to the business and the offers available online. 

7) Article Marketing→ The last component of internet marketing is article marketing. This means that one 

can write articles that are centred on the business and then publish them on different internet sites that 

relate to articles. Articles are normally passed around the internet and shared with others. Article 

marketing can give one a huge boost to the business and to website traffic. This helps to target much 

more audience, because the articles are specific to what company is offering. 
 

PURPOSE OF ONLINE ADVERTISING 

The purpose of internet advertising is as follows: 

1) Solicitation→ A common perception of advertising is related to solicitation, or encouraging consumers 

to purchase the goods and services of a company or organization. Advertising can be found in the form 

of print advertisements in newspapers and magazines, billboards, telephone directories, fliers, and 

mailers, or in electronic media such as the Internet, radio, and television. This type of advertising 

typically promotes a particular product or service, introduces a new offering, or promotes a sale or 

upcoming event. 

2) Marketing and Promoting→ Marketing and promotional efforts use advertising as a vehicle to move 

forward the agenda or image of a person, group, organization or event. For example, a music concert 

promoter may use advertising as a method for elevating the image of his client and his upcoming music 

tour. A promotion in this sense is a form of advertising that does not always urge consumers to make an 

immediate purchase, but compels them to become more interested in and invested in the subject of the 

ads. 

3) Raising Awareness→ Advertising campaigns designed to raise awareness employ many of the same 

principals of solicitation advertising. These advertising messages are not trying to sell the consumer 

something, but are working to make them aware of an issue. Examples include approaches used by non-

profit and community organizations to inform the public about issues such as shortages in blood banks, 

pollution in cities, or the importance of particular medical screenings. 

4) Education and Information→ Advertising is frequently used as a vehicle for educating and informing 

the public about various issues. For example, the advertising campaign of a road safety coalition might 

focus on the potential consequences of driving without a seatbelt by providing statistical information and 

disturbing images. Political campaigns also use education and information in advertising by promoting 

voting records, stands on issues, and credentials for office. 

5) Negative Advertising→ Advertising can be used to criticize or put down competition. Consider 

billboards that denounce the actions of a county commissioner up for re-election, or fliers that provide 

voters with detailed accounting of wasteful government spending. In this instance, the individual or 
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organization purchasing advertising is not trying to sell a product or raise awareness of an issue, but is 

lolling for an effective way to create negative publicity for another entity in order to gain an advantage. 

6) Cost Acquisition per Customer→ Online advertisement ensures that the cost incurred to get customers 

is pretty less as compared to other mediums. It is a simple equation, if the cost of acquisition is low for 

the business, one will end up making more profit. It makes sense to spend online especially when the 

overhead cost of a company is extremely high. 
 

TYPES OF ONLINE ADVERTISING 

The different types of internet or online advertising are explained as follows: 

1) Pop-ups→ Pop-up ads are a form of online marketing where the intent is to advertise a product as well 

as attract web traffic and/or capture email addresses. They are typically generated by JavaScript and 

appear as secondary browser windows. 

Contents vary, ranging from company promotional videos and opt-in forms meant to generate leads to 

messages with the latest news. Although many Internet users consider pop-up ads obtrusive, they are 

good at grabbing users’ attention and can be effective as a marketing strategy once marketers leverage 

their advantages. 

2) Interstitials→ Interstitials are advertisements that appear between the content of two web pages. This 

type of advertisement is not as annoying as pop-ups because the ads tend to run in between the loading 

of the two pages. 

A good aspect of interstitials, for the advertiser, is that the ads cannot be stopped as easily as pop-ups 

can be. With pop-ups, one can just hit the exit button, but if someone wants to see the content after an 

interstitial, he/she has to wait for the entire ad to play. 

3) Banner Ads→ Display or banner ad is the most popular form of advertising. These internet-based 

banner ads are very similar to the still print ads published in newspapers and magazines. These ads are 

small in size and static in nature which are usually placed on the websites which are most visited on the 

internet. 

The websites which place these ads generate their revenue through CTRs (Click-Through Rates). These 

rates are as low as 0.3 per cent. However, the rates of banner ads for B2B companies are higher than that 

of B2C companies. 

4) Sponsorships: Another common form of advertising is sponsorships. There are two types of 

sponsorships. Regular sponsorships occur when a company pays to sponsor a section of a site, for 

example, Clairol’s sponsorship of a page on GirlsOn.com and Intuit’s Turbo Tax sponsorship of a page 

on Netscape’s financial section. A more involved agreement is the content sponsorship, in which the 

sponsor not only provides dollars in return for name association but participates in providing the content 

itself. In some cases, the site is responsible for providing content and having it approved by the sponsor; 

in other instances, the sponsor may contribute all or part of the content. Due in part to the lack of 

effectiveness of banner ads, sponsorships have been increasing in popularity. 

5) Push Technologies: Push technologies, or webcasting technologies, allow companies to “push” a 

message to consumers rather than waiting for them to find it. Push technologies dispatch web pages and 

news updates and may have sound and video geared to specific audiences and even individuals. 

For example, a manager whose job responsibilities involve corporate finance might log on to his or her 

computer and find new stories are automatically there on the economy, stock updates, or a summary of a 

speech by Alan Greenspan. Companies provide screen savers that automatically “hook” the viewer to 

their sites for sports, news, weather reports, and/or other information that the viewer has specified. Users 

can use personalisation—that is, they can personalise their sites to request the kinds of specific 

information they are most interested in viewing. 

6) Links→ While considered by some as not a type of advertising, links serve many of the same purposes 

as are served by the types discussed above. 

For example, a visitor to one site may click on a link that provides additional information and/or related 

materials at another site. At the bottom of the homepage at women.com are a number of links to 

magazines, including Cosmopolitan and Good Housekeeping among others. Clicking on one of these 

takes the visitor to the magazine’s site and usually a pop-up for a subscription to the magazine appears. 

Other forms of advertising, such as ads placed in chat rooms, are also available. 

 

 

http://girlson.com/
http://women.com/
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PPC OR PAY-PER-CLICK: PAID SEARCH 
Paid search marketing is the process of gaining traffic by purchasing ads on search engines. It is sometimes 

referred to as CPC (Cost-Per-Click) marketing or PPC (Pay-Per-Click) marketing. Unlike some digital 

advertising where you pay for impressions, an impression is considered a page view; with PPC search, you 

only pay if your ad is clicked on. 

Pay-per-click is the placement of a small “ad” on the search results page for a specific keyword or keywords 

in return for a specified payment when a visitor actually clicks on that ad. Keep in mind that the advertiser 

pays nothing to appear on the results page per se; they only pay the amount they have agreed to (or bid for) 

when someone actually clicks on their ad and is taken to the “landing” page on their website. Therefore, the 

term “pay per click” means just what it says: the advertiser pays each time a visitor clicks on their ad. 

In a search engine, the paid search ads are usually found at the top, bottom, and right-hand side of the search 

engine results page, often denoted by “sponsored listings” or “ads”. Paid search results are advertisements. 

A business pays to have their ads displayed when users do a search containing specific keywords. The ads 

are typically displayed above and to the right of organic search results. The exact placement of the ads is 

determined by both a bidding process and quality score. 

 

BENEFITS OF PPCS 

The benefits of pay-per-clicks are given below: 

1) Speed→ Advertisers can quickly drive a significant amount of traffic to their website through PPC 

marketing. If managed effectively, PPC marketing is one of the fastest digital marketing strategies to 

drive traffic and conversion growth. 

2) Precision→ Creating a highly-targeted audience to show ads to is straightforward - especially on search 

and shopping networks. 

3) Agility→ Performance data is available almost immediately, which makes it easier to quickly make 

adjustments to improve chances for a successful campaign. 

4) Measurement→ With effective conversion tracking, advertisers can see the ROI of their ads. 
 

LIMITATIONS OF PPCS 

Following are the limitations of PPCs: 

1) Cost→ Depending on the competition and the industry a marketer work in, PPC marketing can be very 

expensive. Some ad placements can cost over $100 per click. 

2) Waste→ Due to the technical nature of most PPC platforms, wasted ad spend is common without 

knowledge of the platform. 

3) Volume→ PPC marketing, especially on the search network, often depends on search volume. If users 

are not searching for the product or service a marketer offer, search and shopping ads will not generate 

much traffic. 
 

DIFFERENCE BETWEEN PAID AND NATURAL SEARCH 

Difference between paid and natural search are as follows: 

1) Highly Qualified Visitors will Come to Your Site→ Just as with organic search, paid search attracts 

visitors who are already interested in what your site does. If they were not, they would not have been 

searching in the first place. 

So it makes sense that searchers who click paid search listings are more likely to buy than visitors 

arriving at your site from clicking a banner ad, e.g. But paid search listings get lower click through rates. 

2) You See Immediate Results→ The biggest difference between paid search advertising and organic 

search is that paid search offers near instantaneous traffic to your site. You can launch a campaign 

immediately by paying your money, writing your ads, and bidding your way to the top of the paid results 

- all without changing a line of code on your website. Organic search, in contrast, takes much longer to 

kick in. 

3) Unlimited Keyword Targeting→ Organic search has a natural limit in the number of keywords that can 

be targeted. Although it is best to use existing pages on your site as search new landing pages as your 

keywords become more obscure. Because organic search landing pages must be deeply linked into the 

navigation of your site, there is a natural limit of how many landing pages (and therefore how many 

keywords) you can target. Because paid search landing pages need not be part of the site’s navigation, 

you can target as many paid search keywords as you can justify the investment for. 
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4) Unequalled Adjustability→ It is difficult to make changes to your website to support organic search, 

especially if you have a medium to large site. If your inventory runs low on your best-selling product, 

your organic search results will keep pouring visitors into your site. 

If you reduce your product’s price, it could take days for the organic search results to reflect it. Paid 

search, however, can adapt to these changes as they occur. You can stop buying the keyword for an out-

of-stock item in paid search, and you can remove the item from product search. You can reflect price 

changes as they happen. You can ratchet up your investment during your busy season and taper it off at 

other times. What is more, you can constantly monitor the return on your investments and make changes 

each day to increase profitability. Paid search is probably the most flexible form of advertising available 

today. 

5) Less Click through Rate→ Except for high purchase intent keyword searches, users click on paid 

search listings at a lower rate than organic search listings. Users seem more reliable and trustful to click 

at organic search results. 

6) Better Click Through Rates→ Click through rates are better for organic search results except for 

searches using keywords that denote high purchase intent. 

7) Cost→ The more competitive the keyword, the more the bid price is for each click on the displayed ad. 

Paid search requires a level of expertise to manage these campaigns. Otherwise, a lot of money will be 

spent to attract unqualified traffic. While organic search are free of cost. 

8) Specific Targeting→ Pay-per-click campaigns can be tailored to reach specific audiences. Examples of 

partitioning include geo-targeting, industry, device targeting, location-based targeting, educational level, 

age, etc., in organic search no specific targeting. 

9) Trust and Credibility→ With high search engine rankings comes a perception of credibility on the part 

of searchers. High search rankings imply industry authority and. leadership. This perception translates 

into more trust and a greater likelihood to click through to the site. 

10) Distrust→ Consumers do not always trust paid ads and often avoid them in paid search. They place 

more trust in organic rankings. 

11) Momentary→ The ads disappear as soon as companies stop paying for them in paid search but not in 

organic search. It is long lasting and no issue of payment. 
 

ADVANTAGES OF ONLINE ADVERTISING 

Advantages of internet or online advertising are as follows: 

1) Wider Ad Coverage→ The online advertising gives ads a much wider global coverage and this helps in 

making online advertisements reach more audiences, which may ultimately help in getting better results 

through online advertising campaign. With internet advertising, companies can also specify the range of 

advertisement coverage which helps the advertiser to enjoy a better advertisement campaign. 

2) Targeted Audiences for Better Response→ When compared with offline advertising, online 

advertising always helps the advertiser to reach the targeted audience and this helps in making the 

campaign more profitable and getting more relevant leads. 

3) Affordable→ Another main advantage of online advertising or marketing is the much affordable price 

when compared with the traditional advertising costs. With a much lesser cost one can advertise on the 

net for a wider range of audience and geographical locations. 

4) Easy to Track and Measure Conversion→ Measurability and easiness to track the conversion makes 

online advertising miles ahead on the traditional advertising methods. A lot of effective analytics tools 

are available to measure online advertising campaigns which help in more improvisation of the ads. 

A company will get a clear picture regarding who viewed the ads, who clicked, the number of leads 

generated and the amount of money that has been spent so far for internet advertising activities. 

5) Speed→ Online advertising is faster than any of the offline advertising activities and the company can 

start sending out their online ads to a wider audience, the moment company starts its advertising 

campaign. 

So if one has a large targeted audience online at the time of triggering online advertisements, then the ad 

will be served to majority of the audience in no time. The execution speed of the internet advertising 

methods gives it a clear advantage over other traditional advertising methods. 

6) Informative→ In online advertising, the advertiser is able to convey more details about the 

advertisement to the audience and that too at relatively low cost. Most of the online advertising 

campaigns are composed of a click-able link to a specific landing page, where users get more 
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information about the product mentioned in the ad. Once the visitor reaches the landing page, he will get 

a clear picture about the product or services and decide whether to buy or not. 

7) Flexible Payment→ Payment flexibility is another added advantage of online advertising and 

marketing. In offline advertising the company needs to pay the full amount to the advertising agency 

irrespective of the results. But in online advertising there is the flexibility of paying for only qualified 

leads, clicks or impressions. This is something that will help the company to manage its ad budget in a 

better way. 
 

LIMITATIONS OF ONLINE ADVERTISING 

Limitations of online advertising are as follows: 

1) Banner Blindness→ One of the major disadvantages of online advertising is that it has been used to 

such extents that the users have developed a blind eye to most online ads. The top online advertising 

agencies across the world rely on innovative approaches to tackle this blindness. 

2) Intrusive→ Web banners, if not placed systematically, can be intrusive and distracting elements for the 

internet users. There have been some horrible instances of agencies flooding sites with so many banners 

that it became virtually impossible for the user to work on them. Online advertising agencies need to 

understand that optimisation rather than maximisation is the name of the game here. 

3) Click Fraud→ Depending on how the company pays for the online advertising, it may encounter a 

common form of ad-result fraud based on inflated click through results. If the ad placement costs rely on 

the number of clicks the messages receive, the competition can pay people to inflate the click rate and 

drive up the costs. 

4) Receptiveness→ Although some consumers do not object to viewing ads on the websites they visit, 

others either ignore or refuse to click on them. Because these ads appear in a setting within which the 

viewer may not expect to see commercial messages - on a news or informational site, e.g.,- the message 

runs the risk of failing to connect with an audience that dislikes and even distrusts online ads. 

Because online ads run above or alongside the content viewers really want to see or read, they can be 

seen as nuisances rather than added value. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


